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Contacting BMC Software

You can access the BMC Software website at http://www.bmc.com. From this website, you can obtain information 
about the company, its products, corporate offices, special events, and career opportunities.

United States and Canada
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2101 CITYWEST BLVD
HOUSTON TX 77042-2827 
USA

Telephone 713 918 8800  or
800 841 2031

Fax 713 918 8000

Outside United States and Canada

Telephone (01) 713 918 8800 Fax (01) 713 918 8000
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Corporation.
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BMC Software considers information included in this documentation to be proprietary and confidential. Your use of this 
information is subject to the terms and conditions of the applicable End User License Agreement for the product and the 
proprietary and restricted rights notices included in this documentation.

Restricted rights legend

U.S. Government Restricted Rights to Computer Software. UNPUBLISHED -- RIGHTS RESERVED UNDER THE 
COPYRIGHT LAWS OF THE UNITED STATES. Use, duplication, or disclosure of any data and computer software by the 
U.S. Government is subject to restrictions, as applicable, set forth in FAR Section 52.227-14, DFARS 252.227-7013, DFARS 
252.227-7014, DFARS 252.227-7015, and DFARS 252.227-7025, as amended from time to time. Contractor/Manufacturer is 
BMC SOFTWARE INC, 2101 CITYWEST BLVD, HOUSTON TX 77042-2827, USA. Any contract notices should be sent to 
this address. 

http://www.bmc.com


   3

Customer support

You can obtain technical support by using the Support page on the BMC Software website or by contacting Customer 
Support by telephone or e-mail. To expedite your inquiry, please see “Before Contacting BMC Software.”

Support website

You can obtain technical support from BMC Software 24 hours a day, 7 days a week at 
http://www.bmc.com/support_home. From this website, you can

■ read overviews about support services and programs that BMC Software offers
■ find the most current information about BMC Software products
■ search a database for problems similar to yours and possible solutions
■ order or download product documentation
■ report a problem or ask a question
■ subscribe to receive e-mail notices when new product versions are released
■ find worldwide BMC Software support center locations and contact information, including e-mail addresses, fax 

numbers, and telephone numbers 

Support by telephone or e-mail

In the United States and Canada, if you need technical support and do not have access to the web, call 800 537 1813 or 
send an e-mail message to support@bmc.com. Outside the United States and Canada, contact your local support center for 
assistance. 

Before contacting BMC Software

Before you contact BMC Software, have the following information available so that Customer Support can begin working 
on your problem immediately:

■ product information

— product name
— product version (release number)
— license number and password (trial or permanent)

■ operating system and environment information

— machine type
— operating system type, version, and service pack or other maintenance level such as PUT or PTF
— system hardware configuration
— serial numbers
— related software (database, application, and communication) including type, version, and service pack or 

maintenance level

■ sequence of events leading to the problem

■ commands and options that you used

■ messages received (and the time and date that you received them)

— product error messages
— messages from the operating system, such as file system full
— messages from related software 

http://www.bmc.com/support_home
mailto:support@bmc.com
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About this book
This book is a guide to using CONTROL-M/Desktop on a Microsoft Windows 
computer. 

This guide is divided into the following chapters:

■ Chapter 1, “CONTROL-M/Desktop Basics”
Provides an overview of CONTROL-M/Desktop including its advantages, 
capabilities, and components. Also describes how to establish communication 
between CONTROL-M/Desktop and CONTROL-M/EM and the means for 
transferring job processing definitions between CONTROL-M/Desktop, the 
CONTROL-M/EM database and CONTROL-M platforms.

■ Chapter 2, “Working with drafts in the definition environment”
Describes how to use the CONTROL-M/Desktop window and the various 
methods available for loading, filtering and viewing data.

■ Chapter 3, “Working with the Job Editing form”
Describes how to use the Job Editing form to create and update job processing 
definitions.

■ Chapter 4, “Creating and updating multiple jobs”
Describes how to create and update multiple job processing definitions at one time.

■ Chapter 5, “Working with the Group Editing form”
Describes how to use the Group Editing form to create and update group 
scheduling table definitions.

■ Chapter 6, “Filtering data using collections”
Describes how to create a subset of job processing definitions for filtered viewing, 
search and replace techniques and mass updates.

■ Chapter 7, “Managing scheduling tables”
Describes how to use the Scheduling Table Manager to create, modify, 
force/order, and upload/download scheduling tables

■ Chapter 8, “Working with calendars”
Describes how to use the Calendar Manager to create and update Calendar 
definitions and how to transfer them to the CONTROL-M/EM database.
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■ Chapter 9, “Defining and scheduling jobs with the CONTROL-M Job Definition 
Wizard”
Describes how to run the CONTROL-M Job Definition Wizard to define and 
schedule jobs. 

■ Chapter 10, “CONTROL-M definitions and validity checks”
Describes how CONTROL-M/Desktop checks and validates job processing 
definitions.

■ Chapter 11, “Customization”
Describes how to set CONTROL-M/Desktop defaults.

■ Appendix A, “CONTROL-M/Desktop menus”
Provides a comprehensive list of all CONTROL-M/Desktop menu options.

■ Appendix B, “Managing logon connections to CONTROL-M/EM”
Describes advanced log in techniques, including changing passwords and 
switching to different GUI Servers. 

NOTE  
Various CONTROL-M platforms sometimes use different terminology for CONTROL-M 
components and parameters. The terminology used in this book may be different than the 
terminology used for your platform, but each component or parameter referenced is easily 
recognized.
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Related publications
■ CONTROL-M for OS/390 and z/OS User Guide describes all CONTROL-M concepts, 

features, facilities and operating instructions in detail. It can be used as a learning 
guide as well as a reference guide.

■ CONTROL-M Administrator Guides are supplied based on the type of computer(s) 
in each site’s CONTROL-M installation(s). These guides describe installation, 
setup, security and utilities that apply to platforms such as iSeries (AS/400) 
platforms.

■ CONTROL-M/Agent Administrator Guide describes maintenance of 
CONTROL-M/Agent on the various types of supported platforms.

■ CONTROL-M/Server Administrator Guide describes maintenance of 
CONTROL-M/Server on the various types of supported platforms.

■ CONTROL-M/Enterprise Manager User Guide describes all CONTROL-M/EM 
concepts, features, facilities and operating instructions in detail. It can be used as a 
learning guide as well as a reference guide.

■ CONTROL-M/Enterprise Manager Administrator Guide describes administrator 
responsibilities, customization, maintenance, and security of CONTROL-M/EM.

■ CONTROL-M/Enterprise Manager Installation Guide describes the installation 
processes for implementing CONTROL-M/EM databases and the 
CONTROL-M/EM product on Microsoft Windows and Unix platforms.

■ CONTROL-M Job Parameter and Variable Reference Guide describes the parameters 
used for creating job processing definitions.

■ CONTROL-M/Enterprise Manager Utility Guide describes the utilities used for 
creating and managing objects in the job production environment and maintaining 
various aspects of CONTROL-M/EM.

■ CONTROL-M/Enterprise Manager API Developers Guide describes how to enable 
your applications to submit requests to CONTROL-M/EM.
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Conventions
The following abbreviations are used in this guide:

The following conventions are used in this guide:

Abbreviation Description

CONTROL-M/EM CONTROL-M/Enterprise Manager

Net CONTROL-M/EM Network

home-directory Directory in which CONTROL-M/EM is installed

key When describing keystrokes, the name of a key (for 
example, F1) is in boldface type. When two keys are joined 
with “+” as in Shift+F1, hold down Shift while pressing F1.

Menu => Option This represents an option selection sequence. For example,
Users and Groups => Groups => Add
means that you first select Users and Groups from the menu 
bar. Select the Groups option from the submenu. Finally, 
select the Add option from the Groups submenu.

{Option A|Option B} The vertical bar is used to separate choices. For example:
{AND|OR}
means that you specify either AND or OR.

[Option] Square brackets are used to enclose parameters that are 
optional.

JCL Script All syntax, operating system terms, and 
literal examples are presented in this 
typeface.

Boldface In instructions, boldface type highlights information that 
you enter. File names, directory names and paths, and 
parameters also appear in boldface type.

Italics Italic type is used to emphasize important terms. The titles of 
BMC Software product documentation are also displayed in 
italic type.

Ellipsis An ellipsis ( . . . ) indicates that you can repeat the preceding 
item or items as many times as necessary.

Option Symbol A vertical bar ( | ) separating items indicates that you must 
choose one item. In the following example, you would 
choose a, b, or c:

a | b | c
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C h a p t e r 1
1  CONTROL-M/Desktop Basics

Basic concepts
CONTROL-M/Desktop is a production design and definition system for users of 
CONTROL-M. It provides you with an intuitive and easy-to-use tool for creating and 
maintaining job processing definitions, scheduling tables, group scheduling tables, 
and calendars.

CONTROL-M/Desktop is a component of CONTROL-M/Enterprise Manager 
(CONTROL-M/EM). It is installed as a client component during CONTROL-M/EM 
installation. For more information see the CONTROL-M/Enterprise Manager 
Installation Guide.

CONTROL-M/Desktop runs under all supported Windows platforms. 
CONTROL-M/Desktop uses offline and online forms to simplify definition of job 
processing parameters, calendars and scheduling tables. For more information on 
supported Windows platforms, see the CONTROL-M/Enterprise Manager Installation 
Guide.

CONTROL-M/Desktop can help you 

■ display job hierarchy based on a CONTROL-M scheduling table or 
application/group parameters

■ move job processing definitions between CONTROL-M installations/scheduling 
tables or between applications/groups using “drag-and-drop” techniques

■ view and modify parameters in job processing definitions

■ perform global search-and-replace of job processing parameters

■ create multiple job processing definitions automatically with predefined 
parameters and functions



CONTROL-M/Desktop components

18 CONTROL-M/Desktop User Guide

■ define “collections” of job processing definitions for both viewing and performing 
mass updates

■ view job production flow graphically, according to job dependencies

■ view and modify calendars

New or modified scheduling tables are saved into the CONTROL-M/EM database. 
Both scheduling tables and calendars can be uploaded or downloaded from the 
CONTROL-M/EM database to their respective CONTROL-M/Server database 
directly in CONTROL-M/Desktop. 

CONTROL-M/Desktop components

CONTROL-M/Desktop consists of the following components:

■ Load Jobs Window – Means of selecting and transferring scheduling tables 
between CONTROL-M/EM and CONTROL-M/Desktop locally and online.

■ CONTROL-M/Desktop Window – The user interface that displays draft data in 
various formats (views):

— Tree View – Hierarchical list of job processing definitions displayed according 
to CONTROL-M/scheduling table or application/group hierarchy.

— List View – Contents of the next level of detail of an item selected from Tree 
View.

— Flow Diagram View – Graphic representation of job production flow based on 
various job dependencies.

— Job Editing Form View – Editing window containing Job Production parameters 
of a selected job processing definition.

— Group Editing Form View – Editing window containing parameters of a 
selected group scheduling table.

■ Collections – Specified subsets of job processing definitions in a draft, used for 
filtered viewing and mass parameter modifications.

■ CONTROL-M – Means of identifying scheduling tables and specific job processing 
parameters for different platforms or applications.

■ Skeletons – Templates for creating job processing definitions based on default 
parameters and predefined functions.
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■ Mass Job Creation/Update Facility – Creates and updates multiple job processing 
definitions in a draft.

■ Scheduling Table Manager – Enables the user to list, create, modify, delete, force, 
order, upload or download scheduling tables.

■ Calendar Manager – Enables the user to view, create, modify, delete, upload or 
download Calendars.

Each of these components is described in detail below.

Drafts

The repository for storing and working on job processing definitions in 
CONTROL-M/Desktop is called a draft. Drafts can contain job processing definitions 
from either a single scheduling table or from multiple scheduling tables.

Drafts are totally independent of CONTROL-M and the CONTROL-M production 
environment. Because of this independence:

■ Work can be saved without undergoing validity checks.

■ Users do not require direct access to CONTROL-M, or the CONTROL-M platform, 
to be able to work in CONTROL-M/Desktop. At sites where only the 
CONTROL-M administrator has direct access to CONTROL-M, personnel from 
other departments can still work in CONTROL-M/Desktop.

■ CONTROL-M does not have to be operational for job processing definitions to be 
created using CONTROL-M/Desktop.

■ Working in CONTROL-M/Desktop does not negatively affect performance of the 
CONTROL-M platform. 
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Load modes for working in CONTROL-M/Desktop

To modify the production environment, first load the relevant job processing 
definitions and scheduling tables from the CONTROL-M/EM database into 
CONTROL-M/Desktop. The following modes are available for loading definitions 
into CONTROL-M/Desktop:

■ Local mode
This mode is particularly useful when many modifications must be made to a 
scheduling table, and exclusive access to an entire scheduling table is preferred. To 
prevent multiple users from updating the same scheduling table concurrently, 
CONTROL-M/Desktop automatically locks the entire scheduling table when it is 
loaded in local mode. 

After creating or modifying job processing definitions in a draft, the user must 
perform the Write to CONTROL-M/EM operation to save all definitions back to 
the CONTROL-M/EM database. CONTROL-M/Desktop automatically unlocks a 
scheduling table when it is written back by the user or when the user ends the 
CONTROL-M/Desktop session.

■ Online mode
This mode is used when modifications to definitions are not extensive (meaning, 
small, localized corrections are necessary), and can be made without interfering 
with the work of other users. 

This mode enables all users to view and access definitions without locking the 
scheduling table until a user starts modifying a definition. When that user saves 
the modifications, the modifications are saved directly to the CONTROL-M/EM 
database and the scheduling table is unlocked. 

NOTE  
It is not possible to work in both modes at the same time.

TIP  
When working in online mode, you can browse a job processing definition so you can view 
its parameters without actually locking its scheduling table.
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A comparison of online and local load modes

As indicated in Table 2 on page 23, when loading data from CONTROL-M/EM into a 
CONTROL-M/Desktop draft, different load modes are available. 
CONTROL-M/Desktop will save your modifications and implement locking 
mechanisms according to the mode you choose.

Table 1 A comparison of online and local load modes

Online mode Local mode

Description This mode enables users to modify 
specific job processing definitions and 
save the modifications directly to the 
CONTROL-M/EM database without 
having to lock the entire scheduling 
table. 

This mode automatically locks the 
entire scheduling table when it is 
loaded. Changes are saved to the 
CONTROL-M/EM database only 
when the Write to CONTROL-M/EM 
operation is performed.

Affected entities Individual job processing definitions Entire scheduling tables. Because a 
scheduling table is locked and written 
to CONTROL-M/EM as a whole 
when working in local mode, review 
the description of scheduling tables 
provided under 

Locking mechanism The scheduling table is locked only when 
one of its job processing definitions is 
being edited in the Job Editing form. 
Only at that time the scheduling table is 
not available to other users. Once the 
user saves the definition, the scheduling 
table is available again. 

The scheduling table that contains the 
job processing definitions that are 
being modified is locked in its entirety 
as soon as the scheduling table is 
loaded and is not available for editing 
(only browsing is possible) to other 
users until the draft is closed or the 
user ends the CONTROL-M/Desktop 
session. 

Saving mechanism Modifications are automatically written 
to the CONTROL-M/EM database each 
time the user clicks Save to Database. 
There is no need to perform the Write to 
CONTROL-M/EM operation.

You have to manually perform the 
“Write to CONTROL-M/EM” 
operation to save modifications.

Availability of features Creating and copying jobs: No
Creating group scheduling tables: No
Creating and deleting dependencies from
    the flow diagram: No
Mass Create: No
Mass Update: No
Validity check: No
CONTROL-M/Desktop wizard: No

Creating and copying jobs: Yes
Creating group scheduling tables: Yes
Creating and deleting dependencies:
      Yes
Mass Create: Yes
Mass Update: Yes
Validity check: Yes
CONTROL-M/Desktop wizard: Yes

Availability in previous 
CONTROL-M/Desktop 
versions

Available in version 5.0.0x. Available as the Read from 
CONTROL-M/EM operation in 
versions 6.1.01, 6.1.02, and 6.1.03. 
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Locking scheduling tables

When loading definitions in local mode, CONTROL-M/Desktop must be able to 
access and lock entire scheduling tables in order to transfer (load) the data. After the 
necessary changes are made to the definitions, the scheduling tables are transferred 
(written) back to CONTROL-M/EM manually by the user. At this point, the 
scheduling tables are unlocked. This is discussed in more detail under “How 
scheduling tables are locked and unlocked in local mode.”

When loading definitions in online mode, CONTROL-M/Desktop can access and 
transfer (load) the data without locking the entire scheduling tables first. The 
scheduling tables are locked only when changes are made to the definitions, and the 
changes are transferred (written) back to CONTROL-M/EM database automatically 
when the user clicks Save to Database. At this point, the scheduling tables are 
unlocked.

How scheduling tables are locked and unlocked in local mode

To prevent multiple users from updating the same scheduling tables at the same time, 
CONTROL-M/Desktop automatically locks a scheduling table when it is loaded by a 
specific user in local load mode.

The following rules apply to lock/unlock:

■ When you load a job processing definition in local mode, its corresponding 
scheduling table is locked automatically.

■ When you load a scheduling table in local mode, it is locked automatically.

■ When you write a scheduling table, it is unlocked automatically.

■ The user loading the scheduling table in local mode can unlock that scheduling 
table using the unlock option in the Scheduling Table Manager.

TIP  
When working in online mode, you can browse a job processing definition so you can view its 
parameters without actually locking its scheduling table. To browse a job processing 
definition, right-click the job in the draft and choose the Browse Job option from the pop-up 
menu.

NOTE  
If, for some reason, the connection between CONTROL-M/Desktop and CONTROL-M/EM is 
broken while you are working in online mode, the draft automatically closes. 
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■ To unlock a scheduling table locked by someone else or unlock a scheduling table 
that you locked in a different session you must have Full authorization for 
Definitions.

■ When you disconnect communication with the GUI Server, close a draft, or exit 
CONTROL-M/Desktop with a table still locked, a window is displayed prompting 
you to Unlock the table.

Moving from definition to production: an overview

Table 2 lists the tasks involved in capturing the current state of the production 
environment, making modifications in the definition environment, and then saving 
the modifications back to the production environment.

Table 2 Using the definition environment to modify the production environment 

Product Task Reference

CONTROL-M/
Desktop

1. Log into the GUI Server of 
CONTROL-M/EM.

“Logging into CONTROL-M/EM” on 
page 35

CONTROL-M/
Desktop

2. Copy definitions from the 
CONTROL-M/EM database to a draft in 
the definition environment. This process 
is called loading, and can be done in 
online mode or local mode.

“Loading scheduling tables and jobs 
from the CONTROL-M/EM database” 
on page 55

CONTROL-M/
Desktop

3. Make the necessary modifications in the 
definition environment to the job 
processing definitions and scheduling 
tables in a draft.

(If working in online mode, you can 
only save to the CONTROL-M/EM 
database directly. There is no option to 
save to a draft.)

■ Chapter 2, “Working with drafts in 
the definition environment”

■ Chapter 3, “Working with the Job 
Editing form”

■ Chapter 4, “Creating and updating 
multiple jobs”

■ Chapter 5, “Working with the 
Group Editing form”

CONTROL-M/
Desktop

4. If working in local mode, write new and 
modified scheduling tables to the 
CONTROL-M/EM database.

(If working in online mode, 
CONTROL-M/Desktop performs an 
automatic write “behind the scenes.”)

“Writing definitions (local mode only)” 
on page 59

CONTROL-M/
Desktop

5. Upload new and modified scheduling 
tables to the CONTROL-M/Server 
database in a specified CONTROL-M 
installation, for scheduling in the 
production environment.

“Uploading definitions to the 
CONTROL-M/Server database” on 
page 210
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CONTROL-M/Desktop window

Figure 1 CONTROL-M/Desktop window

Multiple windows can be opened at the same time to displaying different views of 
the same draft. 

Data in a CONTROL-M/Desktop draft can be organized in different ways when it is 
displayed in a Draft window. Each of these displays is called a view. Each draft 
window contains either two or three panes, each of which displays one view at a 
time.

CONTROL-M/
Desktop or 
CONTROL-M/EM

6. Ordering or forcing the scheduling 
tables, to directly impact the production 
environment.

■ “Ordering and forcing scheduling 
tables” on page 203 of this guide

■ CONTROL-M/Enterprise Manager 
User Guide

CONTROL-M/EM 7. In the production environment, monitor 
progress of the jobs in the scheduling 
table(s) as they are ordered, as they run, 
and as they complete.

CONTROL-M/Enterprise Manager User 
Guide

Table 2 Using the definition environment to modify the production environment 

Product Task Reference
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Draft views usually include a combination of graphic and text representation of draft 
items. Actions performed on an item in one pane affect the view of items displayed in 
another pane.

CONTROL-M/Desktop contains the following draft views:

■ Tree view

The left pane of the draft window displays a tree of job processing definitions in 
the draft. This “tree” is based on parameters in each job processing definition and 
can be displayed using either of two parameter hierarchies:

— CONTROL-M Hierarchy
CONTROL-M hierarchy is based on job processing parameters: CONTROL-M, 
Scheduling Table and Mem Name.

— Application Hierarchy
Application hierarchy is based on job processing parameters: Application, 
Group and Mem Name.

Figure 2 CONTROL-M hierarchy
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Figure 3 Application hierarchy

■ List view

List view displays the details of a selected item in the Tree pane.

Figure 4 List view
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■ Flow diagram view

Flow Diagram view displays a graphic representation of job production flow, 
based on job dependencies established through prerequisite IN and OUT 
conditions.

Figure 5 Flow diagram view

A miniature overview (Net Overview) of the Flow Diagram is displayed in the 
lower right pane of the window. You can click on items in this pane to navigate 
more easily in the Flow Diagram.

Figure 6 Net overview
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■ Job Editing form view

The Job Editing form in CONTROL-M/Desktop displays all parameters in a job 
processing definition. When you double-click on a job in Tree, Flow Diagram or 
List view, or click on a job in Tree view under List/Job Editing Form view, the Job 
Editing form for that job is displayed.

Figure 7 Job Editing form – General panel
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■ Group Editing form view

The Group Editing form displays processing parameters for a group scheduling 
table. It is used to create new group scheduling tables (when working in local 
mode) and to modify processing parameters in existing group scheduling tables. 
When you double-click a group scheduling table node in Flow Diagram view, the 
Group Editing form for the table is displayed.

Figure 8 Group Editing form - General panel

Collections

A collection is a selection of jobs in a draft. CONTROL-M/Desktop allows you define 
a collection of the jobs upon which to work. This is especially useful for applying 
mass updates to all job processing definitions in a collection.

By default, the collection on which you work includes all jobs in the draft. You can 
adjust the collection as often as needed. 

You can also add and delete specific jobs from a collection without having to define a 
new collection that would omit those jobs.
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CONTROL-M/Server and CONTROL-M for OS/390 and z/OS

Each job processing definition handled by CONTROL-M/Desktop must be 
associated with one or more CONTROL-M/Server or CONTROL-M for OS/390 and 
z/OS installations at your site. To create these associations, each relevant 
CONTROL-M installation must be defined in CONTROL-M/Desktop.

Skeletons

CONTROL-M/Desktop provides templates, called Skeletons, that allow you to create 
job processing definitions with default parameters and predefined functions. These 
skeletons can be used to automatically create individual job processing or group 
definitions, and multiple job processing definitions. These definitions can then be 
modified as necessary using the Job Editing form and the Group Editing form. 

Each skeleton is associated with a CONTROL-M definition and an application type. 
The parameters in the displayed Job Editing form vary depending on these 
specifications. Possible variations are:

■ Default (appropriate for most jobs)
■ MVS job parameters
■ Job parameters for a specific application (for example, Oracle Applications or SAP)

Mass job creation and update

CONTROL-M/Desktop allows you to globally search and replace values in job 
processing definitions in the current draft. Together with collections, this global 
search and replace can be limited to jobs that satisfy specified criteria.

You can also create multiple job processing definitions automatically, based on 
skeletons.

The advantage of both of these features is to eliminate the need for individually 
defining and modifying job processing definitions with similar parameters. After 
using the mass job creation facility, you can define collections to filter the new 
definitions and use the mass update facility to further modify the definitions.
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Scheduling Table Manager

The Scheduling Table Manager lists all scheduling tables in the CONTROL-M/EM 
database. It is used to modify, delete, force or order an existing scheduling table, 
create a new scheduling table, and upload or download scheduling tables to the 
CONTROL-M/Server database in the indicated CONTROL-M installation.
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Calendar Manager

A CONTROL-M calendar contains a list of dates, usually spanning a number of 
months or years, which can be used as a basis for scheduling jobs. The dates on which 
a job can be ordered are limited by the calendars named in the scheduling parameters 
of the job processing definition. If no calendar is specified, the job is ordered solely on 
the basis of the other scheduling parameters. The Calendar Manager is used to define 
and edit calendars, and upload and download calendars from the CONTROL-M/EM 
database to the indicated CONTROL-M/Server database.

Language capabilities

Western European languages

CONTROL-M/EM, CONTROL-M/Desktop, CONTROL-M/Server, 
CONTROL-M/Agent, and CONTROL-M/eTrigger, support Western European 
language characters (the Latin-1 character set). These products can accept characters 
in English, German, Spanish, and French from the Latin-1 character set (ISO 8859-1) 
in almost all text fields and parameters. .

For additional information, see the following guides.
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When CONTROL-M/Desktop is first installed, its language is set according to the 
local settings of the computer. When CONTROL-M/Desktop connects to the GUI 
Server the first time, CONTROL-M/Desktop language settings are automatically 
updated to match those of CONTROL-M/EM.

Japanese

CONTROL-M can run on Japanese-enabled operating systems.

The CONTROL-M components, such as the EM GUI and CONTROL-M/Desktop, do 
not accept Japanese characters in any free text fields or parameters and display values 
only in English. For example, Japanese job sysouts do not display correctly. 
Therefore, in these cases, job sysout analysis is not possible.

Japanese configuration and installation instructions for running CONTROL-M 
components with Japanese-enabled operating systems are provided in the 
CONTROL-M Language Customization Guide

Task Topic and guide

Indications of which parameters do not 
support Western European Language special 
characters

Individual parameter descriptions in the 
CONTROL-M/Job Parameter and Variable 
Reference Guide

A list of all parameters that do support 
Western European Language special 
characters

The CONTROL-M Language Customization 
Guide

A list of Western European Language special 
characters that are not supported at any time

The CONTROL-M Language Customization 
Guide

Language configuration instructions The CONTROL-M Language Customization 
Guide

Migration instructions CONTROL-M/Enterprise Manager Migration 
Guide

CONTROL-M/eTrigger customization 
instructions

“Use Locale” topic in Chapter 4 of the 
CONTROL-M/eTrigger Administrator Guide
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Basic tasks

Starting CONTROL-M/Desktop

To start CONTROL-M/Desktop

Perform either of the following:

■ Choose Start => Programs => CONTROL-M Enterprise Manager => 
CONTROL-M/Desktop.

-or-

■ Select CONTROL-M/Desktop from the Tools menu in the CONTROL-M/EM 
GUI.

The following window is displayed.

Figure 9 CONTROL-M/Desktop window
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Logging into CONTROL-M/EM

This section provides basic instructions for logging into CONTROL-M/EM’s GUI 
Server. You must log in to CONTROL-M/EM in order to perform the following 
functions: 

■ Load from CONTROL-M/EM
■ Write to CONTROL-M/EM
■ Upload/download to/from CONTROL-M/Server 
■ Order/Force

To log into CONTROL-M/EM:

1 Click , or select Communication => Connect to GUI Server. A login window is 
displayed.

2 Specify your user name and password. 

3 Select the GUI Server.

4 Click Login. Communication is established.

NOTE  
Additional instructions for advanced log in options, such as changing your password and 
switching to a different GUI Server, are provided in Appendix B, “Managing logon 
connections to CONTROL-M/EM.”
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Working with list displays

Certain dialog boxes display lists of items, for example, lists of CONTROL-M 
definitions or lists of prerequisite conditions, from which you can make a selection. 
Many list displays contain an Item counter at the bottom that indicates the number of 
items appearing in the list.

You can modify many list displays, and perform other tasks in list displays. Two 
pop-up menus enable the various modification and other tasks:

■ The column header pop-up menu

Figure 10 Column header pop-up menu for list displays

This menu is used for performing most modifications. To display this menu, 
right-click in the header of the column in the list display. Changes made are saved 
and redisplayed the next time the list is displayed.

■ The list display pop-up menu

Figure 11 List Display Pop-up Menu

To display this menu, click anywhere in the list display except the column header.

Modifying list displays

The following modifications can be made to list displays:

■ Toggle the Item Counter on and off 
■ Sort the list according the values in a column
■ Remove a column from the list
■ Add fields to the list display
■ Resize a column’s width
■ Reorder columns
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Toggling the item counter is performed from the list display pop-up menu. The other 
modifications are performed from the columns headers or the column header pop-up 
menu.

To display/hide the item count in a list display

Click Item Count in the list display pop-up menu.

To sort the list according to the values in a column

Perform one of the following:

■ Right-click the column header. Select either Sort Ascending or Sort Descending. 

-or-

■ Click the column header. 

The selected column initially sorts in ascending order (default). Once the column is 
already being used as the sort column, each click of the column header toggles 
between ascending and descending sort.

An alphabetic sort is performed, except the Last Update column is sorted by date. The 
date format is determined by the locale setting of the computer. For information 
about how to change the date format, see the manual of your operating system.

To add a field to the display:

1 Right-click the column header. Select the Field Chooser option.

The Field Chooser menu is displayed with the appropriate fields.

NOTE  
Not all list displays can be modified, and not all modifications are possible in modifiable 
list displays. Furthermore, some modifications require Administrator permissions.
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2 Click and drag the field from the Field Chooser menu to the wanted location in the 
column header of the list.

To remove a field from the display

Perform one of the following:

■ Right-click the column header and select Remove This Column.

-or-

■ Right-click the column header and select the Field Chooser menu. Then drag the 
header from the list to the Field Chooser.

To rearrange the fields in the display

Click and drag (right or left) the column header of the field to be moved.

To resize a column in the display according to its best fit

Perform one of the following:

■ Right-click the column header of the column to be adjusted and select Best Fit.

-or-

■ Double-click the header’s right border.

The column width is adjusted to fit the longest value in the column.

Performing other tasks in the list display

You can perform the following tasks from the List Display pop-up menu, which is 
displayed by right-clicking anywhere in the list display (except the column header).

■ Save the contents of the list display to a CSV file
■ Print the contents of the list display
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To save the contents of a list display to a CSV file

Select Export to File in the pop-up menu of the list display, and perform the save in 
the Export to File dialog box.

.csv files are comma-delimited and can be used in applications such as Microsoft 
Excel.

To print the contents of a list display

Select the Print option in the pop-up menu of the list display.

Specifying Pattern-Matching strings

Fields used to select data (for example, in the Scheduling Table Manager window), 
accept pattern-matching strings, or expressions, as input. Using these strings, the user 
can select many different entities by specifying a relatively simple combination of 
characters and symbols.

Table 3 describes the symbols used to compose pattern-matching strings.

NOTE  
The use of complex expressions tends to reduce CONTROL-M/Desktop performance.

Table 3 Symbols used to compose pattern-matching strings

Symbol Name Usage

* Asterisk wildcard Denotes any number of characters (including no 
characters). This can be inserted in place of a string.
Note: In filter criteria fields, if filtering is not needed, it is 
more efficient to leave the field blank than to use the "*" 
character.

? or . Question mark 
wildcard, or period

Denotes any single character. This can be inserted in 
place of any number of characters.
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! Exclamation Denotes all possibilities that do not match the pattern 
that immediately follows the ! character. This can be 
specified to exclude the pattern immediately following 
the ! from the result. 
Where a pattern begins with !, the escape character 
backslash "\" can be used to escape the ! and either 
include or exclude the pattern (required only where ! is 
the first character). For example, to include occurrences 
of "!wip", use the pattern "\!wip", whereas "!\!wip" 
excludes "!wip".

Note: 
! must be the first character of the string, for example, in 
the expression (first!,!one) the exclamation is part of the 
string "first!", but is used to exclude the string "one".

■ ! is evaluated literally in collection and filter 
definition fields.

[ ] Brackets Denotes different possibilities for a single character. The 
brackets enclose a string of possible values. In addition, 
the following symbols can be used within the brackets:

■ – denotes a range of characters.
■ ^ used as the first character in the brackets to denote 

"not".

, or | Comma or pipe Used to separate pattern-matching strings, allowing the 
user to specify more than one string (the comma 
represents a Boolean OR).
Example
(host01, host02, host03)

Note: "," is evaluated literally in collection and filter 
definition fields.

<character> Character Any character, other than one of the above, denotes the 
specific character. 
Note: In case-sensitive fields, CONTROL-M/Desktop 
differentiates between uppercase and lowercase 
characters (for example, "a" and "A" are regarded as two 
different characters).

^ Anchor (start) ■ Denotes "not" when used as the first character in 
brackets [ ].

■ Denotes the start of a word when not specified in 
brackets [ ].

Table 3 Symbols used to compose pattern-matching strings

Symbol Name Usage
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Table 4 lists examples of expressions used to select data centers. Specifying any one of 
them would include data center DALLAS.

$ Anchor (end) Denotes the end of a word.

\<special_
character>

Escape character Denotes the literal value of the special character. The 
special characters are the symbols described in this table.

Examples
■ To specify \, type \\.
■ If you specify \. then "." has the meaning of period 

and not the same meaning as ?.
■ Use "\" to escape ! only where ! is the first character.

NOTE  
XML term files support the use of "," to separate values and "!" to exclude values.

TIP  
If you use special characters, such as asterisk, as a literal part of the object name (for example, 
glo*-job1_started), and when you filter you want to include only these objects (for example, 
you do not want to include glo-job1_started), specify \ before the special character in the 
filter prefix (for example, glo\*). Otherwise, objects without the special character (for 
example, glo-job1_started) will also be included. (Wherever possible, try to avoid defining 
object names with special characters as literals.)

Table 4 Examples of expressions

Pattern Includes...

DALLAS, NY, LA The three data centers DALLAS, NY, LA.

D*S All data centers whose name starts with D and ends with S.

D????S All data centers whose name starts with D, ends with S and consists of 
six characters.

D*ALL?S All data centers whose name starts with D and ends with five letters 
matching the pattern signified by ALL?S.

!NY All data centers except for NY.

LA,!NY,D*S Data centers LA and DALLAS, excluding NY.

DALLAS,TEXAS\* The data centers DALLAS and TEXAS*.

D[ABC]* All data centers whose name starts with D and whose second letter is 
A, B or C.

D[A-E]???? All data centers whose name starts with D, whose second letter is in the 
range of A-E and whose name consists of six characters.

Table 3 Symbols used to compose pattern-matching strings

Symbol Name Usage
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Using SQL wildcards

The SQL wildcards:

■ % – denotes any or no character
■ _ – denotes any one character

These wildcard characters, when used in ViewPoint collections and filter definitions, 
are evaluated as literal % and _ and not as wildcards. 

D[^B-Z]* All data centers whose name starts with D and whose second letter is 
not in the range of B-Z.

NY,D*S Data center NY and all data centers matching the pattern signified by 
D*S.

Table 4 Examples of expressions

Pattern Includes...
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C h a p t e r 2
2  Working with drafts in the definition 
environment

The CONTROL-M/Desktop window displays scheduling tables and jobs in a 
definition environment. The jobs can be filtered and ordered in a hierarchical 
structure. The filter and hierarchical specifications are saved in a draft, which is the 
work area through which you view the jobs in the definition environment that are 
relevant at that time. Drafts can contain job processing definitions from either a single 
scheduling table or from multiple scheduling tables.

This chapter describes how to work with drafts in the CONTROL-M/Desktop 
window. The following main topics are described: 

■ Introduction to the CONTROL-M/Desktop window

■ Getting started with drafts, including Loading scheduling tables and jobs from the 
CONTROL-M/EM database

■ Viewing drafts

■ Navigating in the draft

■ Modifying drafts

■ Working with group scheduling tables

■ Printing a draft
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Introduction to the CONTROL-M/Desktop 
window

Figure 12 illustrates the CONTROL-M/Enterprise Manager window with an open 
Draft window. 

Figure 12 Draft window 

Draft windows consist of the following panes:

■ Navigation Tree
Hierarchical view of jobs in the definition environment, mainly for navigation 
purposes. For more information, see “Understanding the Navigation Tree and its 
components” on page 46.

Navigation 
Tree

Flow
Diagram

Net 
Overview

Work
Area
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■ Work Area
Area for modifying the definition environment. For more information, see 
“Understanding the Work Area, its views, and components” on page 48. The work 
area is displayed in one of the following views:

— Flow Diagram
Graphic representation of job production flow, based on job dependencies 
established by prerequisite conditions specified in job processing definitions (IN 
and OUT conditions).

Components of the definition environment are represented by boxes called 
nodes. The information displayed in a node varies depending on the type of 
node and on how certain customization options.

For more information, see “Flow Diagram view” on page 51.

— List Mode
Details of the item currently selected in the Navigation Tree in list format. For 
more information, see “List Mode view” on page 48.

— Editing Form
Details of the group or job currently selected in the Navigation Tree in its 
editing form. For more information, see “Editing Form view” on page 50.

■ Net Overview
Miniature version of the Flow Diagram, indicating the part of the network 
currently displayed in the Flow Diagram. By dragging the selected area in this 
view to a different part of the network, you can quickly navigate in a complex 
environment. For more information, see “Understanding the Net Overview and its 
components” on page 47.

TIP  
Each of the three panes can be re-sized separately by dragging their borders to the desired 
position.
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Understanding the Navigation Tree and its components

A Navigation Tree of the current draft is displayed on the left side of the Draft 
window. The Navigation Tree is sorted either according to CONTROL-M installation 
or according to application. These sort-orders are called hierarchies. Each hierarchy is 
sorted according to parameters in each job processing definition: 

■ CONTROL-M hierarchy is sorted according to the CONTROL-M, Scheduling 
Table, and Mem Name parameters.

■ Application hierarchy is sorted according to the Application, Group, and Mem 
Name parameters.

When opening an existing draft or loading data into a draft, the highest level in the 
hierarchy is displayed in Navigation Tree on the left side of the Draft window. The 
corresponding Flow Diagram is displayed in the upper-right of the Draft window. A 
net overview of the Flow Diagram is displayed below the Flow Diagram.

When you double-click an application name or icon or single click the  preceding the 
application in the left pane, the Navigation Tree expands to the next level of detail, 
listing all the groups in that application. To decrease the level of detail for an item in 
the Navigation Tree, double-click the item or click the  preceding the item name. 

When you double-click one of the groups, the Navigation Tree expands to list all the 
job processing definitions in that group.

When you click a job in either the Navigation Tree or Flow Diagram, the job is 
highlighted in the Flow Diagram and that section of the diagram is highlighted in the 
Net Overview.

CONTROL-M/Desktop uses various icons next to each item name to indicate the 
level in the hierarchy.

■ The icons in the CONTROL-M hierarchy are described in Table 5.
■ The icons in the Application hierarchy are described in Table 6.

Table 5 Icons in the CONTROL-M hierarchy 

Icon Description

Indicates a CONTROL-M installation 

Indicates a scheduling table 

Indicates a job 

Indicates a job in a group scheduling table 
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Understanding the Net Overview and its components

The portion of the Flow Diagram contains a miniature version of the current Flow 
Diagram. This is the Net Overview. The part of the Flow Diagram that is currently 
displayed above, is enclosed in a rectangle in the Net Overview. When you can click a 
node in the Net Overview, the Flow Diagram is adjusted to view the selected part of 
the job flow. 

If there are too many nodes in the current level to be displayed in the Net Overview, 
only part of the current level is displayed. The Net Overview can be scrolled to view 
other parts of the Flow Diagram.

Figure 13 Net Overview

To select an area in the Net Overview:

1 Click and drag the rectangle in the Net Overview pane until the it include the job 
flow that you want to display in the Flow Diagram.

Table 6 Icons in the Application hierarchy 

Icon Description
 Indicates an application 

Indicates a group 

Indicates a job

Indicates a job in a group scheduling table

NOTE  
Scheduling table library names are indicated with scheduling table names in the Navigation 
Tree only if there is more than one table with the same name in the relevant CONTROL-M 
installation.
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Understanding the Work Area, its views, and components

The following views can be displayed in the work area pane of the Draft window. 

■ List Mode view
■ Editing Form view
■ Flow Diagram view

List Mode view

The List mode displays details (the next level of items) of the item currently selected 
in the Tree (the left pane of the CONTROL-M/Desktop window). For example, if you 
select an application in the Tree, the groups in that application are displayed in List 
mode. You can also use List Mode for selecting jobs for editing. 

To switch to List Mode view

1 Select the item in the Navigation Tree.

2 Change the view using the List/Job Editing option from the View menu. The details 
for the selected item are displayed in list format in the work area.

Figure 14 List Mode view

Table 7 describes the nodes that can be displayed in the CONTROL-M/Desktop Draft 
window when in List mode.
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List mode provides the following advantages:

■ List mode provides additional information about the nodes displayed. (the 
Navigation Tree lists only the node names.) For example, jobs displayed in List 
mode, are displayed with the values of the Owner, Member name, Member library 
and Description parameters.

■ Only one node can be selected at a time in the Navigation Tree. Multiple items can 
be selected in List mode. For example, you can delete only one job at a time in the 
Navigation Tree. You can delete multiple jobs in List mode.

■ Combining two views allows you to simultaneously see items at one level in the 
Navigation Tree and the contents of another item in List mode.

To return to the Flow Diagram view from List Mode view

1 Right-click the CONTROL-M/Desktop window to display the following menu:

Figure 15 Editing Mode pop-up menu

2 Select Flowdiagram View.

Table 7 Display according to node selected in the Navigation Tree

Icon Navigation Tree node Displayed item in List Mode view

CONTROL-M List of scheduling tables in the CONTROL-M

Scheduling Table List of jobs in the scheduling table

Application List of groups in the application

Group List of jobs in the group

Job Job Editing form for the job
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Editing Form view

To display the editing form for a job or group in the Work Area pane:

1 Double-click the job or group in the Navigation Tree. The appropriate editing form 
is displayed in its own dialog box.

-or-

Select the job or group in the Navigation Tree, and change the view using the 
List/Job Editing option from the View menu. The editing form is displayed in the 
work area. 

Figure 16 Job Editing form

TIP  
You can move between various job definitions without closing and opening the form for 
each job. If you make any changes to the parameters, select Apply or Cancel at the top of 
the form before selecting the next job from the Navigation Tree.

NOTE  
When you click a group item in the Navigation Tree, the Job Editing form is replaced with a 
list of the jobs in the group.



Understanding the Work Area, its views, and components

Chapter 2    Working with drafts in the definition environment 51

To return to the Flow Diagram after displaying the Job Editing form

1 Right-click the CONTROL-M/Desktop window to display the following menu:

Figure 17 Flow Diagram pop-up menu when in Editing Mode

2 Select Flowdiagram View.

Flow Diagram view

Flow diagram mode displays a draft containing the job production flow in a graphic 
format. The job flow reflects job dependencies indicated by prerequisite In and Out 
conditions in job processing definitions.

Each CONTROL-M/EM element is represented by a node that is displayed in the 
Flow Diagram. The most common node is the job node. Each job node represents a 
job processing definition. You can modify or delete existing job nodes (when working 
online or locally) or create new definitions (when working locally) that are 
represented by nodes.

NOTE  
Other operations that can be performed when displaying the Job Editing form or Group 
Editing form in the Flow Diagram pane include: 

■ Displaying the icon and the name of the job or group
■ Displaying large icons and names for each icon
■ Editing the Job Editing form or Group Editing form instead of viewing it
■ Accessing customization options
■ Displaying relevant details for the group (number of jobs in the group) or the job (owner, 

memlib and job description)

These options are available from the menu that is displayed after right-clicking the 
CONTROL-M/Desktop window with the Job Editing form or Group Editing form displayed.
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To display the Flow Diagram:

1 Select View => Flowdiagram.

Figure 18 Flow Diagram view

Each entity (application, group, CONTROL-M, scheduling table, job, or group 
scheduling table) in the Flow Diagram is represented by a node. The smallest entity is 
the job node. The top part of the job node contains the Job Title.

The area inside the job node is called the Job Area. Two fields from the job processing 
definition are displayed in the Job Area below the Job Title. The Job Title and the two 
fields to be displayed in the Job Area can be customized in the Flowdiagram - Nodes 
panel of the Options dialog box. 

In this same Flowdiagram - Nodes panel, the user can also request that displayed 
values be wrapped if they are too long for display on single lines (otherwise the 
values are truncated). 

When the Wrap option is selected, all the selected information can be displayed in up 
to four 14-character lines (a total of 56 characters for all the fields). A marker line 
appears between displayed fields to indicate when one field ends and a new field 
begins. (If the Wrap option is not selected, no marker line appears because each 
displayed line always represents a new field.) Figure 19 indicates a job node with the 
Wrap option on.
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Figure 19 Job node with Wrap option on

Triangular symbols  called Connectors appear at the top and bottom of the job 
nodes: 

■ The In Connector at the top represents the job’s In conditions.
■ The Out Connector at the bottom represents the job’s Out conditions.

Job dependencies are indicated by dependency lines from the Out Connector of the 
predecessor to the In Connector of the successor. Job dependencies can be created 
using this graphical representation (in local mode only). For more information, see 
“Creating and modifying conditions and dependencies” on page 81.

Getting started with drafts
To define the production environment, one performs one of the following tasks:

■ Opening an existing draft
■ Creating a new draft
■ Loading scheduling tables and jobs from the CONTROL-M/EM database

NOTE  
Elements of the Flow Diagram (for example, graph placement) can be modified in the 
Flowdiagram panels of the Options dialog box. For more information about these elements, 
see:

■ “Flowdiagram – General panel” on page 247
■ “Flowdiagram – Nodes panel” on page 248
■ “Flowdiagram – Links panel” on page 250
■ “Flowdiagram – Colors panel” on page 251
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Opening an existing draft

To open an existing draft:

1 Choose File => Open or click Open  on the toolbar.

2 Choose the drive, directory, and draft, and click Open.

Only one draft can be open at a time. Therefore, when you open a draft, 
CONTROL-M/Desktop automatically closes the previously opened draft (if it is 
still open):

■ If no changes have been made to the previous draft, it is closed automatically.
■ If changes have been made, you are prompted to save the changes. The previous 

draft is then closed accordingly.

3 Modify the draft as wanted, as described under “Modifying drafts.”

4 Choose File => Save or click  on the toolbar.

Creating a new draft

To create a new draft:

1 Choose File => New or click New  on the toolbar. 

2 Modify the draft as wanted, as described under Chapter 2, “Modifying drafts.”.

3 Choose File => Save or click  on the toolbar.

NOTE  
When you open an existing draft using File => Open, the draft opens in local load mode.

NOTE  
No validity checks are performed when the draft is saved.
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4 If the current draft has not been saved previously, a dialog box is displayed 
allowing you to specify the name and path for the draft.

The first time you save a draft, the default location is your My Documents folder. 
From then on, the default location for new drafts is the location where you most 
recently saved a draft.

Loading scheduling tables and jobs from the CONTROL-M/EM 
database 

Job processing definitions and scheduling tables can be loaded from the 
CONTROL-M/EM database into the current draft.

An overview of this process is discussed in Chapter 1, “Load modes for working in 
CONTROL-M/Desktop.” Details for loading job processing definitions and 
scheduling tables are provided below.

To load scheduling tables from the CONTROL-M/EM database:

1 If no draft is open, open a new draft.

2 Choose File =>Load jobs from CONTROL-M/EM, or click .The Load Jobs window 
is displayed.

NOTE  
No validity checks are performed when the draft is saved.

NOTE  
All scheduling tables loaded into a draft must be of the same load mode.
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Figure 20 Load Jobs window

3 In the Filter Tables and Jobs area, specify criteria which will help you locate the job 
processing definitions and scheduling tables you want to load (for example, the 
CONTROL-M on which the scheduling tables reside, the group, and so on). 

A When specifying values for the filter criteria:

■ An And relationship exists between all specified fields.

■ A blank field is equivalent to specifying *, meaning all values are returned for 
that field if left blank.

■ Use commas to separate multiple values.

■ When specifying a data center in the CONTROL-M field: Specify an 
expression by selecting data centers from the drop-down list and/or typing 
data center names.

■ For all fields, you can use pattern-matching strings to compose a regular 
expression. For more information, see “Specifying Pattern-Matching strings” on 
page 39.

NOTE  
■ When displayed for the first time in a session, the Filter Tables and Jobs fields are blank. 

The next time this window is opened, the fields remain populated from the previous load.

■ To load all scheduling tables and jobs, click Load without specifying filter criteria. 
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B Click Apply. 

4 Select the check boxes next to the desired data centers, scheduling tables and job 
processing definitions. 

■ You can expand and collapse the entities as needed by clicking the plus (+) and 
minus (-) signs.

■ You can select all check boxes associated with the selected entity by clicking the 
 icon at the upper-right corner of the window, or clear them by clicking .

5 Select either Local or Online for the load mode. To help you decide which mode is 
appropriate, see “A comparison of online and local load modes” on page 21.

6 Click Load. The Load Scheduling Table Results window is displayed.

TIP  
If any scheduling tables are locked, the name of the user who has the scheduling table 
locked is displayed next to the scheduling table. 

NOTE  
Once you select a mode and load the definitions into the current draft, all subsequent loads 
that you perform must be of the same load mode, until you either close the current draft or 
exit the current CONTROL-M/Desktop session. For example, if you are working online, 
any subsequent loads that you perform must be of type online.

TIP  
As you select each row in the Load Scheduling Tables Results window, information about 
that row appears in the right-most pane of the window. 
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7 Click Close. The scheduling tables and job processing definitions are loaded into 
the current draft.

Determining if you are working in online or local mode

The following are indications that you are currently working in online mode:

■ The title bar of the Flow Diagram window displays the words “Online Mode” 
instead of the name of a draft.

■ Options and parameters that would create a job or a group scheduling table (both 
directly and indirectly) are unavailable (greyed out). 

■ When working in the Job Editing form, the Save to Database button is available 
instead of the Save to Draft button. 

Considerations for loading multiple copies of the same 
scheduling table

■ If you have a copy of one scheduling table open in your draft in local mode, and 
you load a table of the same name within the same CONTROL-M from the 
CONTROL-M/EM database, the draft copy of the table is overwritten.

■ If you have a copy of several scheduling tables open in your draft in local mode, 
and you load scheduling tables of the same name within the same CONTROL-M 
from the CONTROL-M/EM database, the Confirm Load Scheduling Tables dialog 
box is displayed. In this dialog box, you specify which scheduling tables you want 
to overwrite. (Only scheduling tables that are unlocked can be loaded again.) Select 
the check box of any scheduling table you want to overwrite and click Load.



Saving definitions

Chapter 2    Working with drafts in the definition environment 59

Saving definitions

When working in online mode, all changes made to a definition are saved 
automatically in the CONTROL-M/EM database. There is no need to perform a Write 
to CONTROL-M/EM operation. 

When working in local mode, all changes are first saved to a draft. Then, the Write to 
CONTROL-M/EM operation must be performed for the changes to be saved in the 
CONTROL-M/EM database.

Writing definitions (local mode only)

When working in local mode, changes made to a definition are saved locally in the 
draft, and are not automatically saved in the CONTROL-M/EM database. Therefore, 
you must perform the Write to CONTROL-M/EM operation to save the changes in 
the CONTROL-M/EM database.

To write definitions to the CONTROL-M/EM database:

1 Open the draft containing the job processing definitions for the scheduling table.

2 Choose Edit => Scheduling Tables => Write to CONTROL-M/EM, or click . the 
Write to CONTROL-M/EM window is displayed.
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3 Select the scheduling tables that you want to write to the CONTROL-M/EM 
database.

4 Click Write. The scheduling tables are written to the CONTROL-M/EM database.

If no errors are detected before the write process, a summary window is displayed:

Figure 21 Write Scheduling Tables Results window

Writing multiple scheduling tables

The procedure for writing multiple scheduling tables is the same as for writing a 
single scheduling table, although two or more tables are selected for writing.

If you are writing multiple scheduling tables and one or more of them already exist in 
the CONTROL-M/EM database, the Confirm Write Scheduling Tables dialog box is 
displayed. In this dialog box, you must indicate whether you want these scheduling 
tables overwritten.

NOTE  
Depending on the setting of the Resolve job’s Author field conflict security field in the 
General panel of the Options dialog box, you may be prompted for confirmation if there 
are conflicts between the Author fields of the newly edited job definitions in the scheduling 
table and the currently logged in user in the CONTROL-M/EM database. For more 
information, see the Security chapter and the description of the AuthorSecurity system 
parameter in the CONTROL-M/Enterprise Manager Administrator Guide.
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Select the check box of any scheduling table you want to overwrite and click Write.

You can select all listed scheduling tables by clicking Check All.

Viewing drafts
This section describes methods for viewing the nodes in the draft. 

■ Switching hierarchies
■ Arranging the Flow Diagram display
■ Switching between Definition and Selection modes

Switching hierarchies

To select the Application hierarchy:

1 Click the Application Tree    button in the toolbar.

-or-

Choose View => Hierarchy => Application/Group/Job.
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To select the CONTROL-M hierarchy either:

1 Click the CONTROL-M Tree    button in the toolbar.

-or-

Choose View => Hierarchy => CONTROL-M/Sched. Table/Job.

Arranging the Flow Diagram display

After adding or modifying job dependencies, it may be necessary to rearrange the 
Flow Diagram to display a more direct representation of the job production flow. 
When selected, the Arrange All option reformats the Flow Diagram according to the 
following rules: 

■ Dependencies are displayed from top to bottom (predecessor jobs appear above 
successor jobs).

■ Dependency line crossed as little as possible.

To rearrange the Flow Diagram:

1 Right-click anywhere in Flow Diagram (except on a job node), and select Arrange 
All from the menu.

-or-

Click the Arrange all items in Flow Diagram  button on the toolbar.

Switching between Definition and Selection modes

The action that dragging performs is determined by whether CONTROL-M/Desktop 
is in Selection mode or Definition mode:

■ In Definition mode, dependencies are created when dragging between nodes. 
Dragging does not select multiple nodes. For more information about creating 
dependencies, see “Creating and modifying conditions and dependencies” on 
page 81. 

■ In Selection mode, dragging the mouse enables you to select multiple nodes. 
However, creating dependencies (prerequisite conditions) by dragging between 
nodes is unavailable. For more information about selecting multiple nodes and 
performing action on them, see “Selecting nodes manually” on page 72. 
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To choose Definition mode: 

Click . 

To choose Selection mode: 

Click . 

Navigating in the draft
This section describes methods for navigating through the draft. 

■ Locating a node in the Flow Diagram using the Navigation Tree
■ Expanding and collapsing
■ Stepping In and Out
■ Finding jobs
■ Identifying predecessor and dependent jobs (Neighborhood)
■ Branching in the Flow Diagram

Locating a node in the Flow Diagram using the Navigation 
Tree

When you click a node in the Navigation Tree, the node is selected and highlighted in 
Flow Diagram and Net Overview if it is part of the hierarchy displayed.

To locate a node in Flow Diagram using the Navigation Tree:

1 Right-click the node in the Navigation Tree.

2 Choose Find In Flowdiagram from the menu. 

NOTE  
Definition mode is selected by default when CONTROL-M/Desktop is started.
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Appropriate levels are then expanded or collapsed, and the node is selected in the 
Navigation Tree, the Flow Diagram and the Net Overview:

■ If the level displayed in Flow Diagram is a higher level than the one requested, 
CONTROL-M/EM executes the Expand function to display the node level 
requested and highlights the node.

■ If the level displayed in Flow Diagram is the same level as the node requested, 
CONTROL-M/EM highlights the node.

■ If the level displayed in Flow Diagram is a lower level than the one requested, 
CONTROL-M/EM executes the Step Out function and highlights the specified 
node.

Expanding and collapsing

Initially, the Flow Diagram is displayed showing only the applications or 
CONTROL-M installations, depending upon the hierarchy selected. You can Expand 
each entity displayed to show all the groups in an application or scheduling tables in 
a CONTROL-M. You can expand it further to show all the jobs in a group or 
scheduling table. You can later Collapse each part of the diagram to show only the 
groups, applications, scheduling tables or CONTROL-M installations.

This is similar to clicking on the  and  symbols next to each branch in the 
Navigation Tree.

To expand or collapse the display:

Right-click a node, and select Expand or Collapse from the pop-up menu.

-or-

Double-click the node to toggle the Expand/Collapse function.

NOTE  
For more information about the Expand/Collapse and Step In/Step Out functions, see 
“Expanding and collapsing” and “Stepping In and Out” on page 65.
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To expand or collapse multiple nodes in the Flow Diagram:

Hold down the Ctrl key and select the wanted nodes.

-or-

Right-click a node and select Expand or Collapse from the pop-up menu.

Stepping In and Out

You can focus the Flow Diagram on jobs in only selected applications, groups, 
CONTROL-M installations or scheduling tables. This option limits the Flow Diagram 
to only jobs in the selected entities. 

Stepping In and Out of the Flow Diagram is not the same as Expanding and 
Collapsing.

■ When you Expand a part of the Flow Diagram, the groups and applications or 
scheduling tables and CONTROL-M installations are still displayed in the 
window.

■ When you Step In to a part of a Flow Diagram, only the nodes in the selected 
entities are displayed. When you Step Out, the window returns to the previous 
display.
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Figure 22 Sample step In display

To Step In to an entity in the Flow Diagram:

Right-click the node for the entity and select Step In from the pop-up menu.

-or-

Select the node for the entity and click .

To Step In to multiple entities in the display:

1 Hold down the Ctrl key and click the wanted entity nodes.

2 Right-click the selected entities and select Step In from the pop-up menu.

- or -

Click  .

NOTE  
You can Step In and Step Out to or from any level of the Flow Diagram. Multiple entities can 
be selected for Stepping In.
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To Step Out from the display:

Right-click anywhere in the background of the Flow Diagram, and select Step Out 
from the pop-up menu.

-or-

Click anywhere in the background of the Flow Diagram, and then click .

Zooming in or out

By zooming in and out of the Flow Diagram, you can change the size of the nodes in 
the Flow Diagram.

■ Zooming out makes the nodes smaller so that you can view a larger portion of the 
job production flow.

■ Zooming in makes the nodes larger so that you can focus on a smaller area of the 
flow, and more easily create multiple job dependencies. 

To increase or decrease the size of the Flow Diagram:

Use any of the following methods:

■ Click  or . Repeat as necessary.

■ Select the size in the Flowdiagram Zoom  box on the toolbar. You can also 
type in an alternative size and press Enter.

■ Right-click anywhere in the background of the Flow Diagram, and select Zoom In 
or Zoom Out from the pop-up menu. Repeat as necessary.

TIP  
Use the Zoom In/Out feature together with a collection of jobs in the draft (see Chapter 6, 
“Filtering data using collections”) to view a specific part of the job production flow in a single 
window.
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Finding jobs

You can find nodes in the Flow Diagram using the Find/Select Jobs dialog box. The 
Find/Select Jobs dialog box allows you to specify combinations of job processing 
definition parameters (fields and values) to be used as criteria for finding and 
selecting nodes in the current displayed draft. Each node is highlighted in the Flow 
Diagram in the Draft window.

The Find/Select Jobs feature can be used to find any job in a draft or when a 
collection within a draft is displayed. However, when a collection is displayed, only 
jobs in the collection are searched. Jobs that satisfy selection criteria that are in the 
draft but are not part of the collection are ignored.

To find a job:

1 Choose Edit => Find/Select Jobs.

Figure 23 Find/Select Jobs Dialog Box

2 Select fields and specify their values. 

Up to five fields and their accompanying values can be specified. The relationship 
between the fields in the Find/Select Jobs dialog box is AND. Specified values are 
case-sensitive and must be entered exactly as described in the CONTROL-M Job 
Parameter and Variable Reference Guide. 

3 Click Find/Select.

The jobs that match the specified criteria are selected. Note that you can use the 
Selection buttons on the toolbar to toggle through the selected jobs.

NOTE  
Only one value can be specified for each parameter. However, pattern-matching strings can 
be used to enhance search capabilities. For details on pattern matching rules, see “Specifying 
Pattern-Matching strings” on page 39.
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Identifying predecessor and dependent jobs (Neighborhood)

The Neighborhood option identifies jobs that are predecessors or dependents of a 
selected job or group scheduling table and highlights the nodes of those jobs in the 
Flow Diagram. 

The Neighborhood option is not available in any of the following instances:

■ When condition nodes are displayed.
■ When more than one node is selected in the Flow Diagram or Navigation Tree.

To identify applicable jobs with Neighborhood

1 Right-click a job or group scheduling table node in the Flow Diagram and choose 
Neighborhood from the pop-up menu.

-or-

Select a job or group scheduling table node in the Flow Diagram or the tree and 
choose Tools => Neighborhood.

The Neighborhood dialog box is displayed:
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2 Select a value from the Direction list box to indicate the direction in which to 
extend the search for applicable nodes. Direction values are described in Table 4. I

3 Specify a numerical value in the Radius text box.

4 Click Find. The applicable job nodes in the Flow Diagram are selected. 

Table 8 Neighborhood dialog box elements

Element Description

Data Center CONTROL-M installation in which the selected job was run. Entered 
automatically by CONTROL-M/EM.

Mem Name Mem Name of the selected job. Entered automatically by CONTROL-M/EM.

Scheduling 
Table

Scheduling table of the selected job. Entered automatically by 
CONTROL-M/EM.

Direction Indicates the types of nodes to select.

Radial Identifies relevant job nodes branching in all directions.

Direct 
Relationships

Identifies predecessor and the dependent nodes that are 
directly above and below the selected node. The number 
of levels surveyed is determined by the Radius parameter.

Predecessor Identifies the predecessor nodes of the selected job. The 
number of levels surveyed is determined by the Radius 
parameter.

Dependent Identifies the nodes dependent on the selected job. The 
number of levels surveyed is determined by the Radius 
parameter.

Radius Number of nested levels that are selected branching out from the selected 
node. Valid values: 1-99999.

Number of 
Nodes Found

Displays the number of nodes that are selected when Find is clicked.

Find Identifies and selects applicable job nodes.

Close Closes the Neighborhood dialog box.

NOTE  
The Neighborhood dialog box is displayed until you click Close.
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Branching in the Flow Diagram

Using the Branch Menus option in the popup menu of a node in the Flow diagram, 
you can display predecessor or successor jobs, jobs/scheduling tables, and (if 
working in Conditions mode) conditions, within the Viewpoint. Dependencies are 
indicated by arrows pointing in the appropriate direction.

To display predecessor or successor jobs/groups/conditions for a node:

1 From the popup menu for the node, select the Branch Menus option.

2 From the popup submenu, select either Predecessor or Successor.

The next submenu displays a list of jobs, groups, and conditions (if you are 
working in Condition mode).

3 Select the job, group or condition that you want to display.

The selected job, group or condition node (and relevant connected nodes) are 
displayed, and become the new current node. 

NOTE  
The Flow diagram modes set in the Tools => Options dialog box affect the display.

■ If you are working in Condition mode, condition nodes (see page 87) are displayed in 
addition to job and job/scheduling group nodes, in the menu selection list. In addition, 
Branch menus will be available for Condition nodes. Note that if your site displays 
deleted Out conditions with dotted lines, any such deleted Out conditions will be 
displayed.

■ If you are working in Expand/Collapse mode (see page 63) and you select a job, the upper 
nodes are automatically expanded in the Flow diagram (if need be).

■ If you are working in Step In/Step Out mode (see page 65)

■ If the selected job is at the same level as the current node, the selected job is added to 
the job list.

■ If the selected job is at a higher level than the current node, the Flow diagram changes 
to the level of the Flow diagram to the selected job.
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Modifying drafts
This section describes methods for modifying the contents of a draft. 

■ Selecting nodes manually
■ Viewing only the selected nodes
■ Moving jobs
■ Copying jobs
■ Deleting jobs
■ Modifying jobs
■ Creating dependencies

Selecting nodes manually

You can select multiple nodes in the Flow Diagram or the Navigation Tree. This 
enables you to perform a single action that affects multiple nodes.

To select a single node:

Click the required node. Node color changes, indicating that it is selected.

To select multiple nodes using selection mode:

1 Click  to enter selection mode.

2 Place the cursor in the Flow Diagram window. Hold down the left mouse button 
and drag the cursor over the required nodes. A dotted rectangle is displayed as 
you drag the cursor. Release the mouse button to complete the select action. All 
nodes within the rectangle are selected. 

To select all nodes in the Flow Diagram:

This option selects those nodes currently displayed in the Flow Diagram. this option 
does not select all nodes in the current ViewPoint. 

NOTE  
This option does not select condition nodes.
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Choose View => Select All. All nodes in the displayed in the Flow Diagram are 
selected.

Navigating within a set of selected nodes

If several nodes are selected simultaneously in the Flow Diagram, it is possible to 
navigate between the selected nodes, changing the focus from node to node.

For instructions on how to select multiple nodes, see “Selecting nodes manually” on 
page 72.

To navigate within a set of selected nodes

With a set of nodes selected, click the following buttons in the 
CONTROL-M/Enterprise Manager window toolbar (or corresponding options in the 
View => Toggle Selection menu) to navigate:

NOTE  
Select All works in both Definition mode and Selection mode.

NOTE  
Select All can select nodes of any type other than condition nodes.

Button Description

Navigate to the first node in the set, making it the focused node.

Navigate to the previous node in the set, making it the focused node.

Navigate to the first next in the set, making it the focused node.

Navigate to the last node in the set, making it the focused node.
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Viewing only the selected nodes

You can open a special ViewPoint that contains only the selected nodes in the current, 
regular ViewPoint. 

This type of ViewPoint is similar to regular ViewPoints. However, because it is based 
on a fixed set of nodes:

■ filters cannot be applied
■ nodes may be deleted from the ViewPoint, but not added (including during a 

refresh of the ViewPoint)

To view selected nodes in their own ViewPoint:

With a set of nodes selected, select the View => View Selection menu option. The 
special ViewPoint opens.

Browsing jobs

Browse, instead of opening, a job processing definition enables you to view the job 
read-only, without locking its scheduling table.

NOTE  
If high level entities (for example, scheduling groups) are selected in addition to job nodes, all 
jobs in the high level entity are also considered to be selected. The resultant Flow Diagram is 
opened at the level of the high level node.

TIP  
This type of ViewPoint can also be opened as a result of performing the Critical Path, 
Neighborhood and Enhanced Why operations. 

TIP  
This is particularly useful when working in online load mode and you do not want to 
interfere with other users’ work.
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To browse a job processing definition: 

1 Right-click the job node in the Flow Diagram.

2 Select Browse Job from the pop-up menu. The Job Editing form is displayed but 
cannot be modified.

Moving jobs

The location of a job in the Navigation Tree corresponds directly to the values of 
certain parameters in the job processing definition (Application, Group, 
CONTROL-M, and Scheduling Table). You can change the values of these parameters 
using either the Navigation Tree or the Job Editing form: 

■ If you change the location of a job in the Navigation Tree, the corresponding values 
in the job processing definitions are automatically changed accordingly.

To move a job in the Navigation Tree:

Use the mouse to drag the job from one location in the Navigation Tree and drop it in 
a different location:

■ With the Application hierarchy displayed, drag a job from one group to another. 
Note that the destination group does not need to be in the same application. 
Parameters Application and Group are automatically modified to reflect the new 
location of the job. 

■ With the CONTROL-M hierarchy displayed, drag a job from one scheduling table 
to another in the same or a different CONTROL-M. The CONTROL-M and 
Scheduling Table parameters are automatically modified to reflect the new 
location of the job. 

Figure 24 Moving jobs between scheduling tables
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Moving a job using the Job Editing form

If you change the value of any of the relevant parameters in the Job Editing form, the 
location of the job in the Navigation Tree is automatically updated:

■ When parameters Application or Group are modified, the job moves to the 
appropriate location in the Application hierarchy.

■ When parameters CONTROL-M or Scheduling Table (or Library) are modified, the 
job moves to the appropriate location in the CONTROL-M hierarchy.

Copying jobs

You can copy a job processing definition from a source job and create a new, identical 
job processing definition. The new job is given the same name as the source job, and 
identical properties (conditions, resources, and so on). The new job is assigned a 
unique identification number, so that it can be differentiated from the source job. 

The new job is created in the same group or table as the source job, and it is added in 
the appropriate place in the Flow Diagram.

Alternatively, you can perform a combined Edit and Copy. This operation displays 
the copy of the source job in the Job Editing form. You can then edit the copy of the 
job before you save it to the database.

NOTE  
In CONTROL-M for OS/390 and z/OS, CONTROL-M and Scheduling Table are not 
regarded as modifiable parameters. However, CONTROL-M/Desktop allows you to modify 
these attributes in the same manner as any other parameter. If you drag a job from one table to 
another, the library name is also updated.

NOTE  
You cannot move jobs in a group scheduling table to another group scheduling table or to an 
ordinary scheduling table. You cannot move jobs in an ordinary scheduling table to a group 
scheduling table.

NOTE  
When working in online mode, you can only modify existing jobs; you cannot create new 
ones.
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To perform a Copy operation on a job (local mode only)

1 Use one of the following methods to copy a job:

■ Click .

■ Right-click the job node of the source job in the Flow Diagram, and select Copy 
from the pop-up menu.

■ In the Flow Diagram, select the job node of the source job, and choose Edit => 
Job => Copy.

A copy of the job, with a unique identification number, is added to the Flow Diagram.

To perform an Edit and Copy operation on a job (local mode only)

1 Use one of the following methods to copy a job:

■ Right-click the job node of the source job in the Flow Diagram, and select Edit 
and Copy from the pop-up menu.

■ In the Flow Diagram, select the job node of the source job, and choose Edit => 
Job => Edit and Copy.

A copy of the job, with a unique identification number, is opened in the Job Editing 
Form.

2 Edit the copy of the job as wanted and perform a Save.

NOTE  
Copy and Edit and Copy each create only one job at a time. To create more than one job, the 
Copy or Edit and Copy process must be repeated, or an identical job processing definition 
must be created with the Mass Create feature. For more information about Mass Job Creation, 
see Chapter 4, “Creating and updating multiple jobs.”

NOTE  
Clicking Cancel in the Job Editing Form also cancels the copy part of the operation.
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Deleting jobs

When you delete a job, you are actually deleting it from the draft. It is therefore 
automatically deleted from all views in any panes in which it appears. You can also 
delete an ordinary scheduling table and all its jobs, or a group scheduling table and 
all its jobs. 

To delete an item from the Navigation Tree:

1 Select the item to be deleted in the Navigation Tree. 

2 Press Delete or click the Delete Job  button on the toolbar. 

3 Confirm the deletion in the Confirmation window that is displayed.

To delete a job in List Mode view:

1 Click the job to be deleted.

2 Press the Delete key.

-or-

Click .

-or-

Right-click the selected item and select Delete from the menu.

3 Confirm the deletion.

To delete multiple jobs from List Mode view: 

1 Use one of the following methods for selecting the items:

■ Select the jobs by clicking on the first job to be delete and while pressing the 
Shift key, click the last job to be deleted.

■ Click and drag a rectangle over the jobs.

■ Hold down the Ctrl key and click the jobs.
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2 Press the Delete key.

-or-

Click .

-or-

Right-click the selected items and select Delete from the menu.

3 Confirm the deletion.

To delete a job from the Flow Diagram:

1 click the job to be deleted. 

2 Press the Delete key, click , or right-click the selected item and select Delete 
from the menu.

3 Confirm the deletion.

To delete multiple jobs from the Flow Diagram:

1 Select the jobs to be deleted by holding down the Ctrl key and clicking on each of 
the job nodes.

2 Press the Delete key, click , or right-click the selected item and select Delete 
from the menu.

3 Confirm the deletion.

To delete all jobs in an application, group, CONTROL-M, or scheduling table 
from the Flow Diagram:

1 Click the appropriate application, group, CONTROL-M or scheduling table node.

2 Press the Delete key, click , or right-click the selected item and select Delete 
from the menu.

3 Confirm the deletion.

When an upper level node is deleted, all the lower level nodes (for example, groups, 
tables, or jobs) are deleted.
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Modifying jobs

You can view or modify job processing definitions from the Flow Diagram using the 
Job Editing form. Only one job can be edited at one time. 

In CONTROL-M/Desktop, job processing definitions are edited using the Job Editing 
form. This form can be opened in a number of different ways.

For more information about this form, see Chapter 3, “Working with the Job Editing 
form.”

To open an existing Job Editing form in the Flow Diagram:

■ Double-click the job in the Navigation Tree or the job node in the Flow Diagram.

-or-

■ Right-click a job node in the Flow Diagram, and select Edit Job from the menu.

The Job Editing form is displayed. You must close the Job Editing form using the OK 
or Cancel button at the bottom of the form, before you can return to the original 
display.

To open a Job Editing form for a new job:

Choose Edit => Job => New Job, or click . 

The Job Editing form is displayed on top of the Flow Diagram.You must close the Job 
Editing form using OK or Cancel before you can return to the original window.

If you close the Job Editing form, changes are immediately applied to the draft views 
in the CONTROL-M/Desktop window.

For more information, see Chapter 3, “Working with the Job Editing form.”

NOTE  
The Job Editing form for the new job is displayed with default values from the current 
skeleton. For more information about job skeletons, see Chapter 4, “Creating and updating 
multiple jobs.”
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Creating dependencies

Managing conditions

Prerequisite conditions (In conditions and Out conditions) can be created, modified, 
and deleted from within the Flow Diagram.

Creating and modifying conditions and dependencies

You can view and create job dependencies in the Flow Diagram. These dependencies 
are determined by IN and OUT statements defined in job processing definitions, and 
group scheduling tables. The following symbols are used to indicate job 
dependencies in the Flow Diagram: 

■ Connectors  at the bottom of predecessor job nodes or group nodes represent the 
Out conditions. 

■ Connectors  at the top of the successor job nodes or group nodes represent the 
job’s In conditions. 

■ Dependency lines drawn between Connectors represent the dependencies between 
the various jobs and groups.

Additionally, dependency lines may be displayed using dotted lines. A dotted line 
between two jobs indicates a conditional link between the two job. This means that 
the jobs contain the same defined condition but one of the jobs contains one of the 
following parameters:

■ Out conditions which delete a condition (-).

■ Conditions specified with the Do Condition parameter based on conditional post 
processing actions. 

NOTE  
When working in online mode, prerequisite conditions cannot be created or deleted.

NOTE  
Job dependencies can also be determined by conditions created using Do Condition 
parameters. These conditions are displayed using the same conventions as In and Out 
conditions. For more information, see Chapter 2, “Displaying conditions created by Do 
statements.”
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■ Optional In conditions (In conditions that are defined using Or logic, so that not all 
specified In conditions must exist for a job to run).

The direction of the arrows at the ends of the lines indicates the flow direction (such 
as the relative relationship) of the connected nodes.

To create a job dependency:

1 Click the predecessor job node and drag the mouse to the successor job node. 

CONTROL-M/Desktop creates the In/Out Connectors and Dependency line.

When you create a dependency, CONTROL-M/Desktop automatically adds the 
required In conditions and Out conditions to the job processing definitions.

To display a predecessor job or successor job:

1 Right-click the connector line.

2 Select Goto In Connector or Goto Out Connector from the pop-up menu.

NOTE  
The display of dotted lines depends on settings for the following options in the 
Flowdiagram - Links panel of the Options dialog box (see Chapter 11, 
“Customization”).

■ Display Do Conditions
■ Display Out Conditions with Minus Sign
■ Display Optional In Condition

NOTE  
Dependencies can be created when working in local mode only.

NOTE  
The name and format of new conditions conform to the value specified in the Condition 
Format field in the current Skeleton. 

NOTE  
Depending on the resolution (zoom value) of your display and the number of jobs in the Flow 
Diagram, certain predecessor or successor jobs may not be displayed near their related jobs or 
groups. This feature enables you to quickly jump to a predecessor or successor job.
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To display a job’s prerequisite conditions:

■ Click and hold the left mouse button on the job’s In Connector to display the job’s 
In conditions.

■ Click and hold the left mouse button on the job’s Out Connector to display the 
job’s Out conditions.

Figure 25 In Conditions Window

To modify or delete job dependencies:

1 Double-click the job node to display the Job Editing form for the job. 

2 Select the Conditions panel and edit the In conditions or Out conditions. For more 
information, see Chapter 3, “Working with the Job Editing form.”

Displaying conditions created by Do statements

Display of conditions that are created using a Do Condition parameter is handled 
separately from conditions created using an Out statement.

To display job dependencies that rely on Do Condition parameters, select the Display 
Do-Conditions option in the Flowdiagram - Links panel of the Options dialog box. 
When this option is selected, CONTROL-M/Desktop displays:

■ Links between job nodes that were created by Do Condition parameters (as dotted 
lines).

■ Conditions created by Do Condition parameters, in addition to In and Out 
conditions, in the Delete Dependency dialog box. 

For more information, see Chapter 11, “Customization.”

NOTE  
When working in online mode, you cannot delete a job dependency. 
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Deleting dependencies

You can delete conditions (dependencies) between jobs by deleting the job node lines 
that connect dependent jobs from the CONTROL-M/Desktop Flow Diagram.

When a condition is deleted in the Flow Diagram, the appropriate In condition, Out 
condition and Do Condition parameter can be removed from each connected job 
processing definition. 

To delete a dependency between jobs:

1 Right-click the dependency line of the condition that you want to delete. The 
following popup is displayed: 

2 Click Delete Dependency. The Delete Dependency dialog box is displayed:

NOTE  
When working in online mode, you cannot delete a job dependency. 
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3 Select the name of the condition that you want to delete from the Condition list. 
The names of the jobs in which the selected condition is specified as an Out 
condition, an In condition, or a Do Condition parameter are displayed.

4 Select the jobs from which the selected condition is to be deleted from the Job 
Name list. 

5 Click OK. 

6 If the condition being deleted was created by a Do Condition parameter, and the 
Do Condition parameter is the last parameter in that job processing definition’s 
step, the following confirmation dialog box appears. Click Yes to delete the 
dependency and the step. Clicking No does not delete the dependency.

7 The Delete Dependency dialog box closes, and the dependency line is deleted 
from the Flow Diagram. 

If the Out condition was not deleted, the condition connector remains on the 
underside of the job node that supplied the Out condition:

NOTE  
The Delete Dependency dialog box is displayed by default. If this default setting is changed, 
the dialog box is not displayed and the dependency is deleted automatically according to the 
behavior set using the Flowdiagram - Links panel in the Options dialog box. To change the 
behavior of the Delete Dependency feature, see page 86.

The conditions displayed in the Delete Dependency dialog box can also be customized. 
Conditions created by Do Condition parameters can be displayed or suppressed depending 
on settings in the Flowdiagram - Links panel in the Options dialog box. To set whether or not 
these conditions are displayed, see page 88.

NOTE  
After deleting a condition, a dependency line is still displayed between the two nodes if the 
nodes are still linked by other conditions (which were not deleted).
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Example: Multiple In conditions sharing the same Out condition

Condition C1 is an Out Condition for Job_A and an In condition for jobs Job_B, 
Job_C, and Job_D. You no longer want C1 to be an In condition for Job_D. You must 
remove C1 only from Job_D. 

In this case, you should not remove the C1 Out condition from Job_A. If you do this, 
other jobs (Job_B and Job_C) are also affected.

To modify Delete Dependency behavior 

1 Click Tools => Options to display the Options dialog box and select the 
Flowdiagram - Links panel:

2 Select the required Delete Dependency action from among the three options in the 
Delete Dependency field:

NOTE  
If you remove an Out condition from a job, the jobs for which it is an In condition do not run.

Option Description

Delete only IN cond Deletes only the In condition, when Delete Dependency is selected 
from a dependency line popup menu. The Out condition in the 
predecessor job is not affected.

Delete IN, OUT conds Deletes both the In condition and the Out (or Do Cond) condition, 
when Delete Dependency is selected from a dependency line 
popup menu.

Ask what to delete Displays the Delete Dependency dialog box. Default.
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Condition nodes

Prerequisite conditions can be displayed as separate nodes in the Flow Diagram. 
When displayed, conditions appear as elliptical icons (condition nodes) linked to the 
various types of nodes in the Flow Diagram. 

Condition nodes describe dependencies between jobs. They are most useful when 
viewing a small number of jobs. For example, a condition node is displayed between 
two scheduling table nodes when one or more jobs in one scheduling table are 
dependent on one or more jobs in the other scheduling table.

Figure 26 Condition nodes

To display Condition nodes: 

1 In the Flow Diagram window, click Tools => Options, and select the Flowdiagram 
- Links panel.

2 Select the Display Condition nodes checkbox.

NOTE  
The Expand function is not available when condition nodes are displayed. In this case, you 
can use only the Step In and Step Out functions to move up and down the node hierarchy.
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Condition nodes can also be created using the drag and drop function (in local mode). 
If a dependency is created by dragging a connecting line from one job node to another 
while condition nodes are displayed, a new condition node is displayed 
automatically on the connecting line.

Conditions created or deleted by Do Condition parameters (instead of In and Out 
statements), and their corresponding links, can be displayed or suppressed in the 
Flow Diagram according to options set in the Flowdiagram - Links panel of the 
Options dialog box.

To display condition nodes and links created by Do Condition parameters: 

1 Click Tools => Options and select the Flowdiagram -Links panel.

2 Select the Display Do-Conditions (as links or nodes) checkbox.

Working with group scheduling tables
Group scheduling tables can be created (in local mode only), modified, and deleted in 
the Flow Diagram graphical environment.

Creating group scheduling tables

You can create new group scheduling tables in the Flow Diagram when working in 
local load mode. Processing parameters from the current skeleton are copied to the 
new group scheduling table (see “Skeletons” on page 30). Skeletons do not contain 
Schedule Tag definitions, so you must define at least one Schedule Tag for a new 
group scheduling table. 

NOTE  
When the Display Condition nodes check box is selected, the Expand-Item and the 
StepInto-Item options in the Flowdiagram - Nodes panel are not available.



Working with group scheduling tables

Chapter 2    Working with drafts in the definition environment 89

To create a new group scheduling table:

1 Choose Edit => Scheduling Group => New, or click .

To edit an existing group scheduling table:

1 Double-click the group scheduling table node or choose Scheduling Group=>Edit.

The Group Editing form is displayed over the Flow Diagram. After making 
changes, close the Group Editing form using OK or Cancel.

If you close the Group Editing form, specified changes are immediately applied to 
the draft views in the CONTROL-M/Desktop Draft window.

For more information, see Chapter 5, “Working with the Group Editing form.”

Deleting group scheduling tables 

Use one of the following methods to delete a group scheduling table: 

■ Select the group scheduling table node, and choose Edit => Scheduling Group => 
Delete.

■ Select the group scheduling table node, and click .

■ Right-click the group scheduling table node, and select Delete from the pop-up 
menu.

NOTE  
CONTROL-M/EM does not support definition of group scheduling tables for CONTROL-M 
for OS/390 versions earlier than 6.0.00.

NOTE  
When working in online mode, you cannot create a group scheduling table. 

NOTE  
The Group Editing form for a new group scheduling table is displayed with the default values 
taken in the current skeleton. For more information, see “Skeletons” on page 30.
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Printing a draft
Printing a draft enables you to print the production flow on paper. The printed pages 
are labelled so that you can easily assemble the pages side-by-side in the correct 
order, in a poster-like format.

The printout is generated to match the draft as it is currently displayed. For example, 
the resolution of the printout is determined by the resolution on your screen. You can 
adjust the resolution, and subsequently the amount of information printed on each 
sheet of paper, by zooming in or zooming out of the Flow Diagram.

The printout can also include an index of all the nodes displayed in the production 
flow. The index is printed as the last page, after the graphical representation of the 
production flow.

The following topics are described below. 

■ Previewing a draft
■ Working with the Print Preview window
■ Adjusting print settings
■ Printing the draft

Previewing a draft

Before printing, preview the production flow to make sure it will print as wanted.

To preview the draft

1 Display the draft you want to print.

2 Choose File => Print Preview. The Print Preview window is displayed, displaying a 
graphical representation of how the draft will print.
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Figure 27 Print Preview window

Working with the Print Preview window

Rulers

Rulers are located on the left and top areas of the Print Preview window. The marks 
on the rulers indicate relative distance, not inches or centimeters. Use the marks to 
locate specific nodes. The rulers can also appear on the draft printout.

Columns are labelled alphabetically from right to left, and column numbering begins 
with A. Rows are labelled numerically from top to bottom, and row numbering begins 
with 0.

Pages are labelled:

■ alphabetically in the order they should be assembled horizontally (A, B, C, and so 
on)

■ numerically in the order they should be assembled vertically (0, 1, 2, 3, and so on)
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Status bar

The Print Preview window status bar provides additional information to aid in 
navigating the window.

Available actions

From the Print Preview window, you can perform any of the following actions.

Index

An index describing the contents of the current draft can be displayed in the Print 
Preview window. When printing the draft, the index can be printed also. The index 
display can be toggled on and off using the Index Table option from the Print Setup 
dialog box (File  => Print Setup).

EXAMPLE  
■ B.A corresponds to the first column on the second page horizontally.
■ 3.2 corresponds to the second row on the third page vertically.

Table 9 Status Bar Information

Measure Description

Pages Page(s) currently displayed

of Total number of pages

diagram pages Number of pages in the draft

index pages Number of pages in the index

Table 10 Print Preview Actions 

Click... To...

File => Print Setup Change settings before printing. For more information, see 
“Adjusting print settings” on page 95.

Print... Open the Print window and print the draft. For more information, 
see “Printing the draft” on page 96.

Next Page Display the page(s) after the currently displayed page(s).

Prev Page Display the page(s) preceding the currently displayed page(s).

Two Page / One Page Toggle between a one-page view and a two-page view.

Zoom In Display the current page(s) at a larger magnification.

Zoom Out Display the current page(s) at a smaller magnification.

Close Close the Print Preview window and returns to the main 
CONTROL-M/Desktop window.
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The first line of the index summarizes the number of nodes, columns and rows in the 
draft.

Figure 28 illustrates a sample index. Table 11 describes the columns of the index.

Figure 28 Sample index
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To sort the index table in a different order, use the Sort Order field in the Print Setup 
dialog box.

Table 11 Index columns 

Column Description

Node Name The job name of the node.

Node Type Type of the node (for example, Application, Data Center, Job).

Node Hierarchy Full path indicating where the node is displayed in the Flow Diagram 
hierarchy.

Column The column of the draft in which the node is displayed. Column 
numbering begins with A, and is displayed in the following format: 

x.y

x is a letter representing the current page in the order the pages should 
be assembled horizontally.

y is a letter representing the current column on the page.

Example:

B.A corresponds to the first column on the second page horizontally.

Row The row of the draft in which the node is displayed. Row numbering 
begins at 0, and is displayed in the following format.

m.n

m is a number representing the current page in the order the pages 
should be assembled vertically.

n is a number representing the current row on the page.

Example:

3.2 corresponds to the second row on the third page vertically.
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Adjusting print settings

1 Display the draft.

2 Choose File => Print Setup. The Print Setup window is displayed.

3 Change settings as wanted. Settings for printing a draft are described in Table 12.

4 Click OK.

Table 12 Draft-specific print settings

Parameter Description

Ruler If the ruler should be printed at the top and the left side of the draft.

Index table If the index should be printed at the end of the draft. The index can only be 
printed if rulers are printed.

Sort order Sort order. The index can be sorted by node name, type, column, row, and 
hierarchy.

Zoom Magnification percentage of the screen, or indication that the zoom should be 
the same zoom factor as the display.

Page Header If the page header should be printed.

Page Footer If the page footer should be printed.
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Printing the draft

The Print function divides the area contained in the draft into pages. Each page 
corresponds to part of the diagram that is displayed on your monitor.

To print the entire draft

1 Display the draft.

2 Choose File => Print to display the Print window and click OK.

To print selected pages of the draft

1 Display the draft.

2 Choose File => Print to display the Print window.

3 In the Print window, select the Pages option in the Print Range section of the Print 
window.

4 In the from and to text boxes, enter numbers of the first and last pages in the range 
of pages you want to print and click OK.

NOTE  
Settings which affect how the draft itself is displayed are unavailable.
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C h a p t e r 3
3  Working with the Job Editing form

In CONTROL-M/Desktop, the editing of job processing definitions is performed 
using the Job Editing form. The following are the formats of the Job Editing form: 

■ Window Format
When you choose View => List/Job Editing Form and click on the job in Tree view 
in the left pane, the Job Editing form is displayed. When using this format, you can 
move between job processing definitions by clicking jobs in the tree without 
closing and opening the form for each job.

If modifications are made to the form in this format, select Apply at the top of the 
form to save the changes before selecting the next job from the tree or changing 
views. Select Cancel to undo the changes.

■ Dialog Box Format
If the Job Editing form is opened by any of the other methods (listed below), it is 
displayed as a separate dialog box. When displayed in this format, the Job Editing 
form may need to be closed before you perform certain processes. If modifications 
are made to the form, click Save to Draft (or Save to Database if working in online 
load mode) on the bottom of the form.

To open a Job Editing form for an existing job:

Use any of the following methods to open the Job Editing form:

■ Double-click on the job name or icon in Tree view under Flow Diagram format 
(View => Flowdiagram).

■ Double-click on the job in List view.

■ Double-click on the job node in Flow Diagram view.

■ Right-click on the job node in Flow Diagram view, and select Edit Job from the 
pop-up menu.
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To open a Job Editing form for a new job:

Choose Edit => Job => New Job from the menu bar or click .

NOTE  
If you want CONTROL-M/Desktop to perform validity checks each time you select the 
Apply, Save to Database, or Save to Draft button on the Job Editing form, choose Tools => 
Options and select the Always check the validity of jobs check box in the General panel. For 
more information, see Chapter 11, “Customization.”
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Job Editing form layout
Each panel of the Job Editing form is used to define a certain type of parameter. 
Table 13 describes the panels of the Job Editing form.

Figure 29 Job Editing form

Each of these panels is described below in detail.

NOTE  
Apostrophes are not supported in the Job Editing form. Do not include apostrophes in any 
values entered in the Job Editing form.

Table 13 Job Editing form panels

Panel name Description

General What the job does and where its script is located.

Scheduling When and/or how often the job should be scheduled for submission.

Execution Parameters related to job execution and accompanying processes.

Conditions Prerequisite conditions which must be satisfied before job submission, and 
conditions to be added/deleted when the job is successfully completed.

Resources Quantitative and Control resources required for job submission.

Set AutoEdit variables to be set when the job is submitted.

Steps Conditional post-processing instructions.

PostProc “Shout When” and Sysout-handling post-processing instructions.

Tags Selection Schedule tags to be applied to jobs in group scheduling tables.
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Undo and Redo in the Job Editing form

During the job editing process, actions in the Job Editing form can be undone (using 
Ctrl-z) or redone (using Ctrl-y). 

The number of actions that can be undone or redone (default: 100) is determined by 
settings in the General panel of the Options dialog box.

To toggle the JEF Undo/Redo feature on and off or adjust the number of actions 
that can be undone/redone:

Click Tools => Options.

The General panel is displayed by default.

Figure 30 Options dialog box - General panel

NOTE  
The parameters in the Job Editing form can vary depending on the CONTROL-M platform for 
which the job is being defined. Each parameter is described in the CONTROL-M Job Parameter 
and Variable Reference Guide and in the CONTROL-M for OS/390 and z/OS User Manual.

Additional panels may be displayed in the Job Editing form for jobs whose skeleton indicates 
a specific application type (such as Oracle and SAP).

NOTE  
Undo and redo are not confined to the panel of the Job Editing form that is currently 
displayed. The undo and redo features automatically move among panels in the Job Editing 
form.
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General panel

The General panel indicates what the job does and where it is located. There are three 
possible versions of the General panel:

■ The regular General panel, (described below).
■ The General panel for MVS jobs (see page 103).
■ The General panel for application-specific jobs (see page 104).

Table 14 describes the parameters in the General panel of the Job Editing form.

Figure 31 General panel of the Job Editing form

Table 14 General panel parameters  (Part 1 of 3)

Parameter Description

Job Name Name of the job. (Text) 

File Name Name of the file that contains the job Script. (Text) 

Note: This parameter is called Memname when specified in utilities of 
CONTROL-M/EM or CONTROL-M.

Path Full path for the file that contains the job script. (Text) 

Note: This parameter is called Memlib when specified in utilities of 
CONTROL-M/EM or CONTROL-M.

Over Lib Name of the library/directory to use instead of the library/directory 
specified in the Path field. (Text) 

Owner Owner (user ID) of the job. This parameter is used by the CONTROL-M 
security mechanism. (Text) 
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Author Original author of the job. (Text) 

If defining a new job definition while CONTROL-M/Desktop is not 
currently connected to a GUI Server, the Author field is displayed as 
<username> until the job definition is written to CONTROL-M/EM, at 
which time your user ID is saved in the Author field.

Note: The Author field may be unavailable depending on the value of the 
AuthorSecurity system parameter, and if you are not a CONTROL-M/EM 
administrator. For more information, see the Security chapter and the 
description of the AuthorSecurity system parameter in the 
CONTROL-M/Enterprise Manager Administrator Guide.

Task Type Type of the job (task) to be performed by CONTROL-M. Valid values are: 
Job, Detached Job, and Command. (List) 

Command The job runs the command in the Command 
parameter. 

Detached Detached job in OpenVMS 

Dummy The job does not run but does its preprocessing and 
post processing. It is used to check job flow. 

Job A normal job that submits the file specified in File 
Name to the operating system. 

External A job that runs on an external application, such as 
SAP or Oracle Applications.

Group A group scheduling table. This option is displayed 
under Task Type only on the Group Editing form.

Table Name of the scheduling table to which the job belongs. Together with 
parameter CONTROL-M, this determines the position of the job in the 
CONTROL-M/Scheduling Table hierarchy. (Text) 

Application Name of the application to which the job’s group belongs. Together with 
parameter Group, this determines the position of the job in the 
Application/Group hierarchy. (Text)

Group Name of the group to which the job belongs. Together with parameter 
Application, this determines the position of the job in the 
Application/Group hierarchy. (Text) 

CONTROL-M Name of the CONTROL-M to which the job belongs. Together with 
parameter Scheduling Table Name, this determines the position of the job in 
the CONTROL-M/ Scheduling Table hierarchy. (Text)

Doc Mem Name of the file/member in which the documentation resides. This can be 
viewed using the Documentation option from the Job menu. (Text) 

Note: To access the documentation, the user must be defined and have 
authorization on the CONTROL-M where the documentation resides.

Doc Lib Name of a library/directory containing the documentation file. (Text) 

Note: To access the documentation, the user must be defined and have 
authorization on the CONTROL-M where the documentation resides.

Table 14 General panel parameters  (Part 2 of 3)

Parameter Description
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General panel (MVS)

The General panel indicates what the job does and where it is located. 

Figure 32 General panel (MVS)

Time Zone Indicates the time zone used to calculate when the job should run.

Command Text of the command line to be submitted for the job when the Task Type 
parameter is Command. (Text) 

Description Description of the job. (Text) 

NOTE  
Users of CONTROL-M for z/OS version 6.2.00 or higher may have parameters available that 
are not shown in Figure 32. For more information about these parameters, see Table 15.

Table 15 General panel parameters  (Part 1 of 2)

Parameter Description

Mem Name Name of the member that contains the job JCL. (Text) 

Mem Lib Name of the library that contains the job JCL member. (Text) 

Over Lib Name of an alternate JCL library. CONTROL-M searches for the file 
specified in parameter Mem Name in the Over Lib library before searching 
the Mem Lib library. (Text) 

Table 14 General panel parameters  (Part 3 of 3)

Parameter Description
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General panel for application-specific jobs

As of version 6.2.01, CONTROL-M/Desktop can be used to define jobs for specific 
applications (for example, Oracle Applications or SAP). The application type is 
specified in the Application Type field of the Skeleton Editor form (described in “Job 
skeletons” on page 148). 

Owner Owner (user ID) of the job. This parameter is used by the CONTROL-M 
security mechanism. (Text) 

Task Type Type of the job (task) to be performed by CONTROL-M. Valid values: Batch 
Job and Started Task. For more information about Task Types, see the 
parameters chapter of the CONTROL-M for OS/390 and z/OS User Manual.

Note: The value specified in this field is combined with the Cyclic, and 
Emergency check boxes in the Execution panel to determine the wanted 
tasktype. For more information, see “Execution panel” on page 112.

Scheduling 
Table Name

Name of the table that contains the CONTROL-M job processing definition. 
Together with parameter CONTROL-M, this determines the position of the 
job in the CONTROL-M/Scheduling Table hierarchy. (Text)

Scheduling 
Table Lib

Name of the library that contains the scheduling table. (Text)

Application Name of the application to which the job’s group belongs. Together with 
parameter Group, this determines the position of the job in the 
Application/Group hierarchy. (Text)

Group Name of the group to which the job belongs. Together with parameter 
Application, this determines the position of the job in the 
Application/Group hierarchy. (Text)

CONTROL-M Name of the CONTROL-M to which the job belongs. Together with 
parameter Scheduling Table Name, this determines the position of the job in 
the CONTROL-M/ Scheduling Table hierarchy. (Text)

Time Zone Indicates the global time zone used to calculate when the job should run.

Doc Mem Name of the file/member in which the job documentation resides. (Text)

Note: To access the documentation, the user must be defined and have 
authorization on the CONTROL-M where the documentation resides.

Doc Lib Name of the library/directory containing the job documentation file. (Text)

Note: To access the documentation, the user must be defined and have 
authorization on the CONTROL-M where the documentation resides.

Use In Stream 
JCL

Whether the job is to use a pre-coded JCL procedure. 
This parameter is relevant only for jobs running in CONTROL-M for z/OS 
version 6.2.00 and later.

Description Short job description that appears in the Job List screen. (Text)

Table 15 General panel parameters  (Part 2 of 2)

Parameter Description
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Most parameters in the application-specific General panel are the same as those 
described in “General panel” on page 101. 

Scheduling panel

The Scheduling panel indicates when and how often a job should be scheduled for 
submission. 

Figure 33 Scheduling panel of the Job Editing form 

Three sections of this panel are controlled by option buttons. Data can be specified for 
only one of these sections for each job processing definition. These panel sections are 
described in Table 16.

NOTE  
Before you can create a job for a specific application, you must configure CONTROL-M to 
support specific application jobs. For information about configuring CONTROL-M, see the 
Administrator Guide for the CONTROL-M/Control Module for the relevant application.

NOTE  
Users of CONTROL-M for z/OS version 6.2.00 or higher may have parameters available that 
are not shown in Figure 33. For more information on these parameters, see Table 17.
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The fields of the Scheduling panel are described in Table 17. More detailed 
information for certain parameters is provided in “Month Days: a detailed 
explanation” on page 108 and “Confcal: a detailed explanation” on page 109.

Table 16 Conditional sections of the Scheduling panel 

Parameter Description

Month Days/Week Days Parameters for days-of-the-month and days-of-the-week 
scheduling.

Dates This section contains only the Dates parameter.

PDS Minimum This section contains only the PDS and Minimum 
parameters [MVS only].

Table 17 Scheduling panel parameters  (Part 1 of 3)

Parameter Description

Month Days A calendar and text box used to indicate the days of each month on which 
the job should be scheduled. For a more detailed description of this 
parameter, see “Month Days: a detailed explanation” on page 108.

Month Days 
Calendar

Name of a user-defined calendar for use with the Month Days parameter 
to indicate a set of working days. Specify the name of an existing calendar, 
or specify a new calendar name, and then define it at a later time.

For more information, see Chapter 7, “Managing scheduling tables.”

In various CONTROL-M and CONTROL-M/EM utilities, this parameter 
is also known as DCAL and DAYCAL.

and / or Logical connector establishing the relationship between Month Day 
values and Week Day values. 

Week Days Day(s) of the week on which to schedule the job.

This parameter consists of a series of check boxes for the days of the week 
(Sunday through Saturday), and a text box. Values can be specified using 
the check boxes or the text box.

Note: Regardless of which method is used, the specified values are 
displayed both in the text box and the check boxes above it. 

Weekday Check 
boxes

Each day (Sunday through Saturday) is indicated by 
a separate check box.

Text box Specify the wanted days, using the numeric codes 
according to the site standard. Specified codes should 
be separated by comma. (Text)

Example

1,2,3,4,5 would schedule the job on Monday through Friday (assuming the 
site standard is 0=Sunday, 1=Monday, ... 6=Saturday).
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Weekdays 
Calendar

Name of a user-defined, week-based calendar (WCAL calendar) used 
together with parameter Week Days to specify a set of working days. 
Select from the current list, or specify a different name (this adds the 
specified name to the list). 

Months Months in which to order the job. 

Confcal Calendar used to confirm job scheduling dates. This parameter consists of 
the following subparameters: 

name Name of the calendar. Select from the current list, or 
specify a different name (this adds the name of the 
new calendar to the list). (List)

shift When to schedule the job if the date is not confirmed. 
(Option) Valid values are:

■ Ignore Job. Do not shift the job to a different date. 
The job is not scheduled. 

■ Next Day. Shift to the next working date. 

■ Prev Day. Shift to the previous working date. 

■ No Confcal. Tentatively schedule the job for the 
current day (even if not a working day). 
Additional shifting may or may not be 
performed, depending on the value indicated in 
the Shift Num box. 

See “Confcal: a detailed explanation” on page 109 for a detailed 
explanation of Confcal and the Shift functions.

Shift Num The number of working days that a job can be shifted. Values from -62 to 
62 can be entered. This function is also called Extended Shift. [MVS only]

Dates Dates on which to order the job. Valid values are 4-character dates, in 
mmdd or ddmm format (depending on the site standard). Dates are 
inserted into the list separately, followed by the Enter key. A maximum of 
twelve dates can be specified. If more dates are required, use a calendar. 

Retro Indicates whether the job should be scheduled for possible execution after 
its original scheduled date has passed. 

Statistics 
Calendar

Name of the CONTROL-M periodic calendar in which statistics relating to 
the job are collected. 
This parameter is relevant only for jobs running in CONTROL-M for z/OS 
version 6.2.00 or later.

Active from 
Date

Indicates the start of a period of time during which the job or group 
scheduling table can be ordered. [For MVS jobs and group scheduling 
tables, only]

Table 17 Scheduling panel parameters  (Part 2 of 3)

Parameter Description
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Month Days: a detailed explanation

Month days are specified using either a graphic calendar, or a text box. Selected 
values are displayed in both fields regardless of which field was used to enter the 
specifications. This parameter corresponds to the CONTROL-M DAYS parameter. 

The fields for the Month Days parameter are described below:

Calendar

Each box (1,2, ...31) in the calendar can be toggled on and off:

■ Click a date once to select it for scheduling.
■ Click on an already selected date, deselects that date.

A narrow row of buttons appears above and to the left of the calendar.

■ If you click on a button above the calendar, all dates directly below (that is, that 
day of the week) become scheduling dates.

■ If you click on a button to the left of the calendar, all days in the week to the right 
of the button become scheduling dates.

■ If you click on the button in the corner (first row and first column), all dates 
become scheduling dates.

A column of usage buttons (e.g., +n, -n) is provided to the right of the calendar. These 
buttons can be used to indicate additional scheduling information for jobs that are 
scheduled for a specific date.

Active To Date Indicates the end of a period of time during which the job or group 
scheduling table can be ordered. [For MVS jobs and group scheduling 
tables, only]

SAC Whether to adjust the logical date for a job converted from a scheduling 
product other than CONTROL-M. 
This parameter is relevant only for jobs running in CONTROL-M for z/OS 
version 6.2.00 or later. 

NOTE  
To deselect (unschedule) all dates in a column or row of the calendar, click the button for that 
row or column a second time.

Table 17 Scheduling panel parameters  (Part 3 of 3)

Parameter Description
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Click a calendar date, then click the appropriate usage button. The selected usage 
symbol appears in the selected date box of the calendar. For an explanation of the 
various usage symbols, see Days parameter in the CONTROL-M Job Parameter and 
Variable Reference Guide.

To remove a usage symbol, select the appropriate date and then click the usage 
button.

Text line

Dates can be specified in the text box below the calendar:

■ Usage symbols (e.g., +, -, >) must be specified before the relevant dates.

■ Dates must be separated by commas.

As mentioned earlier, all dates defined using the Text line appear in the chart above 
the line.

Confcal: a detailed explanation

The Confcal field of the Schedule panel specifies a valid calendar name of 1-8 
characters. 

This calendar is used for:

■ Validating scheduling dates
■ Determining the scheduled work day.

Jobs to be scheduled on a given day are checked against the Confcal calendar:

■ If the day is a working day in the Confcal calendar, the job is tentatively scheduled 
on that day. (This day is referred to below as the original scheduling date.) Actual 
scheduling of the job is then determined by the values specified for the Shift and 
Shift Num parameters.

EXAMPLE  
Click on date box 6 and then click on the +n button. A + symbol appears in the calendar box 
for the 6th of the month. This symbol indicates that the job is scheduled on the 6th of the 
month, in addition to any scheduling dates in the DCAL calendar.

NOTE  
As mentioned earlier, all dates defined using the calendar appear in the Text line below the 
calendar.
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■ If the day is not a working day in the Confcal calendar, the Shift parameter is 
checked. Depending on the Shift value, the job may be scheduled on an earlier 
day, a later day, on the original scheduling day, or it may be cancelled.

Shift and Shift Num

The Shift and Shift Num fields determine when and if a job should be scheduled. 
Optional. 

Shift indicates how to shift scheduling of the job if the original scheduling day of the 
job is not a working day in the Confcal calendar.

Valid values for the Shift parameters are described in Table 18.

Shift Num shifts scheduling of the job forward or backward the specified number of 
working days (as defined in the Confcal calendar). Valid Values for the Shift Num 
parameter are described in Table 19.

NOTE  
If no Confcal calendar is specified, no value can be specified for subparameter Shift, and this 
field has no effect on job scheduling.

NOTE  
Shift Num is available on the Job Editing Form only when an MVS CONTROL-M platform is 
selected. In the CONTROL-M for OS/390 and z/OS documentation, Shift Num is referred to 
as “extended shift”.

Table 18 Shift values 

Value Description

Ignore Job No shifting occurs. The job is not scheduled. Default.

Next day Job scheduling is shifted to the next working day in the Confcal calendar. 
Additional shifting may or may not be performed, depending on the 
Shiftnum value (described below).

Prev Day Job scheduling is shifted to the previous working day in the Confcal 
calendar. Additional shifting may or may not be performed, depending on 
the Shiftnum value (described below).

No Confcal Tentatively schedule the job for the current day (even if not a working 
day). Additional shifting may or may not be performed, depending on the 
Shiftnum value (described below).
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The interaction between the Shift value and the Shift Num value is as follows:

■ If the original scheduling day of the job is a working day in the CONFCAL 
calendar, the Shift value is ignored and the Shift Num value determines when the 
job is scheduled.

■ If the original scheduling day of the job is not a working day in the CONFCAL 
calendar, job scheduling is shifted according to the Shift value and then shifted 
again according to the Shift Num value (if specified) to determine when the job is 
scheduled.

Table 19 Shift Num values

Value Description

Blank Do not reshift job scheduling. Default.

If the original scheduling day is a working day, no shifting occurs. If the original 
scheduling day is not a working day, no shifting, beyond that indicated by the x 
value, occurs.

+nn Shift job scheduling forward to next nth working day.

-nn Shift job scheduling backward to the previous nth working day.

NOTE  
If the result of shifting by the number of days specified in Shift Num is a day which is not 
allowed (meaning, –n was specified for that day in the DAYS parameter of the job processing 
definition), the job is shifted again to the next allowed working day (for a forward shift) or to 
the previous allowed working day (for a backward shift).

NOTE  
If the original scheduling day is not a working day and the x value is blank, the job is not 
scheduled (regardless of whether or not a Shift Num value is specified).
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Execution panel 

The Execution panel of the Job Editing form is used to define parameters that are 
related to the execution of a job and processes that accompany the job’s execution. 

Figure 34 Execution panel parameters

Table 20 Execution panel parameters (Part 1 of 3)

Parameter Description

Prevent-NCT2 Indicates if NOT CATLGD 2 errors should be prevented by 
CONTROL-R (if installed) during started executions of a job, if it is 
not a restart. [MVS only]

Valid values:

■ N – (No) – Do not perform data set cleanup before the original 
job run.

■ Y – (Yes) – Perform data set cleanup before the original job run. 
This value is not valid for started tasks.

■ L – (List) – Do not perform data set cleanup before the original 
job run; but generate the messages that would be required for 
GDG adjustment during restart.

■ F – (Flush) – Halt processing of the job if any data set cleanup 
error is detected (even if MVS would not have stopped 
processing the job).

Confirm If selected, indicates that the job is not run until the administrator 
confirms that it should be submitted. 

Priority CONTROL-M job priority. For more information, see the 
CONTROL-M Job Parameter and Variable Reference Guide. 
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Critical Checking the check box a critical-path job in CONTROL-M. 
Resources for a critical job are reserved exclusively for that job. When 
all necessary resources are available, the job is executed.

Note: this parameter is not relevant for MVS jobs.

Cyclic If selected, indicates that the current job is cyclic.

Note for MVS:
The value specified in this field is combined with the Emergency 
check box, and the Tasktype value specified in the General panel to 
determine the wanted tasktype. For more information, see “General 
panel (MVS)” on page 103.

Emergency  The value specified in this field is combined with the Cyclic check 
box, and the Tasktype value specified in the General panel to 
determine the wanted tasktype. For more information, see “General 
panel (MVS)” on page 103.

Note: This field is relevant only for MVS jobs.

Rerun Indicates that a job is rerun at an interval specified by the Interval 
and Maximum (Max Rerun) parameters.

Interval Amount of time (minutes) to wait between reruns, or between cycles 
of a cyclic job. Default setting is 0. (Text) 

Units Specifies a unit of time for the numerical value 
indicated by the Interval parameter.

Valid values are:

■ Minutes (1-64800)

■ Hours (1-1080)

■ Days (1-45)

From Determines whether the interval until the 
subsequent rerun of the job is calculated from 
the beginning or the end of the current run of 
the job, or (for MVS jobs) from the target time 
(which calculates from when the current run 
was scheduled). 

Valid values are Start and End (and for MVS: 
TRGT). 

Maximum Maximum number od reruns of the job.

Member Name of member to be submitted in the case of a rerun. 

Note: This field is relevant only for MVS jobs.

Max Wait Maximum number of days that the job can wait to be executed after 
its original scheduling date has passed. 

Table 20 Execution panel parameters (Part 2 of 3)

Parameter Description
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Category Name of a CONTROL-D Report Decollating Mission category. If 
specified, the Report Decollating Mission is scheduled whenever the 
job is scheduled under CONTROL-M. 

Time Time limits for job submission. 

Note: The values for both time fields must be specified in hh:mm 
format.

From Earliest submission time. 

Until Latest submission time. 

+ num days Number of days after the original scheduling 
date of the job during which execution of the 
job can begin (From + num days) or end (Until 
+ num days).

Node ID/Group Host name of the Agent platform on which the job is running. 

For application-specific jobs, this parameter must contain the host 
name of the CONTROL-M/Agent that triggers the specified 
application.

Note: Not relevant for MVS jobs.

Multi Agent Specifies that job submission details be broadcast to all Agents within 
a defined Node Group. All available Agents in the Node Group run 
an identical job, and each such job has a unique Order ID.

Note: Not relevant for MVS jobs.

Due Out Time by which the job must finish executing. 

+ num Days Number of days that job execution can be 
extended after the Odat. 
This subparameter is relevant only for jobs 
running in CONTROL-M for z/OS version 
6.2.00 or later. 

Scheduling 
Environment

Indicates the JES2 workload management scheduling environment 
that is to be associated with the job. [MVS only]

System Affinity Indicates the identity of the system in which the job must be initiated 
and executed (in JES2).

Indicates the identity of the processor on which the job must execute 
(in JES3). [MVS only]

Request NJE Node Specifies the node in the JES network on which the job is to execute. 
[MVS only]

Use In-Stream JCL Whether CONTROL-M for z/OS uses a JCL stream to create an 
individual job, overriding the MEMLIB parameter value.
This parameter is relevant only for jobs running in CONTROL-M for 
z/OS version 6.2.00 or later. 

Table 20 Execution panel parameters (Part 3 of 3)

Parameter Description
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Conditions panel

Conditions panel is used to define prerequisite IN and OUT conditions. IN conditions 
are defined in the left side of this panel, and OUT conditions are defined in the right 
side of this panel. 

Figure 35 Conditions panel of the Job Editing form

Each half of the conditions panel consists of a list of already-defined conditions, and a 
text box. The text box is used for editing existing conditions or defining new 
conditions. When you select a condition in the list, its contents are displayed in the 
Text line.

After editing or creating a condition, click the check button  next to the Text box to 
save the changes or to add the condition to the list.

Table 21 describes the buttons that are available for each section of the Conditions 
panel.

NOTE  
Users of CONTROL-M for z/OS version 6.2.01 or higher may have parameters available that 
are not shown in Figure 35. For more information on these parameters, see Table 22 and 
Table 23.

NOTE  
Even after a condition has been added or changed, the change can be undone or redone (if it 
was previously undone) using Ctrl-z and Ctrl-y. For more information, see “Undo and Redo 
in the Job Editing form” on page 100.
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Defining IN conditions

Table 22 describes the parameters used to define IN conditions for a job. 

Table 21 Conditions panel buttons

Button Description

Enter a new condition.

Delete the selected condition.

 and Change the order of the list.

Copy data.

Paste data.

Table 22 IN condition parameters

Parameter Description

Name Name of the prerequisite condition. (Text)

Date 4-character date reference for the condition. Valid values are: 

date A 4-digit date reference in the format mmdd or 
ddmm, depending on the site standard. 

offset + or - followed by a number from 0 through 999, 
indicating the number of days in the future (+), or 
in the past (-), relative to the actual order date.

This value is valid only for jobs running in 
CONTROL-M for z/OS version 6.2.00 or later. 

ODAT Original scheduling date of the job.

PREV Previous scheduling date of the job.

NEXT Next scheduling date of the job.

STAT The condition is not date-dependent.

Note: This value is valid only for 
CONTROL-M/Server version 6.0.01 and above, 
and for CONTROL-M for OS/390 and z/OS.

**** or $$$$ Any scheduling date.

And/Or Logical relationship between multiple conditions. (Option buttons)

Parentheses Box. Used to indicate And/Or relationships.

Note: This parameter is relevant only for MVS jobs.
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Defining OUT conditions

Table 23 describes the parameters used for defining OUT conditions.

Resources panel

The Resources panel is used to define Quantitative and Control resources. 
Quantitative resources are defined in the left side of this panel. Control resources are 
defined in the right side.

Table 23 OUT condition parameters

Parameter Description

Name Name of the prerequisite condition. (Text)

Date 4-character date reference for the condition. Valid values are: 

date A 4-digit date reference in the format mmdd or ddmm, 
depending on the site standard. 

offset + or - followed by a number from 0 through 999, 
indicating the number of days in the future (+), or in 
the past (-), relative to the actual order date.

This value is valid only for jobs running in 
CONTROL-M for z/OS version 6.2.00 or later. 

ODAT Original scheduling date of the job.

PREV Previous scheduling date of the job.

NEXT Next scheduling date of the job.

STAT The condition is not date-dependent.

Note: This value is valid only for 
CONTROL-M/Server version 6.0.01 and above, and 
for CONTROL-M for MVS.

**** or $$$$ Any scheduling date.

+ / - Indicates whether to add (+) or delete (–) the condition. (Option buttons)

NOTE  
Users of CONTROL-M for z/OS version 6.2.00 or higher may have parameters available that 
are not shown in Figure 36. For more information on these parameters, see Table 25 and 
Table 26.
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Figure 36 Resources panel of the Job Editing form

Each half of the resources panel consists of a list of already-defined resources, and a 
text box. The text box is used for editing existing resources or defining new resources. 
When you select a resource in the list, its contents are displayed in the Text line.

After editing or creating a resource, click the check button  next to the Text box to 
save the changes or to add the resource to the list.

Table 24 describes the buttons that are available for each section of the Resources 
panel.

NOTE  
Even after data has been added or changed, the change can be undone or redone (if it was 
previously undone) using Ctrl-z and Ctrl-y. For more information, see “Undo and Redo in the 
Job Editing form” on page 100.

Table 24 Resources panel – function buttons

Button Description

Enter a new resource.

Delete the selected resource.

 and Change the order of the list.

Copy data.

Paste data.
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Defining Control resources for a job

The following fields must be specified for each Control resource:

Table 25 Resources panel – Control resource parameters

Name Name of the resource required by the job. (Text)

Shared/Exclusive Type of control that the job must have over the resource. 
(Option buttons)

On Fail Whether to keep a Control resource tied to a job if the job 
does not end OK.
Valid values are:

■ Release – The resource is not kept tied to the job. Default.

■ Keep – The resource is kept tied to the job until one of the 
following occurs:

— the job ends OK
— the job is deleted

■ the job is forced OK

This parameter is only relevant to users of CONTROL-M for 
z/OS version 6.2.00 or later.
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Defining Quantitative resources for a job

The following fields must be specified for each Quantitative resource:

Table 26 Resources panel – Quantitative resource parameters

Name Name of the resource required by the job.

Quantity Quantity of the resource required by the job.

On Fail Whether to keep the resource tied to a job if the job does not 
end OK. 
Valid values are:

■ Keep – the resource is kept tied to the job until one of the 
following occurs:

— the job ends OK
— the job is deleted
— the job is forced OK

■ Release – the resource is not kept tied to the job. This is 
the default.

This parameter is only relevant to users of CONTROL-M for 
z/OS version 6.2.00 or later.

On OK Whether to keep the resource tied to a job if the job ends OK. 
Valid values are:

■ Release – The resource is not kept, and is returned to the 
total quantity available for other jobs. This is the default.

■ Discard – The resource is not reusable, meaning that the 
quantity of the resource is permanently removed from 
the total quantity available for other jobs.

This parameter is only relevant to users of CONTROL-M for 
z/OS version 6.2.00 or later.
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Set panel

The Set panel is used to specify AutoEdit variables to be resolved in the job’s 
JCL/Script before job submission. 

Figure 37 Set panel of the Job Editing form

AutoEdit variables that have already been defined for the job are displayed in the 
central window of this panel. Below this window, is a pair of text boxes that are used 
for adding new variables, for updating existing variables. To edit a variable 
definition, select it in the list of existing variables, and edit its contents the Text boxes 
below.

After editing or creating a variable, click the check button  next to the Text line to 
save the changes and/or add the variable to the list.

For more information about definition of AutoEdit variables, see Do AutoEdit in the 
CONTROL-M Job Parameter and Variable Reference Guide.

For general information about the AutoEdit facility, see the CONTROL-M Job 
Parameter and Variable Reference Guide.

NOTE  
Application-specific job parameters may not be specified in AutoEdit variables. The names of 
application-specific job parameters are prefixed by two percent signs, the application’s 
abbreviation and a hyphen (%%SAPR3- for SAP, %%OAP- for Oracle, and so on). 
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Table 27 describes the buttons that are available for the Set panel.

NOTE  
Even after data has been added or changed, the change can be undone or redone (if it was 
previously undone) using Ctrl-z and Ctrl-y. For more information, see “Undo and Redo in the 
Job Editing form” on page 100.

Table 27 Set panel – function buttons

Button Description

Enter a new variable.

Delete the selected variable.

 and Change the order of the list.

Copy data.

Paste data.
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Steps panel

The Steps panel indicates conditional post processing actions to be performed, 
depending on the outcome of specified statements.

Figure 38 Steps panel of the Job Editing form

Each item in this panel indicates either an ON statement, or a DO statement. ON 
statements indicate conditions under which specified actions should be performed. 
DO statements indicate actions to be performed when the preceding ON statements 
are satisfied.

The definition line below the list of statements can be toggled between fields for ON 
statements and fields for DO statements.

■ Table 28 describes the buttons that are available for use with Step Codes.
■ Table 29 describes the fields that are used for definition of ON statements.
■ Table 30 describes the fields that are used for definition of DO statements.

After editing or creating an ON statement, click the check button  at the corner of 
the Step Codes section to save the changes and/or add the statements to the list.

NOTE  
The steps panel works differently for MVS jobs. For more information, see “Steps panel 
(MVS)” on page 128.
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ON statement definition line

Figure 39 shows a blank set of ON statement fields. These fields are described briefly 
in Table 29. For more detailed information about these fields, see the CONTROL-M 
Job Parameter and Variable Reference Guide. 

Figure 39 Steps panel – ON statement fields

NOTE  
Even after data has been added or changed, the change can be undone or redone (if it was 
previously undone) using Ctrl-z and Ctrl-y. For more information, see “Undo and Redo in the 
Job Editing form” on page 100.

Table 28 Steps panel buttons

Button Description

Displays the DO statement definition line.

Displays the ON statement definition line.

Delete the selected statement.

 and Change the order of the list.

Copy data.

Paste data.

Table 29 ON statement code criteria

Box Description

Statement Character string that is compared with the job’s log statement records.

Code Character string that is compared with the job’s log error codes.
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DO Statement definition line

The DO statement definition line is displayed by clicking the DO button . Figure 40 
displays a sample DO statement definition line. 

Figure 40 Steps panel – DO statement fields

The fields displayed in this line vary depending on the selected DO action. A brief 
description of each DO action and its fields is supplied in Table 30. For more 
information about these fields, see the CONTROL-M Job Parameter and Variable 
Reference Guide.

After editing or creating a DO statement, click the check button  at the corner of the 
Step Codes section to save the changes and/or add the statements to the list.

Table 30 DO statement parameters  (Part 1 of 3)

Parameter Description

DO OK Sets the job’s completion status to OK regardless of the job’s completion 
status. No subparameters.

DO NOTOK Sets the job’s completion status to NOTOK regardless of the job’s 
completion status. No subparameters.

DO Rerun Causes the job to be rerun according to the parameters specified in the 
Rerun parameter. No subparameters.
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DO Set-Var Assigns a value to an AutoEdit variable. The following subparameter 
fields are displayed for this DO statement:

Name Name of variable to be set to the specified value.

Value Value for the specified variable. This value can be either 
a constant value, or a resolvable AutoEdit Expression. 

This value cannot contain any application-specific job 
parameters. The names of application-specific job 
parameters are prefixed by two percent signs, the 
application’s abbreviation and a hyphen (%%SAPR3- 
for SAP, %%OAP- for Oracle, and so on). 

For more information about AutoEdit Expressions, see 
the CONTROL-M Job Parameter and Variable Reference 
Guide.

Note: This parameter is called DO AutoEdit in CONTROL-M/EM. 

DO Shout Specifies messages to be sent (“shouted”) to various destinations on 
various occasions.

The following subparameter fields are displayed for this DO statement:

Destination Destination to which the message should be sent.

Urgency Priority for the shout message. Select the option button 
the reflects the level of urgency for the specified 
message; Regular, Urgent, or Very Urgent. 

MSG Text of the message to be sent. Use Ctrl+Enter to move 
to a new line.

DO Force-job Forces a job or a complete scheduling table to be ordered under 
CONTROL-M regardless of the scheduling criteria.

The following subparameter fields are displayed for this DO statement:

SCD Table Name of the scheduling table containing the job to be 
forced.

Job Name Name of the job to be forced.

Date Scheduling date of the job to be forced. Valid values: 
ODAT, or a specific 4 or 6 character date reference 
(mmdd, ddmm, yymmdd, or yyddmm format, 
depending on the site standard).

For MVS: Only yymmdd or yyddmm format can be 
used.

Library Name of the library containing the specified scheduling 
table.

Table 30 DO statement parameters  (Part 2 of 3)

Parameter Description
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DO Sysout Specifies how the job’s output should be handled.

The following subparameter fields are displayed for this DO statement:

option Sysout option code (list box). The following options are 
available: 

■ C Change job class.
■ F Copy output.
■ D Delete output.
■ N Move output.
■ R Release for Printer.

PRM Relevant sysout data. The appropriate value depends 
on the option code above. For use with codes F, C or N. 
(Text)

■ For option F, specify the file name.

■ For option C, specify the New class (one character) 
or * to indicate the jobs original MSGCLASS.

■ For option N, specify the new destination (up to 8 
characters).

FROM From class. Limits the sysout handling operation to 
sysouts originating in the specified class.

DO Condition Specifies prerequisite conditions to be added or deleted.

The following subparameter fields are displayed for this DO statement:

Name Name of the prerequisite condition.

Date Date reference for the prerequisite condition.

+ or – These option buttons indicate whether the specified 
condition should be added (+) or deleted (-).

DO Mail Sends a brief message when the specified On condition is fulfilled.

To The e-mail address of the recipient of the DO Mail 
message.

Regular or 
Urgent

Priority for the shout message. Select the option button 
the reflects the level of urgency for the specified 
message; Regular, or Urgent. 

Subject A brief message that can describe the contents of a 
longer message.

CC The e-mail address of an additional recipient of the DO 
Mail message. Optional.

text box The text of the message to be sent.

Table 30 DO statement parameters  (Part 3 of 3)

Parameter Description
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Steps panel (MVS)

The Steps panel indicates conditional post-processing actions to be performed, 
depending on the outcome of specified steps. 

Figure 41 Steps panel of the Job Editing form (MVS)

Two types of information are specified in this panel:

■ Step Range indicates which steps should be monitored for the specified codes.

■ Step Codes indicates what steps codes should be handled and what actions should 
be performed when the specified step completion codes are detected.

Each of these types of information is described in detail in the following pages.

Step range 

Each item in the step range list indicates a range of steps to be checked for specified 
completion codes. Specifying a step range eliminates the need to define separate 
postprocessing actions for each step in the range.

NOTE  
This panel is relevant only for MVS jobs. Post-processing for all other jobs is specified using 
the Steps panel described in “Steps panel” on page 123. 

Users of CONTROL-M for z/OS version 6.2.00 or higher may have parameters available that 
are not shown in Figure 41. For more information on these parameters, see “ON statements” 
on page 130.
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Figure 42 Step range fields

■ Table 31 describes the fields that are used for definition of each step range.

■ Table 32 describes the buttons that are available for use with Step ranges panel.

Click the check button  next to the new or updated step range, to save the changes 
or the new step range to the list.

Table 31 Step range fields

Field Description

Name Logical name for the specified step range. (Text)

From First step in the range. 

This field consists of two text boxes:

■ In the left box, specify the program (PGM) step name. (Text) 

■ In the right box, optionally specify the procedure (PROC) step name. 
(Text) 

To Last step in the range.

This field consists of two text boxes:

■ In the left box, specify the program (PGM) step name. (Text)

■ In the right box, optionally specify the procedure (PROC) step name. 
(Text)

Table 32 Step range buttons 

Button Description

Enter a new step.

Delete the selected step. 

 and Change the order of the list.

Copy data.

Paste data.

NOTE  
Even after data has been added or changed, the change can be undone or redone (if it was 
previously undone) using Ctrl-z and Ctrl-y. For more information, see “Undo and Redo in the 
Job Editing form” on page 100.
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Step Codes

Each item in the step codes list indicates either an ON statement, or a DO statement. 
ON statements indicate conditions under which specified actions should be 
performed. DO statements indicate actions to be performed when the preceding ON 
statements are satisfied. 

The definition line below the list of statements can be toggled between fields for ON 
statements and fields for DO statements.

■ Table 33 describes the buttons that are available for use with Step Codes.
■ Table 34 describes the fields that are used for definition of ON statements.
■ Table 36 describes the fields that are used for definition of DO statements.

After editing or creating an ON or DO Action statement, click the check button  at 
the corner of the Step Codes section to save the changes and/or add the statements to 
the list.

ON statements

In defining ON statements for jobs for CONTROL-M for z/OS version 6.2.00 or later, 
there are two options:

■ On Stmt
■ On Sysout

Users of CONTROL-M for OS/390 and z/OS versions earlier than version 6.2.00 have 
only the On Statement (“On Stmt”) option.

NOTE  
Even after data has been added or changed, the change can be undone or redone (if it was 
previously undone) using Ctrl-z and Ctrl-y. For more information, see “Undo and Redo in the 
Job Editing form” on page 100.

Table 33 Step Codes buttons 

Button Description

Displays the DO statement definition line.

Displays the ON statement definition line.

Delete the selected change.

 and Change the order of the list.

Copy data.

Paste data.
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On Stmt statement definition

Figure 43 shows a blank set of the fields that are displayed when the On Stmt button 
is selected. These fields are described briefly in Table 34. For more detailed 
information about these fields, see the CONTROL-M Job Parameter and Variable 
Reference Guide. 

Figure 43 On Stmt fields

On Sysout statement definition

Figure 44 shows a blank set of the fields that are displayed when the On Sysout 
button is selected. These fields are described briefly in Table 35. For more detailed 
information about these fields, see the CONTROL-M Job Parameter and Variable 
Reference Guide.

Figure 44 On Sysout statement (CONTROL-M for z/OS version 6.2.00 and later)

Table 34 On Stmt fields

Field Description

PGMST Name of the program step to be checked for the specified code criteria.

PROCST Name of the procedure step, in which the program step is found.

Codes Codes for the indicated step which satisfy the criteria. Type in each code 
separately, and press Enter after each code.

And/Or/<blank> Buttons that set the logical relationship between multiple On statements. 
If only one On statement is specified, <blank> should be clicked.
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DO statements

The DO statement definition line is displayed by clicking the DO button . Figure 45 
displays a sample Do Statement definition line. 

The fields displayed in this line vary depending on the selected DO action. A brief 
description of each DO action and its fields is supplied in Table 36. For more 
information about these fields, see the CONTROL-M Job Parameter and Variable 
Reference Guide.

After editing or creating a DO statement, click the check button  at the corner of the 
Step Codes section to save the changes and/or add the statements to the list.

Figure 45 DO statement definition line

Table 35 On Sysout parameters

Parameter Description

Sysout Pattern A string of up to 40 characters.

From Column A number from 001 through 132, indicating the column at which the 
search should start.
If this field is blank, the value 001 is assumed.
The value in this field must be lower than that in the To Column field. 

To Column A number from 001 through 132, indicating the column at which the 
search should end.
If this field is blank, the value 132 is assumed.
The value in this field must be higher than that in the From Column field. 

And/Or Option buttons that set the logical relationship between multiple On 
statements.

Table 36 DO statement parameters

Parameter Description

DO OK Sets the job’s completion status to OK regardless of the job’s completion 
status. No subparameters.

DO NOTOK Sets the job’s completion status to NOTOK regardless of the job’s 
completion status. No subparameters.

DO Rerun Causes the job to be rerun according to the parameters specified in the 
Rerun parameter. No subparameters.

DO Stop Cyclic Prevents subsequent iterations of the current cyclic job. No 
subparameters.
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DO Set-Var Assigns a value to an AutoEdit variable. The following subparameter 
fields are displayed for this DO statement:

Name Name of variable to be set to the specified value.

Value Value for the specified variable. This value can be either 
a constant value, or a resolvable AutoEdit Expression.

This value cannot contain application-specific job 
parameters. The names of application-specific job 
parameters are prefixed by two percent signs, the 
application’s abbreviation and a hyphen (%%SAPR3- 
for SAP, %%OAP- for Oracle, and so on). 

For more information about AutoEdit Expressions, see 
the CONTROL-M Job Parameter and Variable Reference 
Guide.

Note: This parameter is called DO AutoEdit in CONTROL-M/EM.

DO Shout Specifies messages to be sent (“shouted”) to various destinations on 
various occasions.

The following subparameter fields are displayed for this DO statement:

Destination Destination to which the message should be sent.

Urgency Priority for the shout message. Select the option button 
the reflects the level of urgency for the specified 
message; Regular, Urgent, or Very Urgent. 

MSG Text of the message to be sent.

DO Force-job Forces a job or a complete scheduling table to be ordered under 
CONTROL-M regardless of the scheduling criteria.

The following subparameter fields are displayed for this DO statement:

SCD Table Name of the scheduling table containing the job to be 
forced.

Job Name Name of the job to be forced.

Date Scheduling date of the job to be forced. Valid values: 
ODAT, or a specific 4 or 6 character date reference 
(mmdd, ddmm, yymmdd, or yyddmm format, 
depending on the site standard).

For MVS: Only yymmdd or yyddmm format can be 
used.

Library Name of the library containing the specified scheduling 
table.

Table 36 DO statement parameters

Parameter Description
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DO Sysout Specifies how the job’s log should be handled.

The following subparameter fields are displayed for this DO statement:

option Sysout option code (list box). The following options are 
available: 

C Change job class.

F Copy output.

D Delete output.

N Move output.

R Release for Printer.

PRM Relevant sysout data. The appropriate value depends 
on the option code above. For use with codes F, C or N. 
(Text)

■ For option F, specify the file name.

■ For option C, specify the New class (one character) 
or * to indicate the jobs original MSGCLASS.

■ For option N, specify the new destination (up to 8 
characters).

FROM From class. Limits the sysout handling operation to 
sysouts originating in the specified class.

DO CTBRule Invokes a CONTROL-M/Analyzer rule to be executed at the processing of 
a specific program step. Available only if CONTROL-M/Analyzer is 
installed. 

The following subparameter fields are displayed for this DO statement:

Name Name of the CONTROL-M/Analyzer rule.

Arg Arguments to be passed to the rule. Multiple arguments 
must be separated by commas.

Table 36 DO statement parameters

Parameter Description
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PostProc panel

The PostProc panel is used to specify actions to be performed upon job completion.

Do IFRerun Indicates restart steps for the job if it is rerun. Valid only if 
CONTROL-M/Restart is installed.

The following subparameter fields are displayed for this DO statement:

From Step from which to begin the job restart. The following 
values can be specified for this subparameter:

■ pgmstep — Program step. 

■ procstep — Called procedure in which the program 
step is found.

To Step at which to end the job restart. The following 
values can be specified for this subparameter:

■ pgmstep — Program step.

■ procstep — Called procedure in which the program 
step is found.

Confirm If selected, indicates that manual confirmation is 
required before the job is submitted for restart.

DO Condition Specifies prerequisite conditions to be added or deleted.

The following subparameter fields are displayed for this DO statement: 

Name Name of the prerequisite condition.

Date Date reference for the prerequisite condition. Valid 
values: A specific date (in mmdd or ddmm format), or 
one of the following 4-character literals: ODAT, PREV, 
NEXT, STAT, or $$$$. Note that $$$$ is only valid 
when deleting a condition.

+ or – These option buttons indicate whether the specified 
condition should be added (+) or deleted (-).

Table 36 DO statement parameters

Parameter Description
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Figure 46 Job Editing form – PostProc panel

This panel is used for specifying the following types of information:

■ Shout information. Describes messages that should be sent to specified 
destinations depending on how the job ended.

■ Sysout handling. Describes how the output of the job should be handled.

Each of these sections is described in detail on the following pages.

Shout

This section of the PostProc panel describes messages to be sent (shouted) to various 
destinations. This section includes a list of previously defined Shout statements for 
the job. Below this list is a series of fields for specifying additional Shout statements. 

■ Table 37 describes the buttons that are available for use with Shout statements.
■ Table 38 describes the fields that are used for definition of Shout statements.

After editing or creating a Shout message, click the check button   to save the 
changes and/or add the message to the list.

NOTE  
Even after Shout data has been added or changed, the change can be undone or redone (if it 
was previously undone) using Ctrl-z and Ctrl-y. For more information, see “Undo and Redo 
in the Job Editing form” on page 100.
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Table 37 Shout statement buttons 

Button Description

Enter a new message.

Delete the selected message.

 and Change the order of the list.

Copy data.

Paste data.

Table 38 Shout statement parameters  (Part 1 of 2)

Parameter Description

When Indicates the conditions under which the messages should be issued. 
Valid values for these fields are:

OK Job ended OK.

NOTOK Job ended NOTOK.

RERUN Job requires rerun.

Late Sub Job not submitted by the specified time.

The time must be specified in HHMM format, where 
HH is 00-23 and MM is 00-59.

The message is sent only if the job actually cannot be 
submitted. That is, a required runtime criterion (such as 
an in condition or quantitative resource) has not been 
met.

Note: If a job is ordered after the specified time but 
starts running immediately because it meets all runtime 
criteria, the LATESUB parameter does not apply.

Late Time Job not finished running by the specified time.

The time must be specified in HHMM format, where 
HH is 00-23 and MM is 00-59.
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EXECTIME The message is sent if the elapsed runtime of the job is 
outside a specified limit. The limit, which is set in the 
Parm field of the Job Editing Form PostProc panel, can 
be expressed as a runtime limit, or as a deviation from 
the average runtime of the job. Valid formats for the 
limit are:

+n% – The message is sent if the elapsed runtime of the 
job exceeds its average execution time by at least n%. n 
is a number from 1 through 900.

–n% – The message is sent if the elapsed runtime of the 
job is at least n% less than its average execution time. n 
is a number from 1 through 99.

>n – The message is sent if the elapsed runtime of the 
job is greater than n minutes. n is a number from 
0 through 999.

<n – The message is sent if the elapsed runtime of the 
job is less than n minutes. n is a number from 1 through 
999.

+n – The message is sent if the elapsed runtime of the 
job exceeds its average execution time by at least n 
minutes. n is a number from 1 through 999.

-n – The message is sent if the elapsed runtime of the job 
is at least n minutes less than its average execution time. 
n is a number from 1 through 999.

To Destination to which the message should be sent.

Very Urgent
Urgent
Regular

These option buttons indicate the urgency level of the shout. 

message area This text box to the right of the other fields is used to specify the contents 
of the message. Use Ctrl+Enter to move to a new line.

Table 38 Shout statement parameters  (Part 2 of 2)

Parameter Description
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Sysout handling

This section of the PostProc panel specifies handling for the sysout when the job ends 
OK. describes the fields that are used to specify sysout handling. 

Table 39 Sysout handling parameters

Field Description

Sysout Handling 
Option

Sysout option code. This is specified in the list box directly below the 
title Sysout Handling.

Note: This field is described as parameter Option in the CONTROL-M 
Job Parameter and Variable Reference Guide.

Available options are:

None The output of the job is placed in a default location 
(specified using a CONTROL-M system parameter) 
until deleted by the next run of the New Day 
procedure.

C Change job class. (for MVS jobs only)

The New Class Name text box is displayed for the 
new class designation.

Copy 
(in MVS: F)

Copy output.

The File Name text box is displayed for the location to 
which the log file should be copied.

Delete 
(in MVS: D)

Delete output.

Move 
(in MVS: N)

Move output.

The New Destination text box is displayed for the 
location to which the log file should be moved.

Release 
(in MVS: R)

Release output to Printer.

From Class Limits the sysout handling operation to sysouts originating in the 
specified class.

AutoArchive For MVS jobs only: When selected, this option indicates that the sysout 
of the job should be archived.

SYS DB When selected, indicates that the SYSDATA of the job should be 
archived to a common data set.

Max Days ... Maximum number of days to retain archived SYSDATA. Must be a 
two-digit number in the range 00 – 99.

Max Run ... Maximum number of runs for which archived SYSDATA should be 
retained. Must be a three-digit number in the range 000 – 999.
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Tags Selection panel
The Tags Selection panel indicates which Schedule tags in a group scheduling table 
should be used by the current job. This panel is not relevant for jobs that are not in a 
group scheduling table. 

Figure 47 Tags Selection panel of the Job Editing form

The Tag Selection panel includes two lists:

■ The Group Tag list (on the left) is a list of Schedule tags that are in the group 
scheduling table definition and not used by the job processing definition. 

■ The Job Tag list (on the right) is a list of Schedule tags that are used by the job 
processing definition. 

To add a tag to the job definition:

1. Either click a tag in the Group Tag list, or enter its name in the text box.

2. Click the right-facing arrow. The tag is removed from the list of Group Tags, and 
added to the list of Job Tags. 

NOTE  
The name of the current group scheduling table is displayed in the upper-righthand corner of 
the Tag Selection panel.
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To remove a tag from the job definition:

1. Click on the tag in the Job Tag list. 

2. Click the left-facing arrow. The tag is removed from the list of Job Tags and added 
to the list of Group Tags.

You can use an asterisk “*” as a wildcard in the tag name, either on its own or as a 
suffix. For example, if you type A*, all the tags in the Group Tag list that begin with 
an A are selected. If you type * or ALL, all tags in the Group Tag list are selected. 

Exiting the Job Editing form
The method for exiting the Job Editing form depends on how the form was originally 
opened.

If the Job Editing form was opened in Flow Diagram view, in List view, from the New 
Job button, or from the Job New menu option, the Job Editing form appeared as a 
dialog box. This dialog box may need to be closed before you perform certain 
processes.

■ Click Save to Draft (or Save to Database if working in online load mode) to apply the 
changes you have made in the Job Editing form.

■ Click Cancel, to cancel the changes you have made in the Job Editing form.

If the Job Editing form was opened in List/Job Editing View by selecting the job from 
the tree in the left pane, the Job Editing form appeared in the right pane. Additional 
processing can be performed in the draft when using this format.

■ Click Save to Draft (or Save to Database if working in online load mode) to apply the 
changes you have made in the Job Editing form.

■ Click Cancel, to cancel the changes you have made in the Job Editing form.
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Running CONTROL-M/Server utilities as 
scheduled jobs

CONTROL-M/Server utilities can be invoked using the Command parameter of any 
job definition where Command has be specified for the Task Type parameter.

A special draft of predefined jobs is supplied with CONTROL-M/EM with sample 
job definitions for certain CONTROL-M/Server utilities (Table 40). 

To use a predefined utility job

1 In CONTROL-M/Desktop, click  to open the draft browse window.

2 Navigate to <INSTALLATION_DIR>\ControlM-EM\CTMDsktp and 
double-click the Control-M Server Utilities.DRF file. the jobs in the draft are 
displayed in the flow diagram.

3 Double-click on the job that you want to schedule. The Job Editing form is 
displayed.

4 On the General panel of the Job Editing form, specify values for the following 
parameters:

■ Author (if enabled)
■ CONTROL-M
■ Node ID/Group
■ Owner

5 Update the command line with the values you specified in step 4 (for ctmcreate 
and ctmdefine only).

6 Optional. Modify the command line to change the utility’s behavior.

7 Optional. Modify any other job parameters.

8 Click Save to Draft or Save to Database.

9 If working in local load mode, write the job to the CONTROL-M/EM database.
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For more information about CONTROL-M/Server utilities, see the Utilities chapter of 
the CONTROL-M/Server for Unix Administrator Guide.

Table 40 CONTROL-M/Server utility jobs

Job name Utility

ctmcontb Performs operations on the Prerequisite Conditions table.

ctmcreate Creates a job in the Active Jobs file.

ctmdefine Defines a job in the CONTROL-M/Server database.

ctmkilljob Terminates a CONTROL-M job and its associated processes.

ctmloadset Updates a resource in the Quantitative Resources table with 
regard to usage on an Agent platform.

ctmorder Orders one or more jobs from a scheduling table contained in the 
CONTROL-M/Server database.

ctmudly Orders jobs for a specific User Daily name.

ctmvar_set Sets a variable. Manipulates Global AutoEdit variables for data 
centers, group scheduling tables, or jobs in group scheduling 
tables.

ctmvar_delete Deletes a variable specification. 

ecactltb Lists the status of each resource in the Control Resources table.

ecaqrtab Performs operations on the Quantitative Resources table.

ecaqrtab_add Adds a resource

ecaqrtab_list Deletes a resource.
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C h a p t e r 4
4  Creating and updating multiple jobs

You can define or modify many job processing definitions simultaneously by 
modifying job skeletons (templates) and applying the new or modified skeletons to 
the relevant jobs. The following topics are discussed in this chapter:

■ Mass Creation of job processing definitions

■ Skeletons. These are templates containing default values used to define multiple 
jobs with identical characteristics.

■ Mass Updating jobs based on a Skeleton.

These features eliminate the need to create and modify each job processing definition 
individually. Instead, many job processing definitions can be defined or modified 
simultaneously.

NOTE  
The Mass Creation and Mass Update operations when working in online load mode. For more 
information, see “A comparison of online and local load modes” on page 21.
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Mass creation of job processing definitions
Mass creation is the process of defining multiple job processing definitions using a 
common job skeleton (template). The job skeleton is created with parameters that 
should appear in all jobs to be created. After the jobs are created, they can be 
modified individually using the Job Editing form (described in Chapter 3 of this 
guide).

To create multiple jobs with similar parameters:

1 Select the Tools => Mass Create option from the menu bar. 

--or-

Click the Mass Job Creation button  on the toolbar.

The Mass Create Form dialog box is displayed.

 

2 Specify the number of jobs to create and the name of the Skeleton that contains the 
parameters to be defined for all the new job processing definitions. (Table 41 
contains descriptions of all fields in this dialog box.)

NOTE  
When working in online mode, this feature is not available.

NOTE  
Normally individual job processing definitions are created using the Edit => Job => New Job 
option, or by clicking the New Job button  on the toolbar.
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3 Click OK to create the requested number of jobs using the specified Skeleton.

Helpful hints

The Mass Create facility enables you to modify a job skeleton at various stages so that 
fewer changes are required later. 

Example: Create multiple jobs for various applications

Create 40 job processing definitions for several different applications or groups which 
all include a certain set of parameters and values.

The recommended method for creating these jobs using one skeleton is as follows:

1 Specify the wanted Skeleton name in the Mass Create Form dialog box.

2 Specify the parameters and values in the Skeleton Editor work area.

3 Specify the first Application name and Group name (e.g., App1, and Group1).

4 Click OK to save the changes.

5 Specify the number of jobs wanted for the first group (e.g., 10).

6 Click OK to create the jobs.

7 Repeat Steps 3 through 6 for each application or group.

Table 41 Fields of the Mass Create Form dialog box

Field Description

Number of 
jobs to create

Number of jobs to create using the specified skeleton. Default: 10.

Skeleton Skeleton to be applied to the new jobs. To select a different Skeleton, click on 
the arrow in the Skeleton field and select the Skeleton from the list.

Skeletons can be modified or created using the Skeleton Editor form. This 
form is displayed by clicking the Edit Skeletons button (described below). 
For more information, see “Job skeletons” on page 148.

Edit Skeletons Opens a skeleton editor for the specified skeleton. For more information, see 
“Job skeletons” on page 148.
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Job skeletons
Job skeletons are templates that are used for the creation of multiple job processing 
definitions. Each job skeleton contains a set of parameters and values. When a job 
skeleton is used to create new jobs, the new jobs automatically include the parameters 
and values that are specified in the skeleton. By modifying a skeleton and reapplying 
it to related jobs, the jobs can also be modified simultaneously. 

All job skeletons are created and modified using the Skeleton Editor form. 

To open the Skeleton Editor form click the Edit Skeletons button in the Mass Create 
Form dialog box. The Skeleton Editor form can also be opened by selecting the Job 
Skeleton option on the menu bar or by clicking the Edit Skeleton  button on the 
toolbar.

Figure 48 Skeleton Editor window

Skeleton Editor form controls are described in Table 42.

Table 42 Skeleton Editor form controls

Element Description

Skeleton Name Name of the Skeleton to be used. Select a name from the list or type 
in a new name. The Skeleton name is case sensitive.

CONTROL-M Type of CONTROL-M platform that processes the job processing 
definitions produced by this Skeleton. Select a value from the list 
box. The selected value determines which Job Editing form is 
displayed based on CONTROL-M platform type.
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The work area of the Skeleton Editor form contains a table for specifying job 
processing definition fields and their values (described below).

To create a new skeleton

1 Click New.

2 Specify a name for the new Skeleton and click OK. An empty Skeleton Editor form 
is displayed.

3 Specify the wanted Skeleton fields and values in the work area. See “Specifying 
and modifying skeleton fields” on page 153 for details about this part of the 
Skeleton Editor.

4 Click OK to save the Skeleton and to close the Skeleton Editor form.

To create a new skeleton based on the values of an existing skeleton 

1 Select the existing Skeleton in the Skeleton name list box on the 
CONTROL-M/Desktop tool bar.

2 Click Copy.

Application Expands the Skeleton Editor window to include fields for defining 
skeletons for specific applications (such as SAP or Oracle 
Applications).

Type of application for jobs created using this skeleton. The General 
Panel in the Job Editing Form is modified to display the parameters 
for the specific application.

The valid applications types are:

■ Oracle - Creates a skeleton for Oracle Applications jobs. 

■ SAP - Creates a skeleton for SAP jobs.

■ Windows 2000 - Creates skeletons for jobs running on Microsoft 
Windows 2000.

The expanded Skeleton Editor window is displayed in Figure 49.

Condition Format Format for In Conditions and Out Conditions that are automatically 
created by job dependencies defined in the Flow Diagram view. For 
more information, see “Condition Format” on page 155.

Table 42 Skeleton Editor form controls

Element Description
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3 Specify a name for the new Skeleton and click OK. The new Skeleton is displayed 
with the same fields and values as the Skeleton from which it was copied.

4 Make the necessary changes in the Skeleton Editor work area. See “Specifying and 
modifying skeleton fields” on page 153 for details about this part of the Skeleton 
Editor.

5 Click OK to save the new skeleton and to close the Skeleton Editor form.

To modify a skeleton 

1 Select a Skeleton in the Mass Create Form dialog box.

2 Click the Edit Skeletons button. The Skeleton Editor form is displayed.

3 Make the necessary changes in the Skeleton Editor work area. See “Specifying and 
modifying skeleton fields” on page 153 for details about this part of the Skeleton 
Editor.

4 Click OK to save the changes and to close the Skeleton Editor.

To delete a skeleton 

1 Select the Skeleton in the Skeleton name list box at the top of the Skeleton Editor 
form.

2 Click the Remove button.

To add a row to the Skeleton window

Place the cursor in the last cell of the table and press <Tab>.

To delete a row From the Skeleton window

Place the cursor in any row of the table and press <Delete>.

To clear all fields in the currently displayed skeleton

Click the Clear button. 

Defining skeletons for jobs running on specific applications

When Application is clicked, the Skeleton Editor window expands to display 
additional controls. These controls are used to define skeletons for jobs that are run 
on specific external applications, such as SAP or Oracle Applications.
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These additional controls specify parameters that determine which application 
parameters are included in the skeleton. Whereas regular CONTROL-M/EM job 
parameters are always included in the skeleton (even when you do not specify a 
value for them), the application (such as SAP) parameters that are included in the 
skeleton are fluid. 

Which parameters are displayed is dependent on which form (specified with the 
Form Name parameter) is chosen. Which form can be selected is dependent on the 
values specified for the Application Type, Application Version, and Control 
Module Version parameters. These parameters are described in the CONTROL-M Job 
Parameter and Variable Reference Guide.

Figure 49 Expanded Skeleton Editor window

NOTE  
Do not specify values for the parameters discussed in this section if you do not have one of the 
supported applications (such as SAP) installed in your system, together with the appropriate 
Control Module for CONTROL-M.
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Table 43 Application support fields in the skeleton editor

Field Description

Application Node 
Group

Logical name of the node group that processes the job. Selecting the 
Application Node Group determines the values for the Application 
Type, Application Version, and Control Module Version parameters.

Click Load to import one of the available Application Groups from 
your CONTROL-M installation.

Application Type Indicates the type of external application (for example, SAP or Oracle 
Applications) on which the external application job runs. Determined 
automatically by the Application Group that is loaded and displayed as 
Read Only.

Application 
Version

Indicates the version of the external application (for example, SAP or 
Oracle Applications) on which the external application job runs. 
Determined automatically by the Application Group that is loaded and 
displayed as Read Only.

CM Version Indicates the version of external application (for example, SAP or 
Oracle Applications) Control Module (CM) that is installed in the 
CONTROL-M installation.

A Control Module is a BMC Software product that enables your 
application to interoperate with your CONTROL-M installation. 
Determined automatically by the Application Group that is loaded and 
displayed as Read Only.

Form Name Specifies a predefined set of external application parameters that are 
displayed in the External Application panel of the CONTROL-M/EM 
Job Editing form. The forms that are available for selection is dependent 
on the values specified for Application Type, Application Version, 
and Control Module Version.

Note: You must load any available forms onto your local computer 
using View => Import Forms. Forms must be loaded onto your 
computer to be available.
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Specifying and modifying skeleton fields

The work area of the Skeleton Editor dialog box contains a table of parameters and 
values to be applied to related job processing definitions.

To modify parameters in the Skeleton Editor work area:

1 Click the Field column in the line to be edited. A list box is displayed containing 
valid field (parameter) names. 

2 Select the wanted field. The field name appears on the line.

3 Specify the value for the field in the Value column by either typing the value or 
selecting the value from a predefined list box.

Special functions can also be specified in the Value field. See Table 44 on page 155 
for a description of these functions.

4 Select the type of CONTROL-M platform on which the job processing definitions 
using this Skeleton are processed.

5 Specify a format (Condition Format) for In Conditions and Out Conditions to be 
automatically created when job dependencies are created by clicking and dragging 
from one job node to another in the Flowdiagram view.

6 Select and edit another Skeleton, if necessary. 

NOTE  
Most fields can be specified only once in each job processing definition. If a field of this type 
has already been specified for the current skeleton, it no longer appears in the list box. In 
Conditions and Out Conditions can be specified multiple times and are therefore always 
available from the field list box. 

NOTE  
Valid values for the job processing parameters displayed in the Skeleton Editor are described 
in the CONTROL-M Job Parameter and Variable Reference Guide.
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7 Click OK to save all the changes and close the Skeleton Editor form.

To move fields in the Skeleton Editor work area:

1 Place the cursor on the number (left column) of the line to be moved. An arrow is 
displayed. 

2 Drag the selection to the wanted location.

To remove lines from the Skeleton Editor work area:

1 Place the cursor on the number (left column) of the line to be deleted. An arrow is 
displayed. 

2 Click the number for the line. The line is highlighted.

3 Press the <Delete> key.

To delete multiple lines from the Skeleton Editor work area:

1 Click the number of the first line to be deleted, and drag the cursor to highlight all 
lines to be deleted.

2 Press the <Delete> key.

NOTE  
Changes made to skeletons in the Skeleton Editor can be saved either by clicking the Apply 
button or the OK button. You can make changes to one skeleton and then make changes to a 
second skeleton without saving changes to the first skeleton. Pressing Apply or OK saves all 
changes. Clicking Cancel cancels all changes. Conversely, it is possible to make changes to one 
skeleton and click Apply to save them. Further changes to the same skeleton or a different one 
can then be cancelled or saved without cancelling the changes made prior to Apply being 
clicked. 
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In conditions and Out conditions

Two types of information can be specified about prerequisite conditions in a job 
skeleton. 

■ Format for the conditions automatically defined when dependencies are created in 
the Flow Diagram view (by clicking on one job and dragging the cursor to the 
dependant job).

■ Actual In conditions and Out conditions defined in the job skeleton that should be 
part of each job processing definition that is created using the skeleton.

Each of these types of condition information is described in the following pages.

Condition Format 

In the Flow Diagram view of CONTROL-M/Desktop, you can create dependencies 
between jobs by clicking on a job node and dragging the mouse cursor to a dependant 
job. When you do this, an Out condition is automatically defined in the job processing 
definition of the first job, and a corresponding In condition is added to the job 
processing definition of the second job. The Condition Format field in the Skeleton 
Editor dialog box indicates the format these automatically defined conditions.

Table 44 Valid functions for values in the skeleton editor 

Function Description

{fieldname} Name of a field in the job processing definition. Use the name of the field exactly 
as it appears in the from the list box of the Field column.

{Counter} Incremental number to be inserted in the value (e.g., This job is Job #  {Counter}).

{+ | -{numerical field| function},quantity to add or subtract}

Indicates an amount to be incremented or decremented from a number in the 
condition name format. This function can be used to reference a previous or 
subsequent job (e.g., Job#{-{Counter},1}-ENDED).

{Substr position.length,{fieldname | function}}

Substring from a specified field or function.

position Offset of the substring within the field/function 
(zero-based)

length Number of characters

fieldname Name of the field

function Name of the function

For example, To indicate the first two characters of MemName, specify: 
{Substr 1.2,{MemName}}.
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The value for the Condition Format can be either chosen from the list box containing 
predefined format, or you can specify your own format using the special functions 
described in Table 45.The default condition format is: 
{MemName}-TO-{ToJob{MemName}}.

NOTE  
The format specified for these conditions has no effect on other In conditions and Out 
conditions specified in either the job skeleton or in specific job processing definitions.

Table 45 Valid functions for the Condition Format field 

Function Description

{from fieldname} Name of a field in the first job (meaning, the job to which we are adding an Out 
condition).. Use the name of the field exactly as it appears in the list box of the 
Field column.

{Counter} Incremental number to be inserted in the value (e.g., Job#{Counter}-ENDED). This 
value is incremented for each successive dependent job in line of dependent jobs. 
The first job from which others are dependent is number one. The second job is 
number 2, and so on.

{+ | -{numerical field| function},quantity to add or subtract} 

Indicates an amount to be incremented or decremented from a number in the 
condition name format. This function can be used to reference a previous or 
subsequent job (e.g., Job#{-{Counter},1}-ENDED). This value assumes that the first 
in a line of independent jobs was job number 1.

{Substr position.length,{from fieldname | function}} 

Substring from a specified field or function. 

position Offset of the substring within the field/function 
(zero-based)

length Number of characters

fieldname Name of the field

function Name of the function

For example, To indicate the first two characters of MemName, specify: 
{Substr 1.2,{MemName}}.

{ToJob[to fieldname]}

Name of a field in the dependent job (i.e., job to which we are adding an In 
condition). For example, to indicate the MemName of the from and to jobs, use 
{MemName}-{ToJob[MemName]}.
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Specifying In conditions and Out conditions in a skeleton

In conditions and Out conditions specified in a job skeleton are added to each job 
processing definition created using that skeleton. Each In condition or Out condition 
contains multiple fields. Therefore, addition, modification and deletion of these 
conditions differs from the methods used for specifying values for other job 
processing definition fields.

To add an In condition or Out condition to a job skeleton:

1 Place the cursor in the Field column of the Skeleton Editor work area and select In 
Conditions or Out Conditions from the list box. A pair of braces {} is displayed in 
the value column.

2 Click the ellipsis button  in the value column. The following dialog box is 
displayed.
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3 Enter the name of the In condition or Out condition in the Name field. Values for 
Date and And/Or can be selected from lists or they can be entered manually.

The Parentheses field is used to group conditions for implementation of And/Or 
logic with groups of conditions. For more information about And/Or logic and 
prerequisite conditions see the CONTROL-M Job Parameter and Variable Reference 
Guide.

4 Click OK when finished.

Multiple In conditions and Out conditions can be defined in a job skeleton.

Updating multiple jobs and group scheduling 
tables

The CONTROL-M/Desktop Mass Update facility updates fields and values in 
multiple job processing and group scheduling table definitions. This facility can be 
applied to all job and group scheduling table definitions in the draft or in the current 
collection. By first defining a collection, mass updates can be performed only on the 
definitions in the collection. 

NOTE  
A draft is comprised of all jobs and group scheduling tables currently in 
CONTROL-M/Desktop, whether they are displayed or not. If you apply a filter to display 
only selected jobs from the draft, these displayed jobs comprise the current collection. 
Collections of jobs are for viewing purposes only and cannot be saved.

NOTE  
When working in online mode, this feature is not available.
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To perform mass update of job processing definitions:

1 Select the Tools => Mass Update.

-or-

Click the Mass Update button  on the tool bar. The Mass Update window is 
displayed.

Table 46 describes the fields in the Mass Update window.

2 Fill in the table in the work area of the Mass Update window. Each line in the table 
can specify criteria that determine which job processing definitions are updated, or 
to specify a field to be added or updated.

3 Click the Draft option button to apply the changes to all jobs and group scheduling 
tables in the draft, or the Collection option button to apply the changes only to jobs 
in the current collection.

4 Click Apply to perform the update.

-or-

Click Close to close the Mass Update window without performing the requested 
function.
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Table 46 Fields of the Mass Update window

Field Description

Field Field in the job or group scheduling table definition to be searched. Click the arrow to display a list of 
possible fields.

From Search value for the field. Each From field consists of an operator specification and a value 
specification.

Operator Operator to apply to the specified value. Click the arrow to display a list of valid 
operators (described below).

= The value in the specified field must equal the value specification in the 
table.

Like Values in the table can contain an * (asterisk). The asterisk matches single 
character or multiple characters which occupy the same character 
position in the value specification in the table.

> The value in the specified field must be greater than the value 
specification in the table.

< The value in the specified field must be less than the value specification 
in the table.

!= The value in the specified field must not equal the value specification in 
the table.

In The value in the specified field must match at least one of the value 
specifications in the table. Use commas to separate the values.

Not In The value in the specified field must not match any value specifications 
in the table. Use commas to separate the values.

Value Values for which to search in the job or group scheduling table parameter.

To Instructions for handling jobs that meet the criteria specified in the From field.

Each To field consists of a function specification and a value specification.

Function The function that should be performed on the jobs that meet the criteria specified in the 
From field.

Find The From criteria are used to select jobs to be modified according to other 
lines in the Mass Update Form.

Note: The value specification of the To field is unavailable when the Find 
function is selected.

Update The From criteria are used to update jobs to the value specification of the 
To field.

Value The new value to replace the existing value in the field. Type in a value, or select the 
new value from a predefined list box. 

Null values may also be specified by leaving the field empty.

Note: This field is unavailable when the Find function of the To field is selected.

Special functions can be used to specify complex values to replace existing information. 
These functions are described in Table 47 on page 161.
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Mass updating of In conditions and Out conditions

Each In condition or Out condition contains multiple fields. Therefore, addition, 
modification and deletion of these conditions in the Mass Update Form dialog box 
differs from the methods used for specifying values for other job processing 
definition fields. 

Using the Mass Update facility, you can:

■ Search for job processing definitions with various types of In conditions or Out 
conditions.

■ Update, add or remove any of the fields in each In condition.

■ Add new conditions to all job processing definitions that were selected according 
to the find criteria in the Mass Update Form.

Table 47 Valid functions for To values 

Function Description

{fieldname} Name of a field in the job or group scheduling table definition. Use the field name 
exactly as it appears in the list box of the Field column (e.g., The MemName of this 
job is {MemName}).

{Counter} Incremental number to be inserted in the value 
(for example, This job is Job #  {Counter}).

{+ | -{numerical field| function},quantity to add or subtract} 

Indicates an amount to be incremented or decremented from a number in the 
condition name format. This function can be used to reference a previous or 
subsequent job (for example, Job#{-{Counter},1}-ENDED).

{Substr position.length,{from fieldname | function}} 

Substring from a specified field or function. 

position Offset of the substring within the field/function 
(zero-based)

length Number of characters

fieldname Name of the field

function Name of the function

For example, To indicate the first two characters of MemName, specify: 
{Substr 1.2,{MemName}}.

{ToJob[to fieldname]} 

Name of a field in the dependent job (that is, job to which we are adding an In 
condition). For example, to indicate the MemName of the from and to jobs, use 
{MemName}-{ToJob[MemName]}.
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To find or update In condition and Out condition data:

1 Select In Conditions from the list in the Field column of the Mass Update Form.
The From and To fields of the form merge and an ellipsis button  is displayed 
on the right. A pair of braces {} are displayed in the merged From/To field.

2 Click . The Mass Update [In Condition] dialog box is displayed.

3 Select Find/Update from the Operation list.

4 Each condition is described by four fields: Name, Date, And/Or, and Parentheses. 
You can specify search criteria for any number of these fields.

NOTE  
The following steps describe how to find or update In condition data. Find and Update for 
Out conditions is handled in almost the same way as for In conditions. The only difference is 
that the Mass Update [Out Condition] dialog box contains rows for Name, Date, and 
Plus/Minus.
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For each field to be used as search criteria:

A Click the first cell in the row, and select an operator from the list.

B In the second cell of the row, either enter a text string to be found or updated, or 
select the search criteria from the list. The text string can contain all valid 
characters specified in the tables Table 46 on page 160 and Table 47 on page 161.

C The word Find is displayed in the third cell.

■ If condition data is to be used only as search criteria, continue with Step 5.
■ If certain fields should be updated, continue with substep D (below).

D Enter the update text string in the fourth cell of the Name row. When data is 
entered in the fourth cell, the term Find in the third cell automatically changes 
to Update. The text string can contain all valid characters specified in Table 46 
on page 160 and Table 47 on page 161.

E For the remaining rows (Date, And/Or and Parentheses), select update data 
from the lists that are displayed when the cursor is placed in the last cell of each 
row.

F Click OK to save your specifications and to return to the Mass Update Form. A 
summary of the Find/Update data is displayed in braces in the In Conditions 
row. 

To add In conditions:

1 Select In Conditions from the list in the Field column in the Mass Update Form. 
The From and To fields of the In Condition line merges, and an ellipsis button is 
displayed on the right. A pair of braces {} are displayed in the merged To/From 
field. 

2 Click . The Mass Update [In Condition] dialog box is displayed.
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3 Select Add from the Operation list box. The From section of the table is unavailable 
and the word Add is displayed in the first cell of the To section in each row.

4 In the fourth (last) cell in the row marked Name, enter the name of the new 
condition. The text string can contain all valid characters specified in Table 46 on 
page 160 and Table 47 on page 161.

5 In the remaining rows, Date, And/Or and Parentheses, select data to be added 
from the lists that are displayed when the cursor is placed in the last cell of each 
row.

6 Click OK to enter the data and return to the Mass Update Form. A summary of the 
added data is displayed in the braces in the In conditions row.

To remove data from In conditions:

Follow the steps listed above in “To Find In Condition Data.” However, in step 3, 
select Remove from the Operation list. The To section of the table is unavailable and 
the word Remove is displayed in the first cell of the From section in each row. 

NOTE  
To add new In conditions, values must be specified for all of the rows in the Mass Update [In 
Condition] dialog box.

NOTE  
It is not necessary to fill in values for all rows of the table for the Remove procedure to work. 
For example, entering only the operand = and a specific date would remove all In condition 
data that contain that date.
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To add and remove Out conditions:

Use the same procedure as described above for In conditions. Note only that the Mass 
Update [Out Condition] dialog box contains slightly different rows (Name, Date, 
and Plus/Minus). 



Mass updating of In conditions and Out conditions

166 CONTROL-M/Desktop User Guide



Chapter 5    Working with the Group Editing form 167

C h a p t e r 5
5  Working with the Group Editing form

The Group Editing form is used to view, specify and modify processing definitions 
that apply to jobs in a group scheduling table. 

These parameters are used by CONTROL-M to determine: 

■ When jobs in the group should be ordered.

■ Which conditions must be satisfied before jobs in the group are submitted for 
execution.

■ What action follows successful completion of all jobs in the group or unsuccessful 
completion of a job in the group.

To open the Group Editing form for an existing group scheduling table:

1 Choose View => Flowdiagram. 

2 Right-click the group scheduling table node, and choose Edit from the pop-up 
menu.

NOTE  
CONTROL-M/EM does not support definition of group scheduling tables for CONTROL-M 
for OS/390 versions earlier than 6.0.00.

NOTE  
You can convert an existing scheduling table to a group scheduling table using the 
copydefjob utility. This change enables you to take advantage of group processing of jobs. For 
more information, see the copydefjob utility description in the CONTROL-M/Enterprise 
Manager Utility Guide.
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To open a Group Editing form for a new group scheduling table:

Choose Edit => Scheduling Group=>New, or click .

Layout
The Group Editing form, which is shown in Figure 50, is divided into different panels 
in a similar way to the Job Editing form. Each panel contains a group of parameters. 
Some parameters differ for the different CONTROL-M platforms.

Table 48 describes the panels of the Group Editing form. Each panel is described in 
detail in the following pages.

Figure 50 Group Editing form 

NOTE  
You can only open the Group Editing form in Flow Diagram view.

You cannot create a new group when working in online load mode.
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General panel
The General panel for the Group Editing form identifies the group, application and 
CONTROL-M installation as well as other miscellaneous parameters. 

Table 48 Group Editing form panels 

Panel Name Description

General Parameters identifying the group, application and CONTROL-M 
installation.

Scheduling 
Tags

Tagged sets of scheduling criteria that are used by CONTROL-M to 
determine:

When jobs in the group should be ordered.

Which conditions must be satisfied before the jobs in the group are 
submitted for execution.

What action follows successful completion of all jobs in the group or 
unsuccessful completion of a job in the group.

Conditions Prerequisite IN conditions that must be satisfied for job submission for 
each job in the group. OUT conditions to be added or deleted on 
completion of the last job in the group.

Resources Quantitative and Control resources required for job submission.

Set AutoEdit variables to be set when each job in the group is submitted.

Shouts Messages to be sent to various destinations, depending on certain 
situations, after all the jobs in the group complete their processing.

PostProc Actions to be performed after all jobs in the group complete their 
processing, depending on the completion status of the group (OK or 
NOTOK).

NOTE  
The General panel for an MVS group has a field called Scheduling Table Lib. This field does 
not appear on the General panel for jobs defined for other platforms.
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Figure 51 Group Editing form – General panel 

Table 49 describes the parameters in this panel.

Table 49 Group Editing form – General panel parameters

Parameter Description

Mem Name Name of the file or member containing the Group definition (sometimes 
referred to as the Group entity).

Owner Owner (user ID) for the group. This parameter is checked by 
CONTROL-M security mechanisms to determine if the owner has the 
necessary authority for the requested actions.

Tasktype Task type of the group. This value is always Scheduling Group for 
group scheduling tables.

Adjust Condition Whether jobs in the group scheduling table ignore conditions usually 
set by jobs in the group scheduling table that are not scheduled. 

Priority Internal job priority under CONTROL-M for the group relative to other 
groups. 

Confirm When selected, manual confirmation is required before the group 
scheduling table is submitted for execution.

Maxwait Number of extra days (beyond the original scheduling date) that the job 
is allowed to remain in the Active Jobs file awaiting execution.

Name Name of the group scheduling table.

Lib Name of the library that contains the group scheduling table. (For MVS 
groups only)

Application Name of the application to which the group scheduling table belongs.

Group Logical name of the group scheduling table. 

CONTROL-M Name of the CONTROL-M to which the group scheduling table 
belongs.
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Time Zone The global time zone used to calculate the interval for time-related 
conditions.

From Earliest time (in hhmm format) that a job in the group scheduling table 
can be scheduled.

Until Latest time (in hhmm format) that a job in the group scheduling table 
can be scheduled. 

Due Out Latest time (in hhmm format) that the last job in the group scheduling 
table can end. [MVS only]

+ num Days – Number of days that job execution can be extended after 
the Odat. 
This subparameter is relevant only for jobs running in CONTROL-M 
for z/OS version 6.2.00 or later. 

Doc Mem Name of the file in which group documentation resides.

Note: To access the documentation, the user must be defined and have 
authorization on the CONTROL-M where the documentation resides.

Doc Lib Name of the library/directory containing the documentation file.

Note: To access the documentation, the user must be defined and have 
authorization on the CONTROL-M where the documentation resides.

Description Free-text description of the group.

NOTE  
The MVS panel may display differently depending on the version of CONTROL-M for z/OS. 

Table 49 Group Editing form – General panel parameters

Parameter Description
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Schedule Tags panel
Figure 52 Group Editing form – Schedule Tags panel

This panel is used to define Schedule Tags for a group scheduling table. Each 
Schedule Tag definition consists of a Schedule Tag name and a set of scheduling 
criteria. A Schedule Tag name is unique within a particular group scheduling table. 
The top left-hand section of the panel lists tags that are currently defined. When a tag 
in the list is selected, its scheduling parameters are displayed in the other fields of this 
panel. 

After editing an existing tag or defining a new one, click the check button  next to 
the text box under the list of Tag Names.

The following buttons are available in the Tag Name section: 

■ Inserts a new tag above the selected tag.

■ Deletes the selected tag.
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Defining a new tag

To add a new tag after the already defined tags: 

1 Select the line at the bottom of the list. To add a new tag elsewhere in the list, select 
the tag above which you want to add the tag, and click the button. An empty 
line opens up in the list above the selected tag. 

2 Type the tag name in the text box immediately below the tag list.

3 Specify scheduling criteria for the new tag. (See “Defining a Set of Scheduling 
Criteria.” below.)

4 When all required parameters have been defined, click or press Enter. The 
new tag is added to the list of defined tags.

Modifying an existing tag

1 Click on the wanted tag in the list. The tag’s scheduling details are displayed in the 
scheduling fields. 

2 Change the scheduling parameters as required. (See “Defining a Set of Scheduling 
Criteria”).

3 When you have made all the changes, click . 

Scheduling criteria

Scheduling criteria indicate days of the month, weekdays, dates on which jobs should 
be scheduled. Each Schedule Tag has its own unique scheduling criteria that can be 
applied to a job. One of the following types of scheduling criteria can be specified for 
each Schedule tag:

■ Month Days/Week Days. A list of days of the month and weekdays on which jobs 
should be scheduled.

■ Dates. A list of dates (month and day) on which the jobs should be scheduled.

Each of these sections has an option button. You can specify parameters in only the 
section whose option button is selected.The parameters of the unchecked section are 
not available.
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The fields of the Schedule Tags panel are described in Table 50.

For more information about scheduling criteria, see “Scheduling panel” on page 105, 
and the CONTROL-M Job Parameter and Variable Reference Guide.

Table 50 Schedule Tags panel parameters

Parameter Description

Month Days Days of the month on which to order the job. Days can be written in the 
Month Days text box separated by commas. Usage symbols should 
appear before the day, e.g. -10, D5. (For more information about usage 
symbols, see Days in the CONTROL-M Job Parameter and Variable 
Reference Guide). 

Month Days 
Calendar

Name of a user-defined calendar (DCAL calendar in CONTROL-M) 
containing a list of days of the month, used with Month Days to 
determine a set of working days. (For more information, see Days 
Calendar in the CONTROL-M Job Parameter and Variable Reference Guide).

and/or Indicate the relationship between Month Days values and Week Days 
values. 

■ If and is selected, a job should be scheduled only if the day of the 
month is one of the days in Month Days, and the day of the week is 
one of the days in Week Days.

■ If or is selected, a job should be scheduled if either the day of the 
month is one of the days in Month Days, or the day of the week is 
one of the days in Week Days.

Weekdays Day(s) of the week on which to schedule the job. A check box is 
provided for each day of the week (Sunday through Saturday). Check 
the boxes for the days on which the job should be scheduled. 
Alternatively, specify the wanted weekdays in the Data Box below the 
Weekdays List using the numeric codes according to the site standard. 
Specified codes should be separated by a comma. (For more 
information, see Week Days in the CONTROL-M Job Parameter and 
Variable Reference Guide) 

Example

1,2,3,4,5 would schedule the job on Monday through Friday (assuming 
the site standard is 0=Sunday, 1=Monday, ... 6=Saturday).

Weekdays 
Calendar

Name of a user-defined calendar (WCAL calendar in CONTROL-M) 
containing a list of weekdays, used with parameter Week Days to 
specify a set of working days. 

Months Months in which to order the job. Each month (Jan through Dec) is 
listed individually.
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Confcal Calendar used to confirm job scheduling dates. This parameter uses the 
following sub-parameters:

Name Name of the calendar.

Shift Days The number of days by which to shift the job if the date 
is not confirmed (i.e, it does not appear in the 
confirmation calendar, Confcal). Choose a value 
between -62 and 62.

Dates Dates on which to order the job. Valid values are four character dates, in 
mmdd or ddmm format (depending on the site standard). Dates are 
inserted into the list separately.

A maximum of twelve dates can be specified. If more dates are required, 
use a calendar. (For more information, see Dates in the CONTROL-M 
Job Parameter and Variable Reference Guide

Max Wait Maximum number of extra days (beyond the original scheduling date) 
the job is allowed to remain in the Active Jobs File awaiting execution, 
until it is deleted. (For more information, see Max Wait in the 
CONTROL-M Job Parameter and Variable Reference Guide.)

Retro Indicates whether or not the job should be scheduled for possible 
execution after its original scheduling date has passed. (For more 
information, see Retro in the CONTROL-M Job Parameter and Variable 
Reference Guide.)

Table 50 Schedule Tags panel parameters

Parameter Description
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Conditions panel
The Conditions panel is used to define prerequisite IN and OUT conditions. IN 
conditions are defined in the left side of this panel. OUT conditions are defined in the 
right side.

Figure 53 Group Editing form – Conditions panel

Each half of the conditions panel consists of a list of already-defined conditions, and a 
text box. The text box is used for editing existing conditions or defining new 
conditions. When you select a condition in the list, its contents are displayed in the 
Text line.

After editing or creating a condition, click the check button  next to the Text box to 
save the changes or to add the condition to the list.

Table 51 describes the buttons that are available for each section of the Conditions 
panel.

NOTE  
Even after a condition has been added or changed, the change can be undone or redone (if it 
was previously undone) using Ctrl-z and Ctrl-y. For more information, see “Undo and Redo 
in the Job Editing form” on page 100.
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Defining IN conditions

Table 52 describes the fields used to define In conditions for a group. 

Table 51 Conditions panel buttons

Button Description

Enter a new condition.

Delete the selected condition.

 and Change the order of the list.

Copy data.

Paste data.

Table 52 In condition fields

Field Description

Name Name of the prerequisite condition. (Text)

Date 4-character date reference for the condition. Valid values are: 

date A 4-digit date reference in the format mmdd or 
ddmm, depending on the site standard.

offset + or - followed by a number from 0 through 999, 
indicating the number of days in the future (+), or 
in the past (-), relative to the actual order date.

This value is valid only for jobs running in 
CONTROL-M for z/OS version 6.2.00 or later. 

ODAT Original scheduling date of the group.

PREV Previous scheduling date of the group.

STAT The condition is not date-dependent.

Note: This value is valid only for 
CONTROL-M/Server version 6.0.01 and above, 
and for CONTROL-M for OS/390 and z/OS.

**** or $$$$ Any scheduling date.

And/Or Logical relationship between multiple conditions. (Option buttons)

Parentheses Box. Used to indicate And/Or relationships.

Note: This field is relevant only for MVS groups.
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Defining OUT conditions

Table 53 describes the fields used for defining OUT conditions.

Table 53 Out condition fields

Field Description

Name Name of the prerequisite condition. (Text)

Date 4-character date reference for the condition. Valid values are:

date A 4-digit date reference in the format mmdd or 
ddmm, depending on the site standard. 

offset + or - followed by a number from 0 through 999, 
indicating the number of days in the future (+), or in 
the past (-), relative to the actual order date.

This value is valid only for jobs running in 
CONTROL-M for z/OS version 6.2.00 or later. 

ODAT Original scheduling date of the group.

PREV Previous scheduling date of the group.

NEXT Next scheduling date of the group.

STAT The condition is not date-dependent.

Note: This value is valid only for 
CONTROL-M/Server version 6.0.01 and above, and 
for CONTROL-M for OS/390 and z/OS.

**** or $$$$ Any scheduling date.

+ / - Indicates whether to add (+) or delete (–) the condition. (Option buttons)
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Resources panel (MVS)
The Resources panel is used to define Control resources for the group scheduling 
table. Control resources are defined in the right side.

The resources panel includes a list of already-defined resources, and a text box. The 
text box is used for editing existing resources or defining new resources. When you 
select a resource in the list, its contents are displayed in the text box.

After editing or creating a resource, click the check button  next to the Text box to 
save the changes or to add the resource to the list.

Table 54 describes the buttons that are available for each section of the Resources 
panel.

NOTE  
Quantitative resources cannot be defined for the group scheduling table. The Quantitative 
resources window is not available.
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Defining Control resources for a job

The following fields must be specified for each Control resource:

Table 54 Resources panel – Function buttons

Button Description

Enter a new resource.

Delete the selected resource.

 and Change the order of the list.

Copy data.

Paste data.

Name Name of the resource required by the job. (Text)

Shared/Exclusive Type of control that the job must have over the resource. 
(Option buttons)
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Set panel
The Set panel is used to specify AutoEdit variables to be resolved before group 
submission, and in each job's JCL/Script before job submission. 

Figure 54 Group Editing form – Set panel

AutoEdit variables that have already been defined for the group are displayed in the 
central window of this panel. Below this window, is a pair of text boxes for adding 
new variables and updating existing variables. To edit a variable definition, select it 
in the list of existing variables, and edit its contents the Text boxes at the bottom of the 
Set panel.

After editing or creating a variable, click the check button  next to the Text line to 
save the changes or to add the variable to the list.

For more information about definition of AutoEdit variables, see Do AutoEdit in the 
CONTROL-M Job Parameter and Variable Reference Guide.

For general information about the AutoEdit facility, see the CONTROL-M Job 
Parameter and Variable Reference Guide.

NOTE  
Application-specific job parameters may not be specified in AutoEdit variables. The names of 
application-specific job parameters are prefixed by two percent signs, the application’s 
abbreviation and a hyphen (%%SAPR3- for SAP, %%OAP- for Oracle, and so on). 
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Table 55 describes the buttons that are available for the Set panel.

Shouts panel
This panel is used to specify shout messages to be sent on group completion (that is, 
completion of the last job in the group). 

NOTE  
Even after data has been added or changed, the change can be undone or redone (if it was 
previously undone) using Ctrl-z and Ctrl-y. For more information, see “Undo and Redo in the 
Job Editing form” on page 100.

Table 55 Set Panel – Function Buttons

Button Description

Enter a new variable.

Delete the selected variable.

 and Change the order of the list.

Copy data.

Paste data.

NOTE  
This panel may display differently depending on the version of the platform (such as 
CONTROL-M for z/OS, which has an additional column for days offset. 
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Figure 55 Group Editing form – Shouts panel

The Shouts panel describes messages to be sent (shouted) to various destinations. The 
panel includes a list of previously defined Shout statements for the group. Below this 
list is series of fields for specifying additional Shout statements. 

■ Table 56 describes the buttons that are available for use with Shout statements.
■ Table 57 describes the fields that are used for definition of Shout statements.

After editing or creating a Shout message, click the check button  to save the 
changes and/or add the message to the list.

NOTE  
Even after shout data has been added or changed, the change can be undone or redone (if it 
was previously undone) using Ctrl-z and Ctrl-y. For more information, see “Undo and Redo 
in the Job Editing form” on page 100.

Table 56 Shout panel buttons 

Button Description

Enter a new message.

Delete the selected statement.

 and Change the order of the list.

Copy data.

Paste data.
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Table 57 Shout panel parameters 

Parameter Description

When Indicates the conditions under which the messages should be issued. 
Valid values are:

OK All jobs in the group ended with OK status.

NOTOK At least one job in the group ended NOTOK.

Late Sub First job in the group was submitted after the 
submission time limit.

The time must be specified in HHMM format, where 
HH is 00-23 and MM is 00-59.

Late Time Last job in the group completed after the completion 
time limit.

The time must be specified in HHMM format, where 
HH is 00-23 and MM is 00-59.

EXECTIME The message is sent if the elapsed runtime of the group 
is outside a specified limit. The limit, which is set in the 
Parm field of the Group Editing Form Shouts panel, can 
be expressed as a runtime limit, or as a deviation from 
the average runtime of the group. Valid formats for the 
limit are:

■ +n% – The message is sent if the elapsed runtime of 
the group exceeds its average execution time by at 
least n%. n is a number from 1 through 900.

■ –n% – The message is sent if the elapsed runtime of 
the group is at least n% less than its average 
execution time. n is a number from 1 through 99.

■ >n – The message is sent if the elapsed runtime of 
the group is greater than n minutes. n is a number 
from 1 through 999.

■ <n – The message is sent if the elapsed runtime of 
the group is less than n minutes. n is a number from 
1 through 999.

■ +n – The message is sent if the elapsed runtime of 
the group exceeds its average execution time by at 
least n minutes. n is a number from 1 through 999.

■ -n – The message is sent if the elapsed runtime of 
the group is at least n minutes less than its average 
execution time. n is a number from 1 through 999.

To Destination to which the message should be sent.

Very Urgent
Urgent
Regular

These option buttons indicate the urgency level of the shout.

message area This text box to the right of the other fields is used to specify the contents 
of the message. Use Ctrl+Enter to move to a new line.
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PostProc panel
The panel indicates conditional post processing actions to be performed when the last 
job in the group finishes processing, depending on the successful or unsuccessful 
completion of all the jobs in the group. 

Figure 56 Group Editing form – PostProc panel

Each item in this panel indicates either an ON statement, or a DO statement. ON 
statements indicate conditions under which specified actions should be performed. 
DO statements indicate actions to be performed when the preceding ON statements 
are satisfied.

The definition line below the list of statements can be toggled between fields for ON 
statements and fields for DO statements.

■ Table 58 describes the buttons that are available in the PostProc panel.
■ Table 59 describes the fields that are used for definition of DO statements.
■ On statement fields are described in the following section, “ON statement 

definition line.”

Table 58 PostProc Panel buttons  (Part 1 of 2)

Button Description

Displays the DO statement definition line.

Displays the ON statement definition line.

Delete the selected statement.

 and Change the order of the list.
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ON statement definition line

ON statements for groups contain the ON GROUP-END field. Choose either OK or 
NOTOK from the list. This field is used to indicate whether the specified DO actions 
should be performed when all the jobs in the group end successfully (OK) or when at 
least one job in the group ended unsuccessfully (NOTOK). 

After editing or creating an ON statement, click the check button  at the corner of 
the Step Codes section to save the changes and/or add the statements to the list.

DO statement definition line

This line is used to define DO actions to be performed when the ON GROUP-END 
condition is satisfied. To display this line, click the DO button . 

When you select a DO action from the list, the appropriate subparameters are 
displayed.

Available DO actions and their subparameters are described in Table 59.

Copy data.

Paste data.

NOTE  
Even after data has been added or changed, the change can be undone or redone (if it was 
previously undone) using Ctrl-z and Ctrl-y. For more information, see “Undo and Redo in the 
Job Editing form” on page 100.

Table 58 PostProc Panel buttons  (Part 2 of 2)

Button Description
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Table 59 Postproc Panel (groups) – valid DO statements  (Part 1 of 2)

DO statement Description

DO OK Sets the group's completion status to OK regardless of the group's 
completion status. No subparameters.

DO NOTOK Sets the group's completion status to NOTOK regardless of the group's 
completion status. No sub-parameters.

DO Set-Var Assigns a value to an AutoEdit variable.

Note: In the CONTROL-M/EM, this parameter is known as Do AutoEdit. 

The following subparameters are displayed: 

Name Name of the AutoEdit variable to be set.

Value Value to which the variable should be set. The value 
must be either a constant or resolvable.

This value cannot contain application-specific job 
parameters. The names of application-specific job 
parameters are prefixed by two percent signs, the 
application’s abbreviation and a hyphen (%%SAPR3- 
for SAP, %%OAP- for Oracle, and so on). 

DO Shout Specifies messages to be sent (“shouted”) to different destinations.

The following subparameters are displayed:

Destination Destination to which the message should be sent.

Urgency Urgency of the shout: Regular, Urgent, Very Urgent.

MSG Message to be sent. Use Ctrl+Enter to move to a new 
line.

DO Force-job Forces a job or a complete scheduling table to be ordered under 
CONTROL-M regardless of the scheduling criteria.

Note: When Do Forcejob forces a job that belongs to a group, it treats it as a 
regular job and forces it alone (that is, without a Group Entity).

The following subparameters are displayed:

SCD Table Name of the scheduling table containing the job to be 
forced.

Job Name Name of the job to be forced.

Date Scheduling date of the job to be forced. Valid values: 
ODAT, or a specific 4 or 6 character date reference 
(mmdd, ddmm, yymmdd, or yyddmm format, 
depending on the site standard).

For MVS: Only yymmdd or yyddmm format can be 
used.

Library [MVS only] Name of the library containing the 
specified scheduling table.
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After editing or creating a DO statement or ON statement, click the check button  to 
save the changes and/or add it to the list. For more information about DO parameters 
and ON parameters, see the CONTROL-M Job Parameter and Variable Reference Guide.

Exiting the Group Editing form

To close the Group Editing form:

1 Click one of the following: 

■ Save to Draft to apply the changes you made in the Group Editing form if you 
are working in local load mode.

■ Save to Database to apply the changes you made in the Group Editing form if 
you are working in online load mode.

■ Cancel. to cancel the changes you made in the Group Editing form.

Changes applied in the Group Editing form are immediately applied to the draft 
views in other panes and windows.

DO Condition Specifies prerequisite conditions to be added or deleted. The following 
subparameters are displayed:

Name Name of the prerequisite condition.

Date Date of the prerequisite condition. Valid values: A 
specific date (in mmdd or ddmm format), or one of the 
following 4-character literals: ODAT, PREV, NEXT, 
STAT, or $$$$. Note that $$$$ is only valid when 
deleting a condition.

+ / - Indicates whether to add (+) or delete (-) the condition.

DO Mail Sends a brief message when the specified On condition is fulfilled.

To The e-mail address of the recipient of the DO Mail 
message.

Regular or Urgent Priority for the shout message. Select the option button 
the reflects the level of urgency for the specified 
message; Regular, or Urgent. 

Subject A brief message that can describe the contents of a 
longer message.

CC The e-mail address of an additional recipient of the DO 
Mail message. Optional.

text box The text of the message to be sent.

Table 59 Postproc Panel (groups) – valid DO statements  (Part 2 of 2)

DO statement Description
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Copy Tags window
This window enables the user to copy Schedule Tags from one group scheduling 
table to another.

To open the Copy Tags window:

Choose Edit => Scheduling Group => Copy Tags from the menu bar.

-or-

Click the Copy Tags  button.

The Copy Tags window contains a From section and a To section. These sections 
provide the information about the table from which to copy the tag and the table to 
which to copy it. 

To copy a tag from one table to another:

1. Choose the data center from which you want to copy the Schedule Tag, from the 
list of data centers in the From section of the window.

2. Choose the group scheduling table from which you want to copy the Schedule Tag, 
from the list of group scheduling tables in the From section. The name of the group 
is displayed in the From Group Name text box.

3. Choose the data center to which you want to copy the Schedule Tag, from the list 
of data centers in the To section.
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4. Choose the group scheduling table to which you want to copy the Schedule Tag, 
from the list of group scheduling tables in the To section. The name of the group is 
displayed in the To Group Name text box.

5. Select the tag you want to copy from the list of tags in the From section by clicking 
on it.

-or-

Type the tag name in the text box above the schedule tag list in the From section.

6. Click the Arrow button. The selected tag is added to the list of tags in the To 
section.

7. Click OK to save the current list of tags in the To section.

NOTE  
For MVS groups, only uppercase letters are allowed in tag names. 

Tag names for groups on non-MVS platforms are case sensitive.
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C h a p t e r 6
6  Filtering data using collections

In CONTROL-M/Desktop, a collection is defined as a selection of jobs in a draft. 
CONTROL-M/Desktop allows you to filter the current draft into various collections 
according to specified criteria. These collections can then be used for filtered viewing, 
search and replace techniques, and mass updates.

By default, the collection on which you work contains all the jobs in the current draft. 
You can adjust this collection as often as necessary using the Collection Criteria form.

To filter the draft according to specified criteria:

Choose Tools => Collection or click the Edit Collection button on the toolbar. 
The following dialog box is displayed:

Figure 57 Collection Criteria Dialog Box
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Defining Collection criteria
The Collection Criteria dialog box contains an empty table in which fields, operators 
and values can be specified. These values act as selection criteria for filtering the 
draft. The field values are compared against the parameters in job processing 
definitions to determine if the job should be included in the collection. 

The Collection Criteria table contains the following columns:

Cells in the Field column are filled using a list box. Figure 58 shows the available 
fields.

Figure 58 Collection Criteria – Field drop-down list

The Operator column in the table is also a List box. Figure 59 shows the available 
operators. These operators are described in Table 61.

Table 60 Collection Criteria dialog box columns

Column Description

Field Field to be checked in the job processing definition.

Operator Operator to be applied to the specified value (e.g., =, >).

Value Value that determines whether or not the criteria are satisfied.

NOTE  
Certain CONTROL-M/Desktop fields correspond to values for CONTROL-M parameters (for 
example, August is a value for parameter MONTHS).
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Figure 59 Collection Criteria – Operators drop-down list

Example

The following collection includes only jobs that meet both of the following criteria: 
■ Job name begins with JOB4.
■ Job belongs to a group whose name begins with GRP5.

Figure 60 Sample collection criteria

Table 61 Collection Criteria – Operators

Operator Description

= Value in the job must equal the value in the table.

Like Use of wild card * in the value field.

> Value in the job must be greater than the value in the table.

< Value in the job must be less than the value in the table.

!= Value in the job must not equal the value in the field.

In Value in the job matches a listed value. Use commas to separate the values.

Not In Value in the job does not match any of the values listed in the value field. Use 
commas to separate the values.
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Specifying the selection action
The Collection window also contains an Action box that is used to specify the way in 
which the selection criteria are applied. 

Specify one of the following options:

■ Select the full draft.
■ Add the matching jobs to the current collection.
■ Remove the matching jobs from the current collection.
■ Set the matching jobs to be the current collection (meaning, the collection consists 

only of those jobs matching the currently specified criteria).

The fields and values in the collection criteria are compared with the parameters each 
job processing definition to determine if it should be included in the collection. For a 
job to be selected, it must match all specified criteria.

NOTE  
All rows of collection criteria table must be satisfied for each job in the collection. To use 
different sets of selection criteria for a single collection, fill in the first set of criteria to create 
the new collection, and then fill in the table again for each addition set of criteria and use the 
Add matching jobs ... option to add the appropriate jobs to the current collection.
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C h a p t e r 7
7  Managing scheduling tables

Job processing definitions are organized into scheduling tables according to various 
criteria. For example, jobs that are generally run together (concurrently or 
sequentially) are usually placed in the same scheduling table.

The Scheduling Table Manager of CONTROL-M/Desktop can be used to define and 
maintain scheduling tables. This feature enables the user to create new scheduling 
tables, modify, delete, force, or order existing tables, and upload and download 
scheduling tables to/from CONTROL-M/Server databases on relevant 
CONTROL-M platforms.

Scheduling tables are displayed as nodes in the CONTROL-M/Desktop Draft 
window Navigation Tree and Flow Diagram. 

The uploading and downloading of scheduling tables between 
CONTROL-M/Desktop and the CONTROL-M/EM database is discussed in 
“Moving from definition to production: an overview” on page 23.

The chapter discusses how to use the Scheduling Table Manager to work with 
scheduling tables.

To define, maintain and control scheduling tables in the CONTROL-M/EM database, 
use the Scheduling Table Manager window. This window allows you to:

■ View a list of all scheduling tables in the CONTROL-M/EM database.

■ Modify or delete existing scheduling tables, or create a new one.

■ Copy an existing scheduling table.

NOTE  
You can convert an existing scheduling table to a group scheduling table using the 
copydefjob utility. This change enables you to take advantage of group processing of jobs. For 
more information, see the copydefjob utility description in the CONTROL-M/Enterprise 
Manager Utility Guide.
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■ Force or order one or more scheduling tables.

■ Upload new or modified tables to the CONTROL-M/Server database in a specified 
CONTROL-M installation.

■ Download tables from a CONTROL-M/Server database to the CONTROL-M/EM 
workstation.

■ View the details for all the jobs in a selected table.

NOTE  
If a table that is associated with more than one User daily is modified using 
CONTROL-M/EM and then uploaded to CONTROL-M, that table is removed from all User 
Dailies except the one that is associated with it in CONTROL-M/EM.

NOTE  
You can convert an existing scheduling table to a Group scheduling table using the 
copydefjob utility. This change enables you to take advantage of group processing of jobs. For 
more information, see the copydefjob utility description in the CONTROL-M/Enterprise 
Manager Utility Guide.
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To open the Scheduling Table Manager window, 

1 In the CONTROL-M/Desktop window menu, either select Edit => Scheduling 
Tables => Scheduling Table Manager or click .

The Scheduling Manager window is displayed.

Figure 61 Scheduling Table Manager window

■ The fields at the top of this window can be used to filter the scheduling tables that 
are displayed. These fields are described in Table 62. Pattern matching rules used 
for filtering are described in “Specifying Pattern-Matching strings” on page 39.

■ The columns in the Scheduling Table Manager window are described in Table 63, 
and can be clicked to sort the scheduling tables in the window.

■ Buttons on the right side of this window offer a wide variety of actions that can be 
performed on scheduling tables selected in this window. These buttons are 
described in Table 64 on page 198.

Table 62 Filter fields – Scheduling Table Manager  (Part 1 of 2)

Field Description

Filter When selected, this check box indicates that the filter criteria should be 
applied.

CONTROL-M List scheduling tables only for the specified CONTROL-M installation.

Table List the specified scheduling tables only.
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Library [For MVS users] List scheduling tables for the specified library only.

Modified Toggles between display of only Modified (÷) tables, tables that have 
not been modified (blank), or both (gray).

Table 63 Column descriptions – Scheduling Table Manager

Column Description

CONTROL-M Name of the CONTROL-M.

Table Name of the scheduling table (1-20 characters, case sensitive).

Library [For MVS users] Name of the library in which the scheduling table is 
located.

Platform Type of CONTROL-M platform.

Version Version of CONTROL-M.

Locked by Name of the CONTROL-M/EM user currently modifying the 
scheduling table. A scheduling table can be modified by only one user 
at a time.

User Daily Identifier used to assign the scheduling table to a specific User Daily 
Job (1-10 characters, case-sensitive). If “SYSTEM” (uppercase only) is 
specified, the scheduling table is ordered by the New Day procedure. 
The New Day procedure and User Daily Jobs are described in the 
CONTROL-M/Enterprise Manager User Guide.

Note for MVS users: Assignment of the scheduling table to the New 
Day procedure or to a specific User Daily Job is described in Section 5 
of the (mainframe) CONTROL-M User Manual.

Modified Yes indicates that the scheduling table has been updated but not yet 
uploaded.

Last Upload Time (24 hour format) of last upload of the scheduling table to the 
CONTROL-M/Server database in the indicated installation.

Table 64 Command buttons – Scheduling Table Manager  (Part 1 of 3)

Button Description

New Opens the Scheduling Table dialog box to enable definition of a new 
scheduling table. For more information, see “Creating or modifying 
scheduling tables” on page 200.

Delete (R + L) Deletes the table from both the CONTROL-M/EM and 
CONTROL-M/Server databases. For more information, see “Table 
Synchronization” in the CONTROL-M/Enterprise Manager User Guide.

Force Delete
(R + L)

Deletes the table from both the CONTROL-M/EM and 
CONTROL-M/Server databases, regardless of whether or not a later 
version of the table exists in the CONTROL-M/Server database.

Local Delete Deletes the table from the CONTROL-M/EM database only.

Remote Delete Deletes the table from the CONTROL-M/Server database only. 

Table 62 Filter fields – Scheduling Table Manager  (Part 2 of 2)

Field Description
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Copy Opens the Copy Scheduling Table dialog box to enable the copying of 
a scheduling table. For more information, see “Creating or modifying 
scheduling tables” on page 200.

Table Details Displays a window from which you can modify the selected 
scheduling table. This window is described in “Creating or modifying 
scheduling tables” on page 200.

Upload Copies the selected scheduling table to the specified 
CONTROL-M/Server database. Upload is a background process. You 
can perform other actions during transmission. On completion, the 
Modified field changes to No.

■ If the scheduling table in the CONTROL-M/Server database is a 
more recent version, a message appears indicating that the 
Upload is not allowed. This restriction can be overridden using 
the Force Upload option (described below).

■ To upload or download multiple scheduling tables, hold down 
the <Ctrl> key and select the required tables.

Force Upload Copies the selected scheduling table to the specified 
CONTROL-M/Server database, regardless of whether a more recent 
version of the table exists in the CONTROL-M/Server database. 
Upload is a background process. you can perform other actions 
during transmission. On completion, the Modified field changes to 
No.

Download Copies the selected scheduling table from the CONTROL-M/Server 
database to the CONTROL-M/EM database. Download is a 
background process. You can perform other actions during 
transmission. On completion, the Modified field changes to No.

To download a scheduling table that is not displayed in the 
Scheduling Table Manager window, create the scheduling table and 
then download the scheduling table normally.

Order Orders the selected table. scheduling tables can also be ordered from 
the Order/Force Jobs window in CONTROL-M/EM. 

When Order is clicked, a dialog box is displayed in which you specify 
the order date. Specify either ODAT or a specific date.

For more information, see “Ordering or Forcing Jobs or Scheduling 
Tables” in the CONTROL-M/Enterprise Manager User Guide.

Force Forces the selected table. scheduling tables can also be forced from 
the Order/Force Jobs window in CONTROL-M/EM. 

When Force is clicked, a dialog box is displayed in which you specify 
the force date. Specify either ODAT or a specific date.

For more information, see “Ordering or Forcing Jobs or Scheduling 
Tables” in the CONTROL-M/Enterprise Manager User Guide.

Table 64 Command buttons – Scheduling Table Manager  (Part 2 of 3)

Button Description
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Creating or modifying scheduling tables
When you click New or Update in the Scheduling Table Manager window, the 
Scheduling Table dialog box is displayed. This window enables you to define new 
scheduling tables and edit existing ones. 

The fields of this dialog box are described in Table 65.

Figure 62 Scheduling Table dialog box

Unlock Unlocks the selected scheduling table to allow modification by a 
different user.

Refresh Refreshes the status of the scheduling tables in the window.

Select All Selects all scheduling tables displayed in the window. 

Note: This option is not available if all of the scheduling tables are 
already selected.

Jobs List Opens a window containing a list of all of the jobs contained in the 
scheduling table. This window is described in “Jobs List window” on 
page 204.

Table 65  Scheduling Table dialog box fields  (Part 1 of 2)

Field Description

CONTROL-M Name of the CONTROL-M installation.

Name Name of the scheduling table (1-20 characters, case sensitive, no 
blanks).

Table 64 Command buttons – Scheduling Table Manager  (Part 3 of 3)

Button Description
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To define a new scheduling table:

1 In the Scheduling Table Manager window, click New. The Scheduling Table 
dialog box (Figure 62 on page 200) opens.

2 Specify criteria for the new scheduling table in the dialog box, and click OK. 

The scheduling table is added to the CONTROL-M/EM database.

To change details of an existing scheduling table:

1 In the Scheduling Table Manager window, select a scheduling table and click 
Update. 

The Scheduling Table dialog box (Figure 62 on page 200) displays details of the 
selected scheduling table.

2 Modify the scheduling table criteria and click OK. 

The changes are saved in the CONTROL-M/EM database.

Library [MVS] Name of the library in which the scheduling table is located.

User Daily (Optional) Identifier used to assign the scheduling table to a specific 
User Daily Job (1-10 characters, case sensitive). If “SYSTEM” 
(uppercase only) is specified, the scheduling table is ordered by the 
New Day procedure. The New Day procedure and User Daily Jobs 
are described in the CONTROL-M/Enterprise Manager User Guide.

[MVS] Documentation purposes only. Assignment of the scheduling 
table to the New Day procedure or to a specific User Daily Job is 
described in Section 5 of the (mainframe) CONTROL-M User Manual.

NOTE  
You must be authorized to modify scheduling tables. Otherwise, the fields of the dialog box 
are unavailable.

Table 65  Scheduling Table dialog box fields  (Part 2 of 2)

Field Description
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Copying a scheduling table
You can copy an existing scheduling table to the same or a different CONTROL-M.

To copy a scheduling table:

1 In the Scheduling Table Manager window, select the scheduling table to be copied, 
and click Copy (or Ctrl + C).

The Copy Scheduling Table dialog box displays details of the selected scheduling 
table.

Figure 63 Copy Scheduling Table dialog box

2 Specify a new table name in the Name field (for the target scheduling table).

3 Modify other criteria as wanted, and click OK.

The changes are saved in the CONTROL-M/EM database.

NOTE  
Depending on defaults set in the Confirmations panel of the Options dialog box, a 
confirmation prompt may be issued before the Copy Scheduling Table dialog box is 
displayed. For information on the Options dialog box, see Chapter 11, “Customization.”
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Ordering and forcing scheduling tables

You can order and force scheduling tables in both CONTROL-M/Desktop and 
CONTROL-M/EM. For instructions on ordering and forcing scheduling tables in 
CONTROL-M/EM, see the CONTROL-M/Enterprise Manager User Guide.

To order or force scheduling tables from within CONTROL-M/Desktop:

1 In the CONTROL-M/Desktop window menu, either select Edit => Scheduling 
Tables => Scheduling Table Manager or click . The Scheduling Manager 
window is displayed.

Figure 64 Scheduling Table Manager window

2 Select the line(s) for the scheduling tables that you want to order or force.

3 Click either Order or Force.

NOTE  
When copying a scheduling table, note the following:

■ Only one table may be selected, and it must be unlocked at the time of the copy.
■ You must be authorized to copy scheduling tables (or the fields are unavailable).
■ The Library field is only enabled in CONTROL-M for z/OS.
■ The new table name you specify must be unique to the particular CONTROL-M.
■ If you specify a different target CONTROL-M, it must be the same platform and version as 

the scheduling table source CONTROL-M.
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4 If a confirmation dialog box displays, click Yes. The following dialog box is 
displayed.

The default order/force date depends on the CONTROL-M version. For 
CONTROL-M versions 6.0.0 and higher, the default date is the CONTROL-M 
ODAT; for versions prior to 6.0.0, the default date is the CONTROL-M/EM 
machine date. 

5 To assign a different date than the default date, click the button by the date 
selection field, and select the desired date.

6 For a job running under CONTROL-M for z/OS version 6.2.00 or later, to ensure 
that it does not run before the Odate, check the Wait for Odate to run check box. 
(If this check box is not checked, the job runs as soon as the execution criteria are 
satisfied.)

The Table Action Report is displayed, reporting the progress of the order or force.

7 Click Close. 

Jobs List window
The Jobs List window lists the jobs and group scheduling tables comprising a selected 
scheduling table. By default, all jobs and group scheduling tables are displayed. 
However, you can apply a filter to display only selected jobs.
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You can modify the processing definitions of jobs and group scheduling tables 
displayed in the Jobs List window. You can also use the Jobs List window to delete or 
create new job definitions and group scheduling tables. Modifications are applied to 
the CONTROL-M/EM database.

To display the Jobs List for a scheduling table:

1 In the Scheduling Table Manager window, select the scheduling table from the list.

2 Click Jobs List, or double-click the selected scheduling table name.

The Jobs List window is displayed. 

Figure 65 Jobs List window

The name of the scheduling table appears in the title bar. If the scheduling table is 
locked, the phrase [Read Only] also appears in the title bar.

■ The fields at the top of this window can be used to filter the jobs that are displayed. 
These fields are described in Table 66. Pattern matching rules used for filtering are 
described in “Specifying Pattern-Matching strings” on page 39.

■ The columns in the Job List window display job definition parameters. For 
parameter descriptions, see the CONTROL-M Job Parameter and Variable Reference 
Guide. 



Jobs List window

206 CONTROL-M/Desktop User Guide

■ Buttons on the right side of this window offer a wide variety of actions that can be 
performed on jobs selected in this window. These buttons are described in Table 67 
on page 206.

Table 66 Filter fields – Job List window

Field Description

Job Name Name of the job.

Mem Name Name of a file containing a job script.

Mem Lib Name of a library/directory in which a job script is located. 

Group Name of a group of jobs.

Application Name of an application. Used to supply a descriptive name to a set of 
related groups of jobs.

Table 67 Command buttons – Jobs List window 

Element Description

Clear Clears filter criteria from the filter fields.

Apply Applies the specified filter.

Close Closes the Jobs List window.

New Opens a new Job Editing form (for an undefined job). It can also 
create a scheduling group if the scheduling table is empty. 
Unavailable if the table is locked or if the user is not authorized to 
open a job in the table.

Update (View) Displays the currently selected job in the Job Editing form for update. 
(If the scheduling table is currently locked, or the user is not 
authorized to update the table or its jobs, the button says View, and 
opens the job for viewing only.)

Delete Deletes the currently selected job definition or scheduling group. 
Unavailable if the table is locked or the user is not authorized to 
delete the table or its jobs.
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Filtering the jobs list

To filter jobs in the Jobs List window based on values:

1 Select the Filter Jobs List check box, and enter valid values into any or all of the 
filter text boxes described in Table 66. (If wanted, click Clear to remove filter 
criteria from the filter fields.)

2 Click Apply to apply the filter. 

All applicable jobs in the scheduling table are displayed. 

Displaying, editing, and deleting job definitions in the Job 
Editing form

To display and edit details of an existing job or group scheduling table:

1 Either select the job in the list and click Update, or double-click the job (or Group 
scheduling table) in the list. 

The job definition is displayed in the Job Editing form (or Group Editing form).

NOTE  
Pattern-matching special characters can be used for filtering. For details, see “Specifying 
Pattern-Matching strings” on page 39.

NOTE  
The Group entity in the Group scheduling table is always displayed, regardless of specified 
filtering criteria.

NOTE  
Any changes made to a definition in a Job Editing form or a Group Editing form are written 
directly to the Definition section of the CONTROL-M/EM database.
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2 Users with Update authorization or higher can modify the job or Group 
scheduling table parameter fields, with the following exceptions

■ When the Job Editing form is displayed, the Table and Scheduling Table 
Library (MVS only) fields cannot be modified. The job is already associated with 
the scheduling table (and Library) from which the Jobs List window was 
displayed.

■ When the Group Editing form is displayed, the Table and Group fields cannot 
be modified. The Group parameter describes the Group scheduling table, itself, 
and the Group scheduling table is already associated with the scheduling table 
from which the Jobs List window was displayed. (The Group field is enabled, 
however, when you are creating a new Group scheduling table.)

NOTE  
If the scheduling table is locked (for example, if it is in use by another user) a View button 
replaces the Update button. In this case, and depending on defaults set in the Confirmation 
panel of the Options window, either the Job Editing form is automatically opened for viewing 
only, or you are asked whether you want to see a copy the Job Editing form for viewing only. 
Updates are prohibited. For details regarding setting defaults in the Options window, see 
Chapter 11, “Customization.”

NOTE  
The Save to Database button replaces the Save to Draft button when working in online mode.
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3 Click Save to Database. The modifications to the job or Group scheduling table 
definition are saved to the CONTROL-M/Enterprise Manager database. 

To create a new job in the scheduling table:

1 Click New.

A Job Editing form is displayed with the default values taken from the active 
skeleton.

2 Define the job parameters in the Job Editing form, and save.

To delete jobs from the scheduling table:

1 Select the job (or jobs) to be deleted (multiple jobs can be selected) and click Delete.

Depending on defaults set in the Confirmation panel of the Options window, you 
may be prompted to confirm the delete request. For details regarding setting 
defaults in the Options window, see Chapter 11, “Customization.”

2 If a confirmation prompt is displayed, confirm the prompt.

The selected jobs are deleted.

NOTE  
If the scheduling table is empty, you are asked whether you want to create a new scheduling 
group or a regular job definition. 

NOTE  
If the default values cannot be determined (that is, there is a mismatch between the current 
CONTROL-M name and the specified CONTROL-M name), an empty Job Editing form is 
displayed. In this case, depending on defaults set in the Confirmation panel of the Options 
window, a message may indicate that the Job Editing form is empty. For details regarding 
setting defaults in the Options window, see Chapter 11, “Customization.”

NOTE  
If you delete a Group entity, all jobs in the group are automatically deleted. This means that 
you are actually deleting all jobs in the table.
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Uploading definitions to the 
CONTROL-M/Server database

Job processing definitions and their scheduling tables must be uploaded to the 
CONTROL-M/Server database at a data center so that they can be scheduled to run. 

The upload copies the selected scheduling table(s) to the specified 
CONTROL-M/Server database. An upload is a background process, so you can 
perform other actions during transmission.

To upload multiple scheduling tables:

1 Either select Edit => Scheduling Tables => Scheduling Table Manager or click 
. The Scheduling Manager window is displayed.

Figure 66 Scheduling Table Manager Window

2 Hold down the <Ctrl> key and select the required scheduling tables.

TIP  
It is also possible to force an upload, for cases where a more recent version of the scheduling 
table exists in the CONTROL-M/Server database. For more information, see “Force Upload” 
on page 199.
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3 Click Upload or Force Upload.

4 Click Close.
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C h a p t e r 8
8  Working with calendars

A calendar contains a list of dates, usually spanning a number of months or years, 
that can be used to determine when a job can and cannot be scheduled. Specific days 
in a calendar can be designated as working days, accounting dates, holidays, and so 
on.

Any number of calendars can be defined, in your data center. Typically, each 
calendar is used to specify a different set of dates.

The dates on which a job can be ordered are limited by the calendars named in the 
scheduling parameters of the job processing definition (for example, Days or 
Calendar).

If no calendar is specified, the job is ordered only on the basis of other scheduling 
parameters (for example, Days, Months).

A new or modified calendar is saved in the CONTROL-M/EM database. Before a 
calendar can be referenced from a job processing definition, it must be uploaded to 
the CONTROL-M/Server database of the appropriate CONTROL-M installation. 
Uploading and downloading of calendars is discussed in “Table Synchronization” in 
the CONTROL-M/Enterprise Manager User Guide.

CONTROL-M uses three types of calendars, which are described in Table 68.
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A job processing definition that points to a calendar from the Days Calendar And/Or 
Week Days Calendar parameter is ordered based on the dates in that calendar. Other 
Scheduling parameters can be used with a calendar to further control the dates on 
which the job is ordered.

For examples of how calendars are used to schedule jobs, refer to the description of 
the Days Calendar parameter in CONTROL-M Job Parameter and Variable Reference 
Guide.

[MVS] For examples of how calendars are used to schedule jobs under MVS, refer to 
the job scheduling parameters chapter in the CONTROL-M for OS/390 and z/OS User 
Manual.

To see the effect of a calendar on a job’s schedule plan, run the CTMRPLN utility. 
This utility produces a report that indicates when jobs in a selected scheduling table 
are scheduled to run. For more information about the CTMRPLN utility, see the 
Utilities references in the CONTROL-M/Server Administrator Guide and the 
CONTROL-M for OS/390 and z/OS User Manual.

Table 68 Calendar types

Calendar type Description

Regular A regular calendar consists of a succession of dates, specifying when a job 
can or cannot be ordered. A job whose job processing definition points to a 
calendar in the Days Calendar and/or Week Days Calendar parameter is 
ordered based on the set of dates in that calendar. Other Scheduling 
parameters can be used in conjunction with a regular calendar to further 
control the dates on which the job is ordered.

Relative [MVS] A relative calendar is one which is intended for use in conjunction 
with another calendar. A relative calendar is combined (using the 
CONTROL-M IOABLCAL utility) with a regular calendar or with another 
relative calendar to generate a new regular calendar. The new calendar 
that results from this process is a combination of the two calendars input to 
the utility. For more information regarding relative calendars and 
examples of how the IOABLCAL utility is used, refer to the CONTROL-M 
for OS/390 and z/OS User Manual. 

Periodic A periodic calendar can be used to divide the year into working periods 
(that is, 13 periods, 20 periods, and so on), instead of into twelve months. 
Each period can be the same or different in length. Periods do not have to 
be specified using consecutive dates, and they can overlap. A periodic 
calendar is used in conjunction with the Days or Week Days parameters to 
specify on which dates a job should be ordered.

Note: Each period can be up to a maximum of 255 days in length.
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Managing calendars
Calendars are listed in the Calendars Manager window. In this window, you can:

■ Delete existing calendars.

■ Request to define new calendars, or edit existing calendars.

■ Request to copy existing calendars.

■ Upload calendars from the CONTROL-M/EM database to the 
CONTROL-M/Server database.

■ Download calendars from the CONTROL-M/Server database to the 
CONTROL-M/EM database.

Opening the Calendars Manager window

Use the following steps to open the Calendars Manager window.

To open the Calendars Manager window:

1 Click . or choose Edit => Calendar Manager. The CONTROL-M/Enterprise 
Manager Login dialog box is displayed. 

2 Enter your user name and password and the name of the server to which you are 
connecting.

3 Click Login. The Calendars Manager window is displayed.

NOTE  
When you close the Calendars Manager window, the connection with CONTROL-M/EM is 
broken. You optionally establish a connection that is closed only when you specify, use the 
Connect feature described in “Moving from definition to production: an overview.”
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Fields of the Calendars Manager window

The columns in the Calendars Manager window are described in Table 69, and can be 
clicked to sort the calendars in the window.

Buttons on the right side of this window offer a wide variety of actions that can be 
performed on calendars selected in this window. These buttons are described in 
Table 70 on page 217.

Figure 67 Calendars Manager window

Table 69 Calendars Manager window columns

Column Description

CONTROL-M Name of the CONTROL-M installation to which the calendar belongs.

Calendar User-defined name of the calendar (maximum of 10 characters). This is the 
name by which the calendar is specified in the job processing definition.

Locked by Name of the CONTROL-M/EM user currently modifying the calendar. 
A calendar can be modified by only one user at a time.

Last Upload Date and time of last upload or download of the calendar between 
CONTROL-M/EM and the CONTROL-M/Server database in the specified 
installation.

Modified Yes indicates that the calendar has been modified on the 
CONTROL-M/EM workstation but not yet uploaded to the CONTROL-M.

Type Type of calendar. Relative, Regular, or Periodic.
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Table 70 Calendars Manager window – Command buttons

Button Description

New Opens the Calendar Definition window to define a new calendar. For more 
information, see “Defining and modifying calendars” on page 218.

Delete Deletes the selected Calendar from the CONTROL-M/EM and 
CONTROL-M/Server databases.

Copy Opens the Copy Calendar dialog box to enable copying of the selected 
calendar.

Force Delete Delete the Calendar from both the CONTROL-M/EM and 
CONTROL-M/Server databases, regardless of whether a later version of 
the Calendar exists in the CONTROL-M/Server database.

Local Delete Deletes the Calendar from the CONTROL-M/EM database.

Remote Delete Deletes the Calendar from the CONTROL-M/Server database. 

Note: To delete a Calendar in the CONTROL-M/Server database that was 
modified more recently than the one in the CONTROL-M/EM database use 
the Force Delete option. For additional information, see the description of 
table synchronization in the CONTROL-M/Enterprise Manager User Guide.

Update Opens the Calendar Definition window to update the selected calendar. For 
more information, see “Defining and modifying calendars” on page 218.

Upload Copies the selected calendar to the indicated CONTROL-M/Server 
database. The upload takes place as a background process, allowing the 
user to perform other actions during transmission. Upon completion, the 
Modified field changes to No.

If the calendar in the CONTROL-M/Server database is a later version, a 
message appears indicating that the Upload is not allowed. This restriction 
can be overridden using the Force Upload option (described below).

Force Upload Copies the selected calendar to the indicated CONTROL-M/Server 
database, regardless of whether or not a later version of the calendar exists 
in the CONTROL-M/Server database. The upload takes place as a 
background process, allowing the user to perform other actions during 
transmission. Upon completion, the Modified field changes to No.

Download Copies the selected calendar from the CONTROL-M/Server database to the 
CONTROL-M/EM database. The download takes place as a background 
process, allowing the user to perform other actions during transmission. 
Upon completion, the Modified field changes to No.

To download a calendar that does not appear in the Calendar Manager 
window (and therefore cannot be selected), first create the calendar (using 
the Calendar Definition window) and then download the calendar 
normally.

Unlock Unlocks the selected calendar to allow modification by a different user.

Refresh Refresh the status of calendars in the window.
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Defining and modifying calendars
The Calendar Definition window enables the user to define new calendars and edit 
existing calendars. This window is displayed by clicking either New or Update in the 
Calendars Manager window.

Figure 68 Calendar Definition window

To define a new calendar:

1 Click New in the Calendars Manager window. The Calendar dialog box is 
displayed:

Figure 69 Calendar dialog box
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2 Specify the CONTROL-M and a name for the new calendar. Indicate whether the 
calendar is Relative/Regular or Periodic. Click OK. The new calendar is created in 
the CONTROL-M/EM database and the Calendar Definition window is displayed 
(see Figure 68 on page 218).

3 Define the calendar criteria as described in “Defining calendar criteria” on 
page 221.

4 When you have finished selecting dates in the new calendar, click OK to close the 
Calendar Definition window.

To modify an existing calendar:

1 Select a calendar in the Calendars Manager window. 

2 Click Update. The Calendar Definition window is displayed for the selected 
calendar.

3 Modify the calendar criteria as described in “Defining calendar criteria” on 
page 221.

4 Click OK. Changes are saved to the CONTROL-M/EM database.

NOTE  
The Calendar Definition window saves calendars only to the CONTROL-M/EM database. For 
CONTROL-M to use a calendar, it must be uploaded to a CONTROL-M/Server database (for 
example, using the Upload button in the Calendars Manager window).
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Copying calendars
You can copy an existing calendar to the same or a different CONTROL-M.

To copy an existing calendar:

1 In the Calendars Manager window, select the calendar to be copied, and click 
Copy (or Ctrl+C).

The Copy Calendar dialog box displays details of the selected calendar.

Figure 70 Copy Calendar dialog box

2 Specify a new calendar name in the Name field (for the target calendar).

3 If wanted, specify a different CONTROL-M.

4 Click OK. The changes are saved in the CONTROL-M/EM database.

NOTE  
Depending on defaults set in the Confirmations panel of the Options dialog box, a 
confirmation prompt may be issued before the Copy Calendar dialog box is displayed. For 
information on the Options dialog box, see Chapter 11, “Customization.”

NOTE  
When copying a calendar, note the following:

■ You must be authorized to copy calendars (or the window fields are unavailable).
■ Only one calendar may be selected, and it must be unlocked at the time of the copy.
■ The new calendar name you specify must be unique to the particular CONTROL-M.
■ If you specify a different target CONTROL-M, it must be the same platform and version as 

the calendar source CONTROL-M.



Defining calendar criteria

Chapter 8    Working with calendars 221

Defining calendar criteria
Calendar criteria can be defined in a variety of different ways. The following 
paragraphs describe the different types of calendar criteria and how they can be 
specified in the Calendar Definition window (Figure 68 on page 218).

General calendar criteria

To add a description to a calendar:

A free text description can be saved for each calendar. This definition is specified in 
text box (labeled Description) in the upper portion of the calender definition 
window. The text is saved when you click OK.

To select years for a calendar:

Each calendar can span one or more years. To edit an existing year in the calendar, 
select the year from the list in the upper left of the Calendar Definition window. If a 
calendar for the required year has not been defined, click New... and specify the year.

Criteria for regular or relative calendars

In regular calendars dates on which the job can be ordered, are marked by a Y. In a 
relative calendar, they are marked by Y, + or -. Dates that contain the actual date (a 
number) indicate dates on which the job cannot be ordered. This is equivalent to the 
value N for that date. For more information about symbols and colors in the calendar, 
see “Dates and colors” on page 224.

To mark a date in the calendar:

1 Click the date and type Y, + or -. The selected mark and an appropriate color 
appear in place of the date and the cursor is advanced to the next date.

-or-

Right-click the date and select an option from the popup menu (N, Y, +, -). 
The selected mark and color appear in place of the date and the cursor is advanced 
to the next date.

B

NOTE  
When defining a calendar, each time you attempt to change the year (either to modify a 
different year or create a new year), CONTROL-M/Desktop prompts you to confirm if you 
want to save the changes made to the current year.
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2 To unmark a date, click the selected date again and change the mark to N. The 
actual date is then displayed.

To select all weekdays in a month:

Click the column heading for the appropriate day. For example, click M to select all 
Mondays in the month.

To select an entire week in a month:

Click the button to the left of a calendar week to select the entire week.

To select an entire month:

Click the top left button of the month.

Criteria for periodic calendars

Dates in a periodic calendar are marked by a periodic identifier. These identifiers can 
be any character except Y, N, +, or -.

To specify a periodic identifier

1 Click a date and type a periodic identifier (any character except Y, N, + and -).

A To unmark a date, click the selected date again and either right-click or press the 
<Del> key to remove the identifier.

NOTE  
The number in the week button indicates the date of the first day in that week.

NOTE  
Each period can be up to a maximum of 255 days in length.
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To apply general calendar criteria to every month in a year:

1 Click Advanced. The General Calendar definition window opens.

2 Select the date(s) in the Month or select the day(s) of the Week.

3 Click OK. All the selected dates are highlighted each month in the Calendar 
Definition window.

4 Type the wanted mark (Y, + or -) or periodic identifier or right-click to open and 
select an option from the pop-up menu (N, Y, +, or -). The selected mark and color 
appear in place of the dates. 
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Dates and colors

The characters and colors displayed in regular, relative and periodic calendars 
indicate how a job should be handled on each date. The meaning of each character 
and color is as follows:

Table 71 Dates and colors

Mark Color Type Description

Date (N) Regular, 
Relative or 
Periodic 

The job cannot be ordered on this date.

Y Green Regular or 
Relative 

The job can be ordered on this date.

– Pink Relative For MVS jobs only.

 When matched against a Y in the associated calendar by the 
IOABLCAL utility, causes the generated calendar to have a Y in 
the corresponding date. When not matched against a Y, causes 
the generated calendar to have a Y on the nearest prior working 
date.

+ Yellow Relative For MVS jobs only.

When matched against a Y in the associated calendar by the 
IOABLCAL utility, causes the generated calendar to have a Y in 
the corresponding date. When not matched against a Y, causes 
the generated calendar to have a Y on the nearest following 
working date.

* different 
color for 
each period

Periodic Dates are marked with unique period identifiers. Identifiers can 
be any character except Y, N, + and -. Each identifier has its own 
unique color.

Note: Each period can be up to a maximum of 255 days in length.
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C h a p t e r 9
9  Defining and scheduling jobs with 
the CONTROL-M Job Definition 
Wizard

The CONTROL-M Job Definition Wizard is the easy way to create, modify, and 
schedule CONTROL-M job processing definitions.

To run the Job Definition Wizard, you will need:

■ A CONTROL-M/EM user account and valid password
■ A running CONTROL-M/EM GUI Server
■ Definitions in CONTROL-M/Desktop for each of your CONTROL-M installations 
■ A running gateway between CONTROL-M/EM and your CONTROL-M 

installation

The Job Definition Wizard is intended for new users. It enables you to define and run 
jobs while becoming familiar with the key elements of CONTROL-M.

NOTE  
The wizard cannot be run in conjunction with the online load mode. For more information, 
see “A comparison of online and local load modes” on page 21.
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Starting the CONTROL-M/Desktop Wizard
1 Click  in the CONTROL-M/EM Desktop tool bar and the Introduction window 

is displayed.

Step 1: Introduction window

The Introduction window (Step 1) describes the Job Definition Wizard functions and 
prerequisites. The left side lists all the windows of this wizard. The window you are 
in is highlighted.

TIP  
If the toolbar is not displayed, press Ctrl-w to display the Toolbar menu.

TIP  
The Finish button completes the job definition and opens the CONTROL-M/EM GUI.

The Close button closes the Job Definition Wizard. All data is retained in the database. You 
can return to the Job Definition Wizard and continue the job definition.
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Ensure that the prerequisites have been met and click Next to continue.

Step 2: Connect window

If you are offline or want to connect to a different CONTROL-M/EM GUI Server, 
enter the data in this window. 

The CONTROL-M/EM GUI Server is the “heart” of CONTROL-M/EM. This 
component controls communication between the various CONTROL-M components 
and the CONTROL-M/Server database. The CONTROL-M/EM GUI Server also 
maintains a database, in which all job scheduling information is stored before being 
inserted in to the CONTROL-M Active Jobs file. 

1 Specify the following information:

■ Username – Your CONTROL-M/EM username
■ Password – Your CONTROL-M/EM password
■ Server – Host name of the computer that is running the CONTROL-M/EM GUI 

Server to which you will connect.

NOTE  
You can connect to only one CONTROL-M/EM GUI server at a time.

If you are logged on to a CONTROL-M/EM GUI server and you choose to change servers, 
the first server is automatically disconnected.
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2 Click Next to continue. 

Step 3: CONTROL-M window

In this window you select the CONTROL-M installation on which to run your jobs.

1 Select the CONTROL-M installation from the list.

The list includes all CONTROL-M configurations that have been defined in 
CONTROL-M/Desktop. 

2 If you want to add, modify, or delete a CONTROL-M definition, click the 
CONTROL-M Definitions button.

For more information on defining a CONTROL-M in CONTROL-M/Desktop, see 
Chapter 10, “CONTROL-M definitions and validity checks.”

3 Click Next to continue.



Step 4: Skeleton window

Chapter 9    Defining and scheduling jobs with the CONTROL-M Job Definition Wizard 229

Step 4: Skeleton window

In this window, you select the skeleton (job template). The skeleton determines the 
default values of the job.

Job skeletons are job parameter templates that are used as the basis from which job processing 
definitions are created. 

1 Select the skeleton from the drop-down list.

2 If you want to add, modify, or delete a skeleton definition, click on the Skeleton 
Editor button.

The Skeleton Editor form is displayed. For more information about job skeletons, 
see Chapter 4, “Creating and updating multiple jobs.”

Any changes to an existing skeleton are permanent and will affect the present job. 
The changes are not retroactive.

3 Click Next to continue.
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Step 5: Job Definition window

The Job Definition window (Step 5) enables specification of the minimum mandatory 
parameters for your job. Each job is added to a specified scheduling table. For more 
information on scheduling tables, see Chapter 7, “Managing scheduling tables.”

1 Specify the following information in the New Job section (all task types require the 
following parameters:

■ Job Name – Specify a job name or use Job(Counter). If you use Job(Counter), the 
job names will be Job0. Job1, Job2 ...

■ Tasktype – Of the job (task) to be performed by CONTROL-M.

■ Table Name – Name of the Scheduling table to which the job belongs. Together 
with parameter CONTROL-M, this determines the position of the job in the 
CONTROL-M/Scheduling Table hierarchy.

NOTE  
The displayed parameters change with the selected Task Type. For a complete description of 
parameters see the CONTROL-M Job Parameter and Variable Reference Guide. 
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For Unix, Microsoft Windows, iSeries (AS/400), and OpenVMS, the task types and 
required parameters are:

2 Click Add to add the job to the Scheduling table.

You can continue to define jobs. If you define jobs with different Table Names, the 
Upload Table window will display the Table Name of the last defined job.

3 In the Existing Jobs field, if you want to add, modify, or delete a job processing 
definition on the specified Scheduling Table, select the job name and click Job 
Details. The Job Editing form is displayed. For more information, see Chapter 3, 
“Working with the Job Editing form.”

4 Click Next to continue.

Table 72 Task Types for Unix, Microsoft Windows, iSeries (AS/400), and OpenVMS

Task Type Description and parameters

Command The only parameter is Command.

Job Normal job. Displayed parameters are:
■ File
■ Path

Detached The job does not run but does its preprocessing and post processing. 
Used to check job flow. Displayed parameters are:

■ File
■ Path

Dummy A normal job that submits the file specified in File Name to the 
operating system. 

Table 73 Task Types for MVS

Task Type Description and parameters

Job Normal job. Displayed parameters are:
■ Mem Name
■ Mem Lib
■ Table Lib

Started Task  Started task. Displayed parameters are:
■ Mem Name
■ Mem Lib
■ Table Library



Step 6: Write Table window

232 CONTROL-M/Desktop User Guide

Step 6: Write Table window

Write Table (Step 6) writes the scheduling table (with the new job) to the 
CONTROL-M/EM database. This is the last table specified in “Step 5: Job Definition 
window” on page 230.

1 Click Write to write the scheduling table to the CONTROL-M/EM database.

Depending on the setting of the Resolve job’s Author field conflict field in the 
General panel of the Options dialog box, you may be prompted for confirmation if 
there are conflicts between the Author fields of the newly edited job definitions in 
the Scheduling table and the currently logged in user in the CONTROL-M/EM 
database. For more information, see the Security chapter in the 
CONTROL-M/Enterprise Manager Administrator Guide, and the description of the 
General panel of the Options dialog box in Chapter 11, “Customization.”

2 To see all scheduling tables that can be written to the CONTROL-M/EM database, 
click the Draft Scheduling Tables button. For more information, see Chapter 7, 
“Managing scheduling tables.”

TIP  
If this scheduling table has the same name as an existing table, you will be prompted to 
confirm the Write operation and the existing table will be overwritten.
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If you have defined more than one Scheduling table and want to select which table 
to write or want to write more than one table at one time, you will have to open the 
Draft Table Manager to write these tables to the CONTROL-M/EM database. For 
more information, see Chapter 7, “Managing scheduling tables.” 

3 Click Next to continue.

Step 7: Upload Table window

The Upload Table window (Step 7) copies the Scheduling table uploaded to the 
CONTROL-M/EM database in “Step 6: Write Table window” on page 232, to the 
CONTROL-M/Server database for that table. 

1 Click Upload to copy the Scheduling table from the CONTROL-M/EM database to 
the CONTROL-M/Server database on the specified computer.

2 If the table cannot be uploaded, you can click Force Upload to upload the 
Scheduling table.

NOTE  
Uploading a table with same name as an existing table will fail unless the table that you are 
uploading has been modified to have content different from that of the table already in the 
database.
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3 Click Table Manager in the Scheduling Table Manager field if you want to 
perform various Scheduling table operations, including the following:

■ Check an existing Scheduling table
■ Modify an existing Scheduling table
■ Upload more than one Scheduling table
■ Delete an existing Scheduling table

For more information, see Chapter 7, “Managing scheduling tables.” 

4 Click Next to continue. 

Step 8: Order/Force window

The Order/Force window (Step 8) submits your job in the scheduling table to 
CONTROL-M.

1 Click Order to submit the job.

NOTE  
If the job data does not fall within existing scheduling parameters, the order will fail.
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2 Clicking Force will submit the job regardless of its scheduling criteria.

3 If you want to check or modify existing tables, click Table Manager in the 
Scheduling Table Manager field. For more information, see Chapter 7, “Managing 
scheduling tables.”

4 Click Next to continue. 

Step 9: Finish window

The Finish window (Step 9) completes the job processing definition. A summary is 
displayed in the Summary window.

1 To launch the CONTROL-M/EM GUI upon completion of the process, click the 
Launch CONTROL-M/EM GUI to view the production environment check box.

2 Click Finish.

The CONTROL-M Job Definition Wizard closes and the CONTROL-M/EM GUI is 
displayed with the All Jobs default ViewPoint loaded.

3 If you click Close, the CONTROL-M Job Definition Wizard closes without starting 
up CONTROL-M/EM.
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C h a p t e r 10
10  CONTROL-M definitions and validity 
checks

The following topics are described in this chapter:

■ CONTROL-M definitions
■ Validity checking

CONTROL-M definitions
CONTROL-M/Desktop identifies each job processing definition being edited or 
created with a specific CONTROL-M installation. The definition of the related 
CONTROL-M installation determines the format of the Job Editing form to be 
displayed and the required validity checks to be performed for the job processing 
definition.

CONTROL-M installations are defined to CONTROL-M/Desktop using the 
CONTROL-M window. Each CONTROL-M represents a single CONTROL-M on a 
specific platform.

When a scheduling table is downloaded, CONTROL-M/Desktop checks for the 
appropriate CONTROL-M name and associated platform in the existing 
CONTROL-M definitions. If no appropriate definition exists, a new one is created for 
this CONTROL-M installation. Additional fields describing the CONTROL-M 
installation may need to be updated in the CONTROL-M window.
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To define a CONTROL-M to CONTROL-M/Desktop:

1 Select Edit => CONTROL-M Definitions from the menu bar.

2 Click Add. The Add CONTROL-M Definition dialog box is displayed:

3 Fill in the fields of this dialog box as indicated in Table 74. 

NOTE  
Click a column heading to sort the window by that column.
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4 Click OK to add the CONTROL-M to CONTROL-M/Desktop.

5 Click OK to save the changes and close the window.

To modify an existing CONTROL-M definition:

1 Select Edit => CONTROL-M Definitions from the menu bar.

2 Select the CONTROL-M definition to be updated and click Update.

3 Modify the fields in the CONTROL-M window and click OK.

To delete a CONTROL-M from CONTROL-M/Desktop:

1 Select the CONTROL-M and click Remove. A confirmation window is displayed.

2 Indicate whether you want to Remove all jobs from this CONTROL-M in the 
current draft and click OK.

Table 74 Fields in the CONTROL-M dialog box

Field Description

Name Enter the name of the CONTROL-M. This name is used by 
CONTROL-M/Desktop only. It appears in the list for the CONTROL-M 
field in the Job Editing form. It is a required field for the Validity 
Checks function (described in “Validity checking” on page 240).

Platform Select the type of platform, such as OS/390, z/OS, 
UNIX/Windows/TANDEM, or iSeries (AS/400).

Version Version number of the CONTROL-M at the specified installation.

iSeries (AS/400): When defining an iSeries (AS/400) data center, select 
224 (or 225, if available).

Uppercase Only Indicates if all parameters in the Job Editing form for this CONTROL-M 
must be in uppercase. For most installations this option should not be 
selected.

Start Day of 
the Week

Indicates the first day of the week for use in the Week Days field in the 
Job Editing form.

Note: The day selected in this field is used to ensure that the display of 
calendars for this CONTROL-M are properly adjusted. However, this 
value is not passed back to the CONTROL-M installation. Use the 
ctmsys utility, to ensure that the start day of the week for the 
CONTROL-M installation is the same as the value specified in this field.

Installed Products For MVS platforms only:
Indicate which other CONTROL-M products are installed with 
CONTROL-M for OS/390 and z/OS: (CONTROL-M/Restart, 
CONTROL-M/Analyzer, or CONTROL-M/Tape).
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Validity checking
One of the advantages of CONTROL-M/Desktop is that it can work with job 
processing definitions independently of CONTROL-M. This allows you to create and 
update job processing parameters without having to undergo validity checks that 
occur in CONTROL-M/Enterprise Manager (CONTROL-M/EM). This means that 
you can work much faster, especially when creating multiple jobs using the Mass 
Create facility (described in Chapter 4, “Creating and updating multiple jobs”).

This section describes a CONTROL-M/Desktop facility that is used for checking 
validity of new and updated job processing definitions.

To check the validity of all jobs in a draft:

1 Open the draft.

2 Choose Tools => Validity Checks or click .

CONTROL-M/Desktop checks all parameters in all job processing definitions in 
the draft and displays the errors in a messages window.

Figure 71 Validity Checks Error Messages window

To correct the errors found during a validity check:

Use either of the following methods to correct errors found during a validity check:

NOTE  
This does not mean that job processing definitions should not be checked for validity before 
they are used in the production environment.
After job processing definitions are created or updated, they should be checked before they 
are written to the CONTROL-M/EM database.
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■ Double-click the Job Name in the Messages window to open the Job Editing form 
for the job. Make the necessary corrections and then click OK to save the changes 
to the job definition.

■ Choose Tools => Mass Update or click .

These actions start the Mass Update facility, and can be used to correct common 
errors in multiple jobs in the draft. For more information, see Chapter 4, “Creating 
and updating multiple jobs.”

Checking validity by default

CONTROL-M/Desktop can optionally validate all parameter values in the Job 
Editing form when each time it is used to open or create a job processing definition.

This option is set by checking the Always check the validity of jobs option in the 
General panel of the Options dialog box (Tools=>Options). For more information 
about this option, see Chapter 11, “Customization.”

NOTE  
This option should not be set when using the Mass Create or Mass Update facility.
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C h a p t e r 11
11  Customization

This chapter describes the various way in which CONTROL-M/Desktop can be 
customized for your site. This information includes: 

■ Setting feature defaults in the Options dialog box
■ Modifying the display of CONTROL-M/Desktop toolbars

Setting feature defaults using the Options 
dialog box

Several features in CONTROL-M/Desktop can be customized to suit site 
requirements and preferences. This customization is generally performed from the 
Options dialog box, which is displayed by selecting the Tools => Options menu 
option. 

This dialog box consists of two panes that are used to display any of several panels, 
each contain default settings pertaining to a particular feature. The left pane displays 
a tree that lists available panels, from which you can select a panel for display; the 
right pane displays the current panel.

Figure 72 shows the Options dialog box as it appears when first opened.
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Figure 72 Options dialog box

To display the appropriate panel to modify particular CONTROL-M/Desktop 
default settings, you must first select the appropriate tree branch. Table 75 describes 
the features whose default settings can be accessed from each tree branch.

NOTE  
Some branches have sub-branches, each of which displays a different panel.

Table 75 Default settings accessed by branches in the tree

Branch Description

General General defaults for the CONTROL-M/Desktop environment. 

Flowdiagram Default features for Flow Diagram view. This branch has 
sub-branches.

Diagnostics Troubleshooting settings for tracking technical problems with 
CONTROL-M/Desktop. Use this panel only when instructed by 
BMC Software Customer Support.

Confirmations Confirmation requests and warnings to display for various job, 
table and calendar actions.
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To modify any default setting

1 Open the Options dialog box by selecting Tools => Options in the menu.

2 Click the appropriate branch to display its panel of default settings. 

3 Change defaults as wanted, and click OK.

Available branches and corresponding panels

The rest of this section describes the features that can be modified, by branch and 
corresponding panel.

General panel

The General panel (Figure 73) contains several general settings for the 
CONTROL-M/Desktop environment. These settings are described in Table 76.

Figure 73 General panel
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Table 76 General panel (Part 1 of 2)

Area Field Description

Job Definition General settings that apply to job processing definitions.

 Always check the 
validity of jobs

Check this box to indicate that CONTROL-M/Desktop 
should automatically check the validity of parameter values 
as they are entered in the Job Editing form. 

Validity checks can also be performed on all jobs in a draft 
using the Tools => Validity Checks option. For more 
information, see “Validity checking” on page 240.

{Counter} The current value of the {Counter} variable used by the Mass 
Job Create and Mass Job Update facility. For more 
information, see “Job skeletons” on page 148 and “Updating 
multiple jobs and group scheduling tables” on page 158.

Default Start Day of 
the Week

Indicates the first day of the week for use in the Week Days 
field in the Job Editing form. This is the default value used 
for all data centers. A Start Day of the Week can also be 
specified for each CONTROL-M using the CONTROL-M 
Definition window. The value in the CONTROL-M definition 
window overrides the default value specified in the Options 
dialog box. 

Enable Undo /
 Undo Size

Check this box to enable actions performed in the Job Editing 
form to be undone or redone. 

If checked, select the number of levels of Undo/Redo that 
can be performed, in the Undo Size field. Default: 100.

For more information, see “Undo and Redo in the Job Editing 
form” on page 100.

Communication

Connection Mode Determines how CONTROL-M/Desktop should connect to 
CONTROL-M/EM. Select either of the following:

■ Automatic Connection. CONTROL-M/Desktop opens 
and closes the connection as communication as necessary 
depending on selected actions.

■ Manual Connection. CONTROL-M/Desktop maintains 
an open connection with the CONTROL-M/EM GUI 
Server until the user closes the connection.

For more information, see “Moving from definition to 
production: an overview” on page 23.
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Flowdiagram – General panel

The Flowdiagram General panel (Figure 74) contains general settings for the 
CONTROL-M Flow Diagram view. These settings are described in Table 77. For more 
information about the Flow Diagram, see “Understanding the Work Area, its views, 
and components” on page 48.

Figure 74 Flowdiagram – General panel

Security

Resolve job’s Author 
field conflict

Determines how to handle situations where the user 
performing a Write to CONTROL-M/EM does not match the 
name of the Author. Select either of the following:

■ Change Automatically — check this value if the author 
should automatically be reset without prompting the 
user for confirmation.

■ Prompt Before Changing — check this value to have 
CONTROL-M/EM prompt the user for confirmation 
before changing authorship. Default.

For more information, see the Security chapter in the 
CONTROL-M/Enterprise Manager Administrator Guide.

Table 76 General panel (Part 2 of 2)

Area Field Description
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Flowdiagram – Nodes panel

The Flowdiagram Nodes panel (Figure 75) contains node settings for the Flow 
Diagram view. These settings are described in Table 78. For more information about 
the Flow Diagram, see “Understanding the Work Area, its views, and components” 
on page 48.

Figure 75 Flowdiagram – Nodes panel

Table 77 Flowdiagram – General panel

Area Field Description

Graph Determines the orientation and positioning of job nodes in 
the Flow Diagram.

Graph Placement The combination box allows the user to specify Parent on the 
Left, Parent in the Middle, or Parent on the Right screen 
display options for the parent job in the Flow Diagram. The 
default is Parent in the Middle.

Maximize Downward 
Flow

Check mark indicates that the Flow Diagram is displayed as 
much as possible in vertical alignment rather than in 
horizontal alignment.

Minimize Graph 
Width

Check mark indicates that the Flow Diagram accommodates 
the available screen space provided.

Zoom Level

Start Zoom Level Determines the default percentage of magnification of nodes 
displayed in Flow Diagram view when viewing a new 
network.Valid values are 10 through 400.
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Table 78 Flowdiagram – Nodes panel

Area Field Description

Titles Determines the information to be displayed in Flow Diagram 
job nodes.

Node Title Select the information to be displayed in the title bar of the 
node. Default: MemName

Note: If JOB_NAME/MEMNAME is selected for:
■ MVS jobs —Mem Name is displayed
■ other jobs — Job Name is displayed

First Field Select the information to be displayed in the first field of the 
node body. Default: CONTROL-M Name

Second Field Select the information to be displayed in the second field of 
the node body. Default: CONTROL-M Name

Wrap field text in node Check this box if the text of fields in the job node should 
wrap to the next line. If not selected, the fields are truncated 
if necessary.

Display

Node shape Indicates the shape for nodes in the Flow Diagram. Select one 
of the following:

■ Rounded — displays nodes with rounded corners.
■ Rectangle — displays nodes with square corners.

Behavior

Double Click Action Indicates what function should be performed when a node is 
double-clicked in the Flow Diagram. 

Select either of the following.

■ Expand-item — Expand or Collapse function. Expands 
the selected node to display levels lower than the current 
selected node, or collapses the selected node to hide all 
lower levels.

Note: This option is not available when condition nodes 
are displayed.

■ StepInto-Item — Step In function. Changes the Flow 
Diagram to display nodes one level lower than the 
current selected node. For more information, see the 
description of Step In/Step Out in the 
CONTROL-M/Enterprise Manager User Guide.
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Flowdiagram – Links panel

The Flowdiagram Links panel (Figure 76) contains link settings for the CONTROL-M 
Flow Diagram view. These settings are described in Table 79. For more information 
about the Flow Diagram, see “Understanding the Work Area, its views, and 
components” on page 48.

Figure 76 Flowdiagram – Links panel

Table 79 Flowdiagram – Links panel

Area Field Description

Link Settings Determines the information to be displayed in Flow Diagram 
job nodes.

Display Condition 
nodes 

When selected, indicates that condition nodes should be 
displayed in the FlowDiagram.

Display 
Do-Conditions (as 
dotted links)

Check this box if conditions created using the Do Condition 
parameter should be displayed. The link is indicated with 
dotted lines.

Display Out 
Conditions with 
minus sign (as dotted 
links)

Check this box if Out Conditions that get deleted should be 
displayed. The link is indicated with dotted lines.

Display Optional In 
Condition as

Determines whether Optional In conditions (for example, 
two In conditions separated by an OR operator) will be 
displayed with solid or dotted lines.

Delete Dependency Indicates what action the Delete Dependency feature 
performs. For more information, see “Deleting 
dependencies” on page 84.

Delete only IN cond Deletes the In condition when Delete Dependency is 
selected from a condition line popup menu.

Delete IN, OUT conds Deletes both the In condition and the Out condition when 
Delete Dependency is selected from a condition line popup 
menu.

Ask what to delete Displays the Delete Dependency dialog box. Default.
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Flowdiagram – Colors panel

The Flowdiagram Colors panel (Figure 77) contains color settings for the 
CONTROL-M Flow Diagram view. These settings are described in Table 80. For more 
information about the Flow Diagram, see “Understanding the Work Area, its views, 
and components” on page 48.

Figure 77 Flowdiagram – Colors panel

Table 80 Flowdiagram – Colors panel

Area Field Description

Color Settings Determines the colors to be used for displaying the different 
elements of the Flow Diagram.

Background Color for the Flow Diagram background.

Group/Application Color for all high-level nodes in the hierarchy.

Connector Color for In/Out condition triangles.

Frames Color for frames of nodes in Flow Diagram view and in Net 
Overview.

Condition Nodes Color for condition nodes.

Dependency Color for links (unselected).

Selected Link Color for a link that has been selected.

Focused Item Color of the currently focused item.

Node Title Color for the node title.

First Field Color for the first field displayed in the node.

Second Field Color for the second field displayed in the node.
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Flowdiagram – Diagnostics panel

The Flowdiagram Diagnostics panel (Figure 78) helps troubleshoot technical 
problems with CONTROL-M/Desktop by printing diagnostics at the selected 
severity levels into a log file. The log file should then be sent to BMC Software 
Customer Support. The settings in the Diagnostic panel are described in Figure 78. 

Figure 78 Flowdiagram – Diagnostics panel

NOTE  
Use this panel only when instructed by BMC Software Customer Support. Your technical 
support representative will notify you which fields to change.

NOTE  
The changes to the settings take effect immediately, except for changes made to the Cyclic Log 
File field(s). Changes to Cyclic Log File field settings take affect the next time the specified 
CONTROL-M/Desktop application files are run.
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Flowdiagram – Confirmations panel

Table 81 Flowdiagram – Diagnostic panel fields (Part 1 of 2)

Area Field Description

Log File Name Full name and path of the log file to which diagnostics should 
be printed. For display purposes only.

General

Enable Diag When selected, diagnostics are printed to a log file. Default: 
Selected.

Use Minimum 
Diag Level

If this is selected, all diagnostics are printed to the log at the 
selected diagnostic level or higher, even if diagnostic levels 
specified in the Diagnostic Levels fields (see below) are lower 
than the value specified here. Values can be selected from the 
list, or entered manually (keyword or numeric code). Default: 1 
ERROR. Valid values are: 

0 SEVERE

1 ERROR

2 WARNING

3 (General)

4 INFO

5 DEBUG

6 FNC_ENTER

7 FNC_EXIT

Only severe issues (crashes).

Error messages (CORBA exceptions, 
errors that can cause the application to 
malfunction or crash at a later time). 
Default.

Warning messages (unexpected events 
that do not stop the application but 
may limit functionality.

General events. 

Information about the basic 
functionality of the application.

More detailed information including 
the steps of an event, parameters, etc.

Every entrance to a function/method.

Every exit from a function/method.

Cyclic Log File When checked, diagnostics are printed to a set of log files 
(instead of one). Default: Not checked.
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The Confirmations panel (Figure 79) determines which confirmation requests and 
warnings should be displayed for various job, table, and calendar actions. 

Number of Files The maximum number of files to which diagnostics are printed. 
Valid values: 1-300. Default: 1.

Number of 
Messages Per File

The maximum number of messages that can be written to each 
cyclic log file. Valid values: 200-10000. Default: 200.

If more diagnostics are generated than fit in the defined number 
of cyclic log files, CONTROL-M/Desktop writes over the 
existing log files, starting with the first in the set.

Changes to these fields take affect the next time the specified 
CONTROL-M/Desktop application files are run (not 
immediately).

Diagnostic Levels Individual diagnostic level settings for each file or context 
(procedure). See the Use Minimum Diag Level field for valid 
values.

Files tab Diagnostics are generated on a file basis, at the level specified 
next to each file name. 

Contexts tab Diagnostics are generated on a procedural basis, at the level 
specified next to each context (procedure). Procedures listed in 
the Contexts tab can span several files or sub-procedures. When 
you change the level of a procedure, CONTROL-M/Desktop 
automatically changes the level of any sub-procedures.

Save settings for next run If selected, the diagnostic settings are saved as a default for 
future CONTROL-M/Desktop sessions. Otherwise, the settings 
take effect for this CONTROL-M/Desktop session only.

Table 81 Flowdiagram – Diagnostic panel fields (Part 2 of 2)

Area Field Description
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Figure 79 Flowdiagram – Confirmations panel

Confirmation options are divided into the following sections:

■ Job Confirmations

Select or deselect the job actions for which you want a confirmation dialog box to 
display before CONTROL-M/Desktop performs the job action.

■  Table Confirmations

Select or deselect the actions for which you want a confirmation dialog box to 
display before CONTROL-M/Desktop performs the table action.

■ Calendar Confirmations

Select or deselect the actions for which you want a confirmation dialog box to 
display before CONTROL-M/Desktop performs the calendar action.

■ General Confirmations

To set confirmations

1 Select or deselect the general confirmations that you want displayed.

2 To reassign the originally provided default settings, click Restore Defaults.
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Viewing toolbars
The buttons in the CONTROL-M/Desktop window are arranged in several different 
toolbars that can be displayed or not displayed depending on your preference.

To modify the Toolbar display:

1 Choose Edit => Toolbars. 

The Toolbars dialog box (Figure 80) is displayed.

Figure 80 Toolbars dialog box

Table 82 Toolbar contents  (Part 1 of 2)

Toolbar Contents

General New, Open, Save, Copy, New Job, Delete Job, Copy Tags, and New 
Scheduling Group

Tree CONTROL-M Hierarchy, and Application Hierarchy.

Flowdiagram Flowdiagram Zoom, Zoom In, Zoom Out, Arrange All Items, Step In, 
and Step Out.

Communication Load, Write, Scheduling Table Manager, Edit Calendars, Connect, 
and Disconnect

Tools Current Skeleton list, Edit Skeleton, Edit Collection, Mass Job 
Creation, Mass Update, and Validity Check.

Wizard Starts the Wizard.
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2 Select the toolbars to be displayed. Table 82 describes the contents of each toolbar.

3 Click Close.

Mouse pointer 
modes

Definition mode, Selection mode

Selection First, Next, Previous, Last

Table 82 Toolbar contents  (Part 2 of 2)

Toolbar Contents
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A p p e n d i x A
A  CONTROL-M/Desktop menus

This appendix provides a comprehensive listing of all options available from the 
CONTROL-M/Desktop menu bar.

All CONTROL-M/Desktop options can be chosen from the toolbar. The menu 
options are described in the following tables. 

Table 83 CONTROL-M/Desktop File Menu options

Options Description

New Creates a new draft.

Open Opens an existing draft.

Close Closes the current draft.

Save Saves the current draft.

Save As Saves the current draft with a file name that you specify.

Load jobs from 
CONTROL-M/EM

Loads jobs from CONTROL-M/EM into the current draft in either 
online or local load mode.

<Recent File> Lists shortcuts to drafts recently edited.

Print Prints the current draft.

Print Preview Displays a preview of the current draft.

Exit Closes CONTROL-M/Desktop.
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Table 84 CONTROL-M/Desktop Edit Menu options

Option Description

CONTROL-M 
definitions

Opens the CONTROL-M definitions window, from which you can 
register the CONTROL-M installations in your network.

Job Submenu containing the options for managing jobs.

New Creates a job using the current skeleton.

Delete Deletes the selected job.

Copy Creates a copy of the selected job.

Edit and Copy Displays the Job Editing form for you to 
edit, and then creates a copy of the selected 
job as edited.

Edit Displays the Job Editing form for you to edit 
the selected job. 

Browse Allows you to browse to a different job.

Scheduling Group Submenu containing the options for managing group scheduling 
tables.

New Creates a new group scheduling table

Delete Deletes the selected group scheduling table

Edit Opens the Group Editing form.

Copy Tag Creates a copy of the selected Schedule tag.

Browse Allows you to browse to a different job in 
the group.

Find/Select Jobs Opens the Find a Job dialog box. Use the Find a Job dialog box to 
locate one or more jobs in the current draft.

Scheduling Tables Submenu containing the options for managing and writing 
scheduling tables.

Scheduling Table 
Manager

Opens the Scheduling Table Manager, from 
which you can create, delete, and manage 
the contents of scheduling tables in the 
CONTROL-M/EM database and the 
CONTROL-M/Server database.

Write to 
CONTROL-M/EM

Exports scheduling tables from the current 
draft to the CONTROL-M/EM database.

Note: You can export new scheduling tables 
when the target CONTROL-M is active or 
unavailable.

Calendars Manager Opens the Calendar Manager window.
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Table 85 CONTROL-M/Desktop View Menu options 

Option Description

Flowdiagram Displays the Flow Diagram in the Draft window.

List/Job Editing 
Form

Displays the List view in the Draft window.

Hierarchy Changes the order of displayed information between Application => 
Group => Job and Data Center => Scheduling table => Job.

Name Arranges the nodes in the Draft window according to name.

Big Icon Displays large nodes.

Partial Details Displays information about each displayed node.

Toggle Selection Displays the following suboptions for navigating through selected 
nodes, making the target node the focus:

First Jumps to the first selected node.

Next Jumps to the next selected node.

Previous Jumps to the previous selected node.

Last Jumps to the last selected node.

Select All Selects all displayed nodes in the Draft window.

Validity Checks 
Error Messages

Displays the Validity Checks Error Messages window, from which 
you can trouble shoot problems with your job and table definitions.

Table Action Report Displays the Table Actions Report window. This window can be 
hidden when it is waiting for pending information.

Calendar Action 
Report

Displays the Calendar Actions Report window. This window can be 
hidden when it is waiting for pending information.

Toolbars Displays the Toolbars dialog box, from which you can select which 
toolbars to display.

Status Bar Displays/ hides the Status Bar.

Table 86 CONTROL-M/Desktop Tools Menu options  (Part 1 of 2)

Option Description

Mass Create Displays the Mass Create dialog box, from which multiple jobs, based 
on the same skeleton (template), are created.

Mass Update Displays the Mass Update dialog box, from which modifications can 
be applied to multiple jobs.

Validity Checks Performs validity checks on the jobs in the current draft. The results 
are displayed in the Validity Checks Error Messages window.

Skeleton Displays the Skeleton Editor window, from which you can create and 
modify job skeletons (templates).

Collection Displays the Collection window, from which you can modify the 
contents of the current collection.

Neighborhood Opens the Neighborhood dialog box, which you can use to identify 
jobs according to their dependent relationships.
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Import Application 
Forms

Imports a Job Editing form panel for the Job Editing form. Using this 
panel, you can create jobs for supported external applications (such as 
SAP and Microsoft Windows 2000). 

Import the forms once on each CONTROL-M/Desktop installation in 
your network from which you want to create jobs to run on the 
specific application.

Change Password Enables you to change your password.

Options Displays the Options dialog box.

Table 87 CONTROL-M/Desktop Communication Menu options

Option Description

Connection Properties Displays the current connection properties.

Connect to GUI Server Establishes communication with the GUI Server.

Disconnect from GUI Server Ends communication with the GUI Server.

Connect with Different 
Properties

Enables you to change your connection properties and 
reconnect to a GUI Server.

Table 88 CONTROL-M/Desktop Window Menu options

Option Description

New Window Opens a new window.

Cascade Cascades all open windows.

Tiles Tiles all open windows.

Arrange Icons Arranges icons in the CONTROL-M/Desktop window.

Split Resizes the Flow Diagram and Net Overview by moving the 
split between them.

<List of Windows> Lists currently open windows.

Table 89 CONTROL-M/Desktop Help Menu options

Option Description

Wizard Starts the CONTROL-M Job Definition Wizard.

Tutorial Displays the CONTROL-M/Enterprise Manager tutorial. this 
tutorial explains the steps necessary for getting started with 
CONTROL-M/Desktop.

Help Index Displays CONTROL-M/Desktop Help.

About 
CONTROL-M/Desktop

Displays identifying information about your version of 
CONTROL-M/Desktop.

Table 86 CONTROL-M/Desktop Tools Menu options  (Part 2 of 2)

Option Description
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A p p e n d i x B
B  Managing logon connections to CONTROL-M/EM

This appendix provides a comprehensive listing of all options available from the 
CONTROL-M/Desktop menu bar.

Logging on to CONTROL-M/EM
Each time you upload or download scheduling tables or calendars, you use a 
communication channel with CONTROL-M/EM. You can maintain an open 
connection all the time, initiate communication each time data is transferred, or close 
the connection following the transfer.

When you log on to CONTROL-M/EM, you are prompted for your user name, 
password and the name of the GUI Server to which you are connecting. These 
settings remain in effect until you close CONTROL-M/Desktop or you establish a 
connection with different properties. 

The following connection modes are available:

■ Automatic connection
CONTROL-M/Desktop manages your connection with the GUI Server. Every time 
you perform an action requiring communication with the GUI Server (such as 
uploading a scheduling table), CONTROL-M/Desktop establishes a connection 
with the GUI Server you specified when you logged on. When the action is 
complete (for example, the table is finished uploading), the connection is 
terminated by CONTROL-M/Desktop. For more information, see 
“Communication” on page 246.

TIP  
To learn how to establish a connection with different properties, see “Connecting with 
different connection properties” on page 266. 
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■ Manual connection
You manage your connection with the GUI Server. If an action requiring 
communication is requested, and no connection is active, you are informed that the 
requested action requires a connection. Once a connection is established, it remains 
on until you log off of CONTROL-M/Desktop or terminate the connection 
manually. You can manually reestablish a terminated connection. For more 
information, see “Manual communication management” on page 265.

To choose a communication mode:

1 Choose Tools => Options. The General panel of the Options dialog box is 
displayed.

2 Select the required connection mode.

3 Click OK.

To log on to CONTROL-M/EM:

1 Click , or select Communication => Connect to GUI Server. The 
CONTROL-M/Enterprise Manager logon dialog box is displayed.

2 Specify your user name and password.

3 The name of the last accessed CONTROL-M/EM GUI Server is automatically 
displayed in the Server list box. The list contains all GUI Servers registered with the 
current CORBA Naming Service. Select the GUI Server you want.
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4 Click Login. Communication is established.

Manual communication management
A connection is established only after you specifically request it. This connection 
remains up until you either click  or until you choose Communication => 
Disconnect from GUI Server.

As long as the connection remains, you can freely upload and download scheduling 
tables and Calendars without having to reestablish communication. This enables you 
to perform multiple actions that require communication with CONTROL-M/EM 
without having to reconnect to the GUI Server for each action.

If you request an action that requires a connection, and communication is not 
currently established with the GUI Server, you are informed of the situation. 
Establish a connection and then retry the request.

The Connect  and Disconnect  functions are available only when the Manual 
Connection mode is chosen in the General panel of the Options dialog box.

NOTE  
The first time a user connects, the default GUI Server specified during installation is 
displayed. To change the GUI Server, see page 266.

NOTE  
Usually the connection with CONTROL-M/EM is broken when you close the Scheduling 
Table Manager window. To establish a connection that remains open until you close it 
manually, use the Connect feature described in “Manual communication management.”.

TIP  
You can obtain information about the current connection status at any time using the 
Connection Properties feature described in “Displaying connection properties” on page 268.



Disconnecting from CONTROL-M/EM

266 CONTROL-M/Desktop User Guide

Disconnecting from CONTROL-M/EM

To disconnect from CONTROL-M/EM:

1 Click . The Disconnect icon is replaced by . The connection is broken.

-or-

Choose Communication => Disconnect from GUI Server. 

Connecting with different connection 
properties

After you start CONTROL-M/Desktop, it is not necessary to close and restart 
CONTROL-M/Desktop to log on to a different GUI Server or to log on as a different 
user. 

Instead, you can establish communication with properties different from those with 
which you initially logged on using Connect with Different Properties.

To log on to a different GUI Server, you must make some additional changes to the 
communication properties. These changes are described in the following procedure. 

To log on to a different GUI Server

1 Click , or choose Communication => Connect with Different Properties. The 
Communication Login dialog box displayed.

2 Enter your user name and your password.

3 Select a different GUI Server from the Server drop-down list box.

4 To log on to a GUI Server that is registered with a different Naming Service, 
perform the steps described on page 267.

5 Click Login. Communication is established with the new GUI Server.
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To log on to a GUI Server with a different Naming Service

To log on to a GUI Server registered with a different Naming Service, change the 
logon properties as described in the following procedure. This procedure displays a 
different list of GUI Servers in the Server list box in the Communication Login dialog 
box.

1 In the Communication Login dialog box, click Advanced. The Communication 
Login dialog box is redisplayed with additional controls:

2 Enter the name of the CORBA Naming Service host computer in the Host Name 
text box.

3 Enter the port number on the CORBA Naming Service host computer in the Port 
Number text box.

NOTE  
If the IP address of the computer running CORBA services has changed, the CORBA Naming 
Service fails to start up the next time CORBA is activated. The CORBA server must be 
reconfigured as described in the “CORBA Configuration” chapter of the 
CONTROL-M/Enterprise Manager Administrator Guide.
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4 Click Apply Settings. The following occurs:

■ The bottom portion of the window is hidden.
■ Login becomes available.
■ The list of all GUI Servers registered with the CORBA Naming Service is 

updated and becomes available from the Server list box.

5 Click Login. Communication is established using the new properties.

Displaying connection properties
The Connection Properties window displays the name of the user who is currently 
connected and the name of the server to which that user is connected.

To display connection properties:

1 Choose Communication => Connection Properties or click . The Connection 
Properties dialog box is displayed.

Figure 81 Connection Properties dialog box

2 Click OK to close the dialog box.

NOTE  
Click Restore Default Settings to enter the CORBA host name and port values that were 
specified when CONTROL-M/Desktop was installed.
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Changing your password
After connecting to the CONTROL-M/EM GUI Server, you can change your 
password.

To change your password:

1 Choose Tools => Change Password. The Change Password dialog box is 
displayed.

Figure 82 Change Password dialog box

2 Enter your current password in the Current Password field.

3 Enter your new password in the New Password field. (Your keystrokes appear as 
asterisks as you type them.)

4 Re-enter your new password in the Verify Password field. (Your keystrokes 
appear as asterisks as you type them.)

5 Click OK to confirm your new password.

6 Log off all CONTROL-M/EM components for the change to take effect.

NOTE  
The Change Password option is available only if your administrator has set the 
UserChangePassword system parameter to 1.
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Index
- sign

EXECTIME parameter (group) 184
EXECTIME parameter (job) 138

- symbol
condition format 156
Mass Update form 161
skeleton editor value 155

Symbols
-% sign

EXECTIME parameter (group) 184
EXECTIME parameter (job) 138

+ sign
EXECTIME parameter (group) 184
EXECTIME parameter (job) 138

+ symbol
condition format 156
Mass Update form 161
skeleton editor value 155

+% sign
EXECTIME parameter (group) 184
EXECTIME parameter (job) 138

< sign
EXECTIME parameter (group) 184
EXECTIME parameter (job) 138

< symbol
Mass Update form 160

= symbol
Mass Update form 160

> sign
EXECTIME parameter (group) 184
EXECTIME parameter (job) 138

> symbol
Mass Update form 160

A
action statements. See Do statements
actions

undoing and redoing 100
Add matching jobs ...

Collection criteria 194
adding

CONTROL-M definitions 238, 239
In conditions in mass update 163

jobs to a collection 194
Schedule tags 140

Adjust Condition parameter
Group Editing form 170

Always check the validity...
Options dialog box 246

and parameter
Group Editing form 174

and/or options
conditions panel 116

and/or parameter
job editing form 106

Application
icon in tree view 47

Application hierarchy
description 25, 46

Application parameter
Group Editing form 170
Job Editing form 102
Job Editing form (z/OS) 104
moving a job 75

application support
import application forms 262

Application Type field
Skeleton Editor form 149

applications. See ERP
Apply button

skeleton Editor 154
Arg field

DO CTBrule parameter 134
Arrange All function

flow diagram 62
AS/400. See iSeries (AS/400)
Ask what to delete

Options dialog box 250
Author Change

Options dialog box 247
Author parameter

Job Editing form 102
AutoArchive field

Sysout handling 139
AutoEdit variables

for jobs in a group 181
in Job Editing form 121
Set panel (groups) 181

Automatic Connection option
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Options dialog box 246

B
Background

Options dialog box 251
basic scheduling parameters

Job Editing form 105
Best Fit option 38
BMC Software, contacting 2
Boolean. See and/or
Branch Menus 71
browsing jobs 74
buttons

in toolbars 256
Schedule Tags panel 172
Scheduling Tables window 198
shout statements 137, 183
step codes 130
step range definition 129

C
Calendar Definition window 218
Calendar Manager

commands 217
definition window 218
description 215
fields 216
window 215

calendars
adding a description 221
Calendar Definition window 218
Calendar Manager 215
Calendars window 215
confcal parameter 107, 175
dates and colors 224
Days Calendar parameter 214
defining 221
deleting 217
description 213
downloading 217
general criteria 223
month days 106, 174
periodic 214
regular 214
relative 214
selecting a month 222
selecting a week 222
unlocking 217
updating 219
uploading 217
weekdays 107, 174, 214
years 221

Calendars column

Calendars window 216
Category parameter

Job Editing form 114
change

password 269
cleanup. See maintenance
clearing, skeleton fields 150
closing. See exiting
codes

step codes 130
sysout options 127, 134

Codes parameter
Job Editing form 131

collapsing. See stepping out
Collection option

job menu 191
Mass Update form 159

Collections
applying criteria 194
defining criteria 192
description 191

colors
calendars 224

Colors panel
Options dialog box 251

columns
Scheduling Tables window 198

Command parameter
Job Editing form 103
Wizard 231

Command tasktype
Job Editing form 102

communication
with CONTROL-M/EM 263

Communication toolbar 256
components

CONTROL-M/Desktop 18
Condition Format field

creating conditions in flow diagram 82
Conditions

Options dialog box 251
conditions

See also prerequisite conditions
creating in flow diagram 81
delete options 86
deleting 84
identifying dependent jobs 69
Job Editing form 115

Conditions panel
Group Editing form 176
Job Editing form 115

Confcal parameter
detailed description 109
Group Editing form 175
Job Editing form 107

Confirm parameter
Group Editing form 170



Index 273

A   B   C   D   E   F   G   H   I   J   K   L   M   N   O   P   Q   R   S   T   U   V   W   X   Y   Z

Job Editing form 112
confirmation settings 255
Confirmations panel

Options dialog box 254
Connect panel

Wizard 227
connection

automatic communication mode 263
changing GUI Servers 266
changing login properties 266
choosing a connection mode 264
Connection Mode (Options) 246
manual communication mode 264
to CONTROL-M/EM 263

Connector
Options dialog box 251

Contexts tab
Options dialog box 254

Control resources
Job Editing form 117

CONTROL-B
invoking a rule 134
with CONTROL-M 239

CONTROL-D
Category parameter 114

CONTROL-M
definitions window 238
field in Scheduling Table details 200
field in Scheduling Tables window 197
hierarchy 46
icon in tree view 46
in Calendars window 216
in Job Editing form 102
in Scheduling Tables window 198
parameter (moving a job) 75
parameter in Group Editing form 170
z/OS job parameter 104

CONTROL-M panel
Wizard 228

CONTROL-M/Desktop
components 18
customizing 243
description 17
feature list 17
installation 17
toolbars 256
window forms 43

CONTROL-M/Desktop window
customization 243

CONTROL-M/EM
logging in to different GUI Server 267
server name 264

CONTROL-M/EM menus
Communication menu 262
descriptions 259
Edit menu 260
File menu 259

Tools menu 261
View menu 261

CONTROL-M/EM server
changing 266

CONTROL-M/Server utilities
scheduling 142

CONTROL-R
with CONTROL-M 239

CONTROL-T
with CONTROL-M 239

Copy button
Calendars window 217

copying
calendars 217
jobs in flow diagram 76
Scheduling tables 199

correcting
job definition errors 241

Counter function
skeleton editor 155

creating
See also defining
conditions in a flow diagram 82
Drafts 54
Group Scheduling table 88
job dependencies 81
multiple jobs 145
new jobs 80
Scheduling tables 200
skeletons 149

Critical parameter
Job Editing form 113

customer support 3
customizing

CONTROL-M/Desktop 243
CONTROL-M/Desktop window 243
toolbars 256

Cyclic
Log file

Options dialog box 253
Cyclic parameter

Job Editing form 113

D
datacenter definition. See CONTROL-M definition
date reference

In conditions (groups) 177
In conditions (jobs) 116

Dates parameter
Group Editing form 175
Job Editing form 107

days
weekdays parameter 174

Days Offset subparameter 114, 171
default setting
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modification options 244
default settings 243

modifying 243
restoring 255

Default Start Day of the Week field
Options dialog box 246

defaults
start zoom 248

defining
See also creating
group conditions 177
job conditions 116
Schedule tags 173
services 23
step codes 130
step range 128
variables for a job 121

defining jobs
Wizard 225

Definition mode
choosing 63
description 62

Delete button
Calendars window 217
Scheduling Tables window 198

delete dependency
configuring 86
description 84

Delete IN, OUT conds
Options dialog box 250

Delete only IN cond
Options dialog box 250

deleting
calendars 217
CONTROL-M definitions 239
data from In conditions 164
Group Scheduling table 89
in the skeleton editor 154
job dependencies 84
jobs in flow diagram 79
jobs in List view 78
jobs in Tree view 78
Schedule tags 141
Scheduling tables 198
skeletons 150
step ranges 129

dependencies
See also In conditions
See also job dependencies
See also Out conditions
condition nodes 87
creating 81
in Flow Diagram view 53
job skeletons 155
viewing 83

Dependency
Options dialog box 251

Description parameter
calendars 221
Group Editing form 171
Job Editing form 103
Job Editing form (z/OS) 104

Detached parameter
Wizard 231

Detached task type
Job Editing form 102

Diagnostic Levels
Options dialog box 254

Diagnostics
Levels 254

Diagnostics panel
Options dialog box 252

Disconnect from GUI Server option
Edit menu 266

disconnecting
from CONTROL-M/EM 263

Display 83
Display condition nodes

Options dialog box 250
Display Do-Conditions

Options dialog box 250
Display Optional In Condition

Options dialog box 250
Display Out Conditions

Options dialog box 250
displaying

See also viewing
condition nodes 87, 88
list of Scheduling tables 197, 206
prerequisite conditions 250

Do AutoEdit parameter
Group Editing form 187
Job Editing form 126

Do Condition parameter
Group Editing form 188
Job Editing form 135

Do Conditions
displaying in flow diagram 83

Do CTBRule parameter
Job Editing form 134

Do Force-job parameter
Group Editing form 187
Job Editing form 126, 133

Do Ifrerun parameter
Job Editing form 135

Do NOTOK parameter
Group Editing form 187
Job Editing form 125, 132

Do OK parameter
Group Editing form 187
Job Editing form 125, 132

Do Rerun parameter
Job Editing form 125, 132

Do Set-Var parameter
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Group Editing form 187
Job Editing form 126, 133

Do Shout parameter
Group Editing form 187
Job Editing form 126, 133

Do statements
Group Editing form 186
in Job Editing form 125, 132

DO Stop Cyclic parameter
Job Editing form 132

Do Sysout parameter
Job Editing form 127, 134

Doc Lib parameter
Job Editing form 102
Job Editing form (z/OS) 104

Doc Mem parameter
Group Editing form 171
Job Editing form 102
Job Editing form (z/OS) 104

documentation
Doc Lib parameter 102
Doc Mem parameter 102

double-click action
Options dialog box 249

Download button
Calendars window 217
Scheduling Tables window 199

downloading
calendars 217
Scheduling tables 199

drafts
creating 54
filtering 191
opening 54
option in Mass Update form 159
selecting 54
viewing 24
window description 44
working with 43

Due Out parameter
Group Editing form 171
Job Editing form 114

Dummy parameter
Wizard 231

Dummy task type
Job Editing form 102

E
Edit Collection button 191
Edit Skeletons field

Mass Create form 147
editing

jobs in flow diagram 80
skeletons 148

Emergency parameter

Job Editing form 113
Enable Diag

Options dialog box 253
Enterprise Resource Planning. See ERP
equal sign (=)

Mass Update form 160
ERP

Application Type field 149
Job Editing form 104

errors
validity checking 241

examples
collection criteria 193
mass job creation 147

EXECTIME
Shout When parameter (groups) 184
Shout When parameter (job) 138

EXECTIME parameter (group)
- sign 184
-% sign 184
+ sign 184
+% sign 184
< sign 184
> sign 184
SHOUT statement 184

EXECTIME parameter (job)
- sign 138
-% sign 138
+ sign 138
+% sign 138
< sign 138
> sign 138
SHOUT statement 138

Execution panel
description 112

exiting
Group Editing form 188
Job Editing form 141

expanding. See stepping in
Expand-item field

Options dialog box 249
Export to File option 39
extended shift

in Job Editing form 110
Shift Num parameter 107

F
features

CONTROL-M/Desktop 17
Field Chooser option 37
Field column

Collection Criteria dialog box 192
Mass Update form 160
skeleton editor 153

File Name parameter
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See also memname
in Job Editing form 101

Files tab
Options dialog box 254

Filter checkbox
Scheduling Tables window 197

filtering
Drafts 191
Scheduling Tables window 197, 205

Find keyword
Mass update conditions 163

Find/Highlight window 68
Finish panel

Wizard 235
First Field

Options dialog box 249, 251
Flow Diagram

start zoom magnification 248
Flow diagram

description 45
flow diagram

arranging the display 62
copying jobs 76
creating conditions 81
creating Group Scheduling tables 88
creating job dependencies 81
deleting Group Scheduling tables 89
deleting jobs 79
description 27, 45
displaying condition nodes 250
Do Condition statements 83
editing jobs 80
expanding/collapsing entries 64
Options dialog box 247
selecting nodes 69
stepping in/out 65
viewing job dependencies 83
working in 51
zooming in/out 67

Flowdiagram toolbar 256
Focused Item

Options dialog box 251
focusing. See zooming
Force button

Scheduling Tables window 199
Force Delete button

Calendars window 217
Scheduling Tables window 198

Force Upload button
Calendars window 217
Scheduling Tables window 199

Forces 199
forcing

jobs in Group Editing form 187
Scheduling tables 195, 199

format
conditions in a flow diagram 82

conditions in skeletons 155
Frames

Options dialog box 251
From

column in Mass Update form 160
job submission time 114
parameter in Group Editing form 171
step range definition 129

From Class field
Sysout handling 139

functions
for Condition format 156
for values in Mass Update form 161
for values in skeleton editor 155

G
General panel

description 101
ERP jobs 104
Group Editing form 169
Options dialog box 245
z/OS platforms 103

General toolbar 256
Graph Placement

Options dialog box 248
Group Editing form

Conditions panel 176
description 167
exiting 188
General panel 169
panel descriptions 169
Postproc panel 185
Set panel 181

Group parameter
Group Editing form 170
Job Editing form 102
Job Editing form (z/OS) 104
moving a job 75

Group Scheduling table
modifying with the Jobs List window 207

group scheduling tables
creating in flow diagram 88
deleting in flow diagram 89
Group editing form 167
icon in tree view 46
On statements 186
Schedule tags 140, 172

Group Tag list
Job Editing form 140

Group/Application
Options dialog box 251

GROUP-END parameter
Group Editing form 186

groups
See also node ID
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icon in tree view 47
GUI Server

changing during login 267

H
hierarchies

Tree view sort order 46

I
icons

Application hierarchy 47
CONTROL-M hierarchy 46

Ignore Job value
Shift parameter 107

Import Forms option 262
importing

Scheduling tables 55
In conditions

See also prerequisite conditions
Group Editing form 176
in flow diagram 53, 81
job skeletons 155

in conditions
deleting 84

In keyword
Mass Update form 160

Installed Products fields
CONTROL-M definition 239

installing CONTROL-M/Desktop 17
Interval parameter

Job Editing form 113
Introduction panel

Wizard 226
IOABLCAL utility

with relative calendars 214
Item Count option 37

J
Japanese 33
JEF Undo field

Options dialog box 246
job

modifying with the Jobs List window 207
Job Definition panel

Wizard 230
Job Definition Wizard 225
job dependency

creating 81, 83
Job Editing form

accessing from Flow Diagram view 80
Conditions panel 115
description 97

ERP jobs 104
exiting 141
from Flow Diagram view 80
General panel 101
General panel (OS/390) 103
new jobs 80
opening 80
PostProc panel 135
Resources panel 117
Scheduling panel 105
Set panel 121
step range 128
Steps panel 123
Steps panel (MVS) 128
Tag Selection panel 140

job list
filter fields 206

job name
display in job nodes 249
in Job Editing form 101

Job Name parameter
Wizard 230

Job parameter
Wizard 231

job parameters
See also specific parameter name

job processing definitions
Job Editing form 28, 97
modifying 80

Job Tag list
Job Editing form 140

Job task type
Job Editing form 102

jobs
copying in flow diagram 76
creating 80
creating multiple jobs 145
deleting 78
deleting in flow diagram 79
deleting in List view 78
dependencies, in Flow Diagram 53
editing in flow diagram 80
filtering for a collection 194
icon in tree view 46
mass update 158
moving 75
path name in Job Editing form 101
skeletons (description) 30
skeletons (implementation) 148
submission time 114

Jobs List window
description 204
displaying Group Scheduling tables 204
displaying jobs 204
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L
languages

Japanese 33
Last Update column 37
Last Upload column

Calendars window 216
Last Upload field

Scheduling Table details 198
Late Sub value

Shout When parameter (groups) 184
Shout When parameter (jobs) 137

Late Time value
Shout When parameter (groups) 184
Shout When parameter (jobs) 137

Lib parameter
Group Editing form 170

libraries
in Job Editing form 101, 103
in Scheduling Table details 201
in Scheduling Tables window 198
See also doclib

life cycle for a service 23
Like value

Mass Update form 160
Links panel

Options dialog box 250
list display

adding fields 37
List view

deleting jobs 78
description 48
editing jobs 48

Load/Write facility
description 20

loading
jobs from CONTROL-M/EM 20
Scheduling tables 55

Local Delete button
Calendars window 217
Scheduling Tables window 198

location. See moving
Locked by column

Calendars window 216
Scheduling Tables window 198

locking
Scheduling tables 22, 200

Log
Cyclic

Options dialog box 253
Log Filename

Options dialog box 253

M
magnification

start zoom default 248
Manual Connection option

Options dialog box 246
Mass Create option, Tools menu 146
mass job creation

description 145
Mass Create form 146

mass job updating
Mass Update form 160
tools menu 159

MAX DAYS parameter
Sysout handling 139

Max Run 139
Max Wait parameter

Group Editing form 175
Job Editing form 113

Maximize Downward Flow
Options dialog box 248

Maxwait parameter
Group Editing form 170

Mem Lib parameter
Job Editing form (z/OS) 103

Mem Name
Group Editing form 170
Job Editing form (MVS) 103

Member parameter
Job Editing form 113

messages
See also shout messages
shout statements 136, 183

Minimize Graph Width
Options dialog box 248

Minimum debug level
Options dialog box 253

minus sign
condition format 156
Mass Update form 161
skeleton editor value 155
Tree view 46

modes
local 18
online 18

Modified checkbox
Scheduling Tables window 198

Modified column
Calendars window 216
Scheduling Tables window 198

modifying
See also creating
See also editing
See also updating
CONTROL-M definitions 239
group Scheduling tables from the Jobs List window 

207
job processing definitions 80
jobs from the Jobs List window 207
Schedule tags 173
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skeletons 150
modifying default settings 245
modifying toolbar displays 256
Month Days Calendar parameter

Group Editing form 174
Job Editing form 106

Month Days parameter
Group Editing form 174
Job Editing form 108

months
selecting in a calendar 222

Months parameter
Group Editing form 174
Job Editing form 107

mouse pointer modes
enable Definition mode 257
enable Selection mode 257

moving
in the skeleton editor 154
jobs in Tree view 75

MVS
postprocessing 128

MVS. See OS/390

N
Name field

CONTROL-M definition 239
Scheduling Table details 200
step range definition 129

Name parameter
Group Editing form 170

names
file name in Job Editing form 101
job name in Job Editing form 101
step ranges (z/OS) 129

Navigation tree 44
selecting nodes 63

Neighborhood
identifying dependencies 69
selecting nodes 69

Net Overview 45
description 27
working with 47

Network
searching 68

New button
Calendars window 217
Scheduling Tables window 198

New Job button 80
Next Day value

Shift parameter 107
No Confcal value

Shift parameter 107
Node ID

Job Editing form 114

Node Shape
Options dialog box 249

Node Title
Options dialog box 251

node title
Options dialog box 249

nodes
condition nodes 87
locating 68
selecting 69, 72
selecting in Navigation tree 63
selecting using Select All 72

Nodes panel
Options dialog box 248

Not In keywords
Mass Update form 160

NOTOK value
Shout When parameter 137
Shout When parameter (groups) 184

Number of Files
Options dialog box 254

Number of jobs to create
Mass Create form 147

Number of messages per file
Options dialog box 254

O
OK value

Shout When parameter 137
Shout When parameter (groups) 184

On statements
Group Editing form 186
in Job Editing form 124
in Job Editing form (z/OS) 131

online mode
description 18

opening
Drafts 54
Group Editing form 167
Job Editing form 80

OpenVMS
Detached task type 102

operating systems
CONTROL-M/Desktop 17

Operation list box
Mass Updating conditions 164

operators
Collection Criteria dialog box 192
Mass Update form 160

Options dialog box 243
Or parameter

Group Editing form 174
or. See and/or
Oracle Applications

Application Type field 149
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job parameters 104
Order button

Scheduling Tables window 199
Order/Force panel

Wizard 234
ordering

Scheduling tables 195, 199
Orders 199
OS/390

other INCONTROL products 239
Out conditions

Flow Diagram view 81
Group Editing form 176
in Flow Diagram 53
job skeletons 155
mass updating 165

out conditions
deleting 84

output
Sysout handling 139

Over Lib parameter
Job Editing form 101
Job Editing form (z/OS) 103

overview. See Net Overview
Owner parameter

Group Editing form 170
Job Editing form 101
Job Editing form (z/OS) 104

P
parameters

shout statements 137, 184
Parentheses field

condition format (skeletons) 158
Mass Updating conditions 162

password
change 269

Path parameter
See also memlib
Job Editing form 101

pattern-matching strings 39
periodic calendars

dates and colors 224
defining criteria 222
description 214

PGMST parameter
Job Editing form 131

Platform column
Scheduling Tables window 198

Platform field
CONTROL-M definition 239

plus sign
condition format 156
Mass Update form 161
skeleton editor value 155

PostProc panel
Group Editing form 185
Job Editing form 135

postprocessing
Do statements 125, 132
Job Editing form 135
MVS jobs 128
On statements 124, 131

prerequisite conditions
Adjust Condition parameter 170
creating via Flow Diagram view 82
displaying 250
format in skeletons 155
formatting functions 156
Group Editing form 176
identifying dependent jobs 69
Job Editing form 115, 135
job skeletons 155
listing via Flow Diagram view 83
Mass Update form 161
modifying 83
nodes in a flow diagram 87

prerequisites
deleting conditions 84

Prev Day value
Shift parameter 107

Prevent-NCT2 parameter
Job Editing form 112

preview
printing a flow diagram 90

Print option 39
printing

preview 90
Priority parameter

Group Editing form 170
Job Editing form 112

PRM field
DO Sysout parameter 127, 134

procedure step
Do IFRerun parameter 135
step range definition 129

PROCST parameter
Job Editing form 131

product support 3
program step

Do IFRerun parameter 135
step range definition 129

Q
Quantitative resources

Job Editing form 117
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R
R/3

Application Type field 149
job parameters 104

range
job steps 128

reading
See also copying
See also downloading
See also uploading

redo
in Job Editing form 100

Refresh button
Calendars window 217
Scheduling Tables window 200

Regular calendars
dates and colors 224

Relative calendars 214
dates and colors 224

Remote Delete button
Calendars window 217
Scheduling Tables window 198

Remove matching jobs ...
Collection criteria 194

Remove This Column option 38
removing. See deleting
Rerun

Shout When parameter 137
Rerun parameter

Job Editing form 113
resizing panes 45
resolution. See zooming
Resources panel

description 117
restoring default settings 255
Retro parameter

Group Editing form 175
Job Editing form 107

rows
sorting 37

running
CONTROL-M/Server utilities 142

S
SAC parameter

Job Editing form 108
SAP. See R/3
Save settings for next run

Options dialog box 254
saving

changes to a skeleton 154
SCD Table field

Job Editing form 126, 133
SCD Table subparameter

Group Editing form 187
Schedule tags

adding 140
defining 173
definition 172
deleting 141
modifying 173

Schedule Tags panel
buttons 172
field descriptions 174
Group Editing form 172

scheduling
CONTROL-M/Server utilities 142

Scheduling Group menu 168
Scheduling panel

Job Editing form 105
Scheduling table

jobs list 204
Scheduling Table Lib parameter

Job Editing form (z/OS) 104
Scheduling Table Manager

button 197, 203, 210
columns 198
commands 198
description 195
details window 200
jobs list 204
window 197, 203, 210

Scheduling tables
deleting 198
description 195
Details window 200
downloading 199
filter fields 197
forcing 195, 199
icon in tree view 46
importing 55
Job Editing form (z/OS) 104
loading 55
locking 22, 200
moving a job 75
new 198, 200
ordering 195, 199
Scheduling Table manager 31, 195
transfer from CONTROL-M/EM 22
unlocking 22, 200
uploading 199
window buttons 198
writing 59

Scheduling Tags
Job Editing form 140

Second Field
Options dialog box 249, 251

Select All 72
Select the full Draft

Collection criteria 194
Selected Link
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Options dialog box 251
selecting

dependent nodes 69
Drafts 54
multiple nodes 72
predecessor nodes 69

selection criteria
collections 192

Selection mode
choosing 63
description 62

servers
changing CONTROL-M/EM 266
CONTROL-M/EM 264

services
defining 23
overview 23

Set matching jobs...
Collection criteria 194

Set panel
Group Editing form 181
Job Editing form 121

setting confirmations 255
setting defaults 243
setting. See customizing
Shift Days parameter

Group Editing form 175
Shift Num parameter

Job Editing form 107
Shift parameter

detailed description 110
valid values 110

Shout messages
Group Editing form 182, 187
Job Editing form 136, 183

SHOUT statement
EXECTIME parameter (group) 184
EXECTIME parameter (job) 138

Shouts panel
Group Editing form 182

size
See also zooming

skeleton editor
Apply button 154
deleting fields 154
description 148
Field column 153
functions for values 155
moving fields 154

Skeleton field
Mass Create form 147

Skeleton panel
Wizard 229

skeletons
application type 149
clearing 150
conditions format 155

creating 149
definition 148
deleting 150
description 30
modifying 150
prerequisite conditions 155
saving changes 154
specifying fields 153

Sort Ascending option 37
Sort Descending option 37
sorting rows 37
sorting. See filtering
Start Day of the Week

CONTROL-M definition 239
default 246

start zoom magnification 248
Started Task parameter

Wizard 231
step codes

buttons 130
defining 130

step range
Job Editing form 128

StepInto item field
Options dialog box 249

stepping in and out
See also collapsing
See also expanding
Flow Diagram view 65

Steps panel
Job Editing form 123
Job Editing form (MVS) 128

Substr function
condition format 156
Mass Update form 161
skeleton editor 155

support, customer 3
SYS DB field, Sysout handling 139
Sysout handling 139

T
Table details

Scheduling tables 199
Table Name parameter

Wizard 230
tables

See also Scheduling tables
Job Editing form 102
Scheduling Tables window 198

Tag Selection panel
Job Editing form 140

Task Type
emergency tasktypes 113

Task Type parameter
Group Editing form 170
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Job Editing form 102
Job Editing form (MVS) 104

Task type parameter
cyclic jobs 113

Tasktype parameter
Wizard 230

technical support 3
templates. See skeletons
time

in the Group Editing form 171
parameter in Job Editing form 114

Time Zone parameter
Group Editing form 171

To column
Mass Update form 160

To field
step range definition 129

ToJob function
condition format 156
Mass Update form 161

toolbar
enable Communication toolbar 256
enable Flow Diagram toolbar 256
enable general toolbar 256
enable Tools toolbar 256
enable Tree toolbar 256
enable Wizard toolbar 256
mouse pointer modes 257
Selection toolbar 257

toolbars
viewing 256

Tools toolbar 256
Tree toolbar 256
Tree view

deleting jobs 78
description 25, 46
moving jobs 75

Type column
Calendars window 216

U
Undo Size field

Options dialog box 246
undoing actions

in Job Editing form 100
Unlock button

Calendars window 217
Scheduling Tables window 200

unlocking
calendars 217
Scheduling tables 22, 200

Until
job submission time 114
parameter in Group Editing form 171

Update button

Calendars window 217
Update keyword

Mass update conditions 163
updating

See also modifying
calendars 219
multiple jobs 145, 158
scheduling tables 199

Upload button
Calendars window 217
Scheduling Tables window 199

Upload Table panel
Wizard 233

uploading
calendars 217
Scheduling tables 199

Uppercase Only field
CONTROL-M definition 239

urgency
shout messages 138
shout messages (groups) 184

Use In Stream JCL
Job Editing form (z/OS) 104

User Daily column
Scheduling Tables window 198

User Daily field
Scheduling Table details 201

user ID
See also owner
Owner parameter 170

V
validity checks

automatic 241, 246
button 240
correcting errors 241
description 240

Value column
Collection Criteria dialog box 192

variables. See AutoEdit variables
Version column

Scheduling Tables window 198
Version field

CONTROL-M definition 239
viewing

See also displaying
Drafts 24
Group Scheduling tables 167
job dependencies 83
print preview 90
toolbars 256

views
list 48
tree 46

VMS. See OpenVMS
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W
waiting period, Max Wait parameter 113
Week Days Calendar parameter

Job Editing form 107
Week Days parameter

Job Editing form 106
weekdays

default start day 246
selecting in a calendar 222

Weekdays Calendar parameter
Group Editing form 174

Weekdays parameter
Group Editing form 174

weeks
selecting in a calendar 222

Western European language characters 32
Western European languages

special characters 32
When parameter

Group Editing form 184
Job Editing form 137

Wizard
enable toolbar 256
Job definition 225

Wrap field text in node
Options dialog box 249

Write Table panel
Wizard 232

Write to CONTROL-M/EM button 59
writing

jobs from CONTROL-M/EM 20
Scheduling tables 59

Y
years

calendar definition 221

Z
z/OS

Job Editing form 103
zoom

default magnification 248
zooming

Flow Diagram view 67
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